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chapitre 1 

Démarrage de Soft SampleCell
Merci d'avoir acheté Soft SampleCell. 
Soft SampleCell confère à votre ordinateur des 
fonctions puissantes de montage et de lecture 
d'échantillons.

Il vous permet d'utiliser des sons provenant de 
bibliothèques d'échantillons sur CD-ROM, ou 
d'importer vos propres sons numérisés et de les 
adapter à vos besoins. Vous pouvez ensuite 
lancer la lecture de ces échantillons depuis 
n'importe quel appareil ou logiciel MIDI.

Soft SampleCell est un échantillonneur 
performant qui s'intègre parfaitement dans 
l'environnement d'enregistrement, de montage 
et de mixage 24 bits de Pro Tools.

Les fonctions de Soft SampleCell sont les 
suivantes :

• Jusqu'à 64 voix

• La RAM mise à disposition des samples est 
uniquement limitée par la capacité de la 
mémoire vive de l'ordinateur (jusqu'à 1 Go)

• Lecture audio mono/stéréo, en 16 et 24 bits

• Lecture audio en 44.1 et 48 kHz

• Filtre passe-bas résonant 4 pôles, 24 dB par 
octave

• 3 enveloppes, 2 oscillateurs à basse fréquence 
(LFO) et 1 filtre par voix

• Matrice de modulation unique

• Editeur de boucle intégré
• Générateur de suivi

• Possibilité de rappel total de configuration 
lors d'une utilisation avec DirectConnect

Configuration requise
Pour pouvoir utiliser Soft SampleCell, vous 
devez posséder :

◆ Un ordinateur Power Macintosh validé par 
Digidesign avec :

• au moins 32 Mo de mémoire vive (128 Mo 
recommandés)

• Il est recommandé de prévoir une capacité 
de mémoire vive plus importante si vous 
désirez utiliser des applications audio ou 
MIDI en même temps que Soft SampleCell 
(la mémoire virtuelle n'est pas prise en 
charge)

◆ Mac OS 9.0.4 ou version ultérieure

◆ Le logiciel OMS (Open Music System) 2.3.8 ou 
version ultérieure (fourni avec Soft SampleCell)

◆ Un moniteur couleur 17 pouces ou plus (les 
moniteurs noir et blanc ne sont pas pris en 
charge)

◆ Un lecteur de disquette validé par Digidesign, 
avec pilote approprié (inclus dans le CD-ROM 
du programme d'installation de 
Soft SampleCell) ; indispensable pour 
l'autorisation de Soft SampleCell
Chapitre 1 : Démarrage de Soft SampleCell 1
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Configuration MIDI requise

Vous devez installer et configurer le logiciel 
OMS (Open Music System) 2.3.8 (ou version 
ultérieure) avant d'utiliser Soft SampleCell avec 
des appareils MIDI. Voir « Configuration 
d’OMS » à la page 4.

Soft SampleCell fonctionne avec les interfaces 
MIDI USB et sur port série. Toutefois, ce sont les 
interfaces MIDI sur port série qui respectent le 
mieux le timing des données MIDI. 

◆ Les interfaces MIDI de type « série » 
requièrent soit un port série Mac, soit un 
adaptateur de port modem-série validé (ce qui 
libère un port PCI). Référez-vous au site Web de 
Digidesign pour de plus amples informations 
sur les adaptateurs pris en charge.

Equipement supplémentaire

Certaines utilisations requièrent les éléments 
suivants :

• Un système d'écoute, tel qu'une table de 
mixage, un amplificateur de puissance et des 
enceintes

• Des câbles et un clavier de contrôle MIDI (ou 
tout autre périphérique de contrôle MIDI) 
pour déclencher via MIDI la lecture 
d’échantillons dans Soft SampleCell

• Un séquenceur logiciel MIDI compatible OMS

Afin d'utiliser Soft SampleCell avec Digital 
Performer (Mark of the Unicorn), ou tout 
autre logiciel compatible FreeMIDI™, vous 
devez régler Free MIDI en mode de 
compatibilité OMS. Plus tout 
renseignement supplémentaire, référez-vous 
à la documentation FreeMIDI.
Guide Soft SampleCell
Informations sur la compatibilité

Pour les dernières informations de 
compatibilité, visitez le site Web de Digidesign :

www.digidesign.com/compato/

Conventions utilisées dans ce 
guide
Les guides de Digidesign utilisent les 
conventions suivantes pour indiquer les choix 
de menu et les commandes principales :

Les symboles qui suivent servent à mettre en 
évidence des informations importantes :

Convention Action

File > Save 
Session

Choisissez Save Session 
(Enregistrer session) dans le 
menu File (Fichier)

Contrôle+N Maintenez la touche Contrôle 
enfoncée puis appuyez sur la 
touche N

Option-clic Maintenez la touche Option 
enfoncée puis cliquez sur le 
bouton de la souris

Les conseils aux utilisateurs sont des 
astuces permettant d'optimiser l'utilisation 
du système.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
les données ou les performances du système.

Les renvois dirigent l'utilisateur vers les 
sections correspondantes des divers guides 
de Digidesign.



                              
Installation de 
Soft SampleCell
Pour installer Soft SampleCell, utilisez le 
CD-ROM d’installation. Il existe deux options 
d'installation :

◆ Soft SampleCell. Sélectionnez cette option 
pour installer Soft SampleCell.

Digi System Files. Sélectionnez cette option pour 
mettre à jour un DAE antérieur à la version 5.1 
de Pro Tools ou tout autre fichier Digidesign 
System. 

Pour installer Soft SampleCell :

1  Insérez le CD-ROM du programme 
d'installation dans le lecteur de CD-ROM de 
l'ordinateur et cliquez deux fois sur l'icône du 
programme.

2  Sélectionnez l'option d'installation souhaitée.

3  Cliquez sur Installer.

4  Lorsque l'installation est terminée, cliquez sur 
Quit.

Enregistrement pour recevoir une 
disquette d'autorisation de secours

A la réception de votre carte d’enregistrement, 
Digidesign vous enverra une disquette 
d'autorisation supplémentaire pour 
Soft SampleCell. Si vous êtes un client hors USA, 
référez-vous à la liste des distributeurs 
internationaux incluse dans la documentation 
relative à l’enregistrement. 
Autorisation de 
Soft SampleCell
Lors du premier lancement de l'éditeur 
Soft SampleCell, après son installation, le 
système invite l'utilisateur à autoriser 
Soft SampleCell.

La disquette d'autorisation limite l'utilisation de 
Soft SampleCell à un seul système. Elle permet 
également de récupérer l'autorisation, si vous le 
souhaitez.

Pour autoriser Soft SampleCell :

1  Lancez l'application de l'éditeur 
Soft SampleCell.

2  Insérez la disquette d'autorisation lorsque le 
système vous invite à le faire.

3  Lorsque l'opération est terminée, cliquez sur 
Done. 

Ne perdez pas la disquette d'autorisation. 
Sans elle, il vous sera impossible d'effectuer 
une installation. Gardez cette disquette 
dans un endroit sûr.

Vous pouvez utiliser la disquette 
d'autorisation comme clé d'autorisation de 
secours, lorsque vous avez utilisé toutes les 
autorisations disponibles. Lancez l'éditeur 
Soft SampleCell et insérez la disquette 
lorsque le système requiert une autorisation.
Chapitre 1 : Démarrage de Soft SampleCell 3
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Annulation de l'autorisation 
de Soft SampleCell
Afin d'autoriser l'utilisation de Soft SampleCell 
sur un autre disque dur, vous devez d'abord 
annuler l'autorisation actuelle, car celle-ci est 
limitée à un seul disque.

Vous devez également récupérer l'autorisation 
avant d'effectuer un reformatage de bas niveau 
du disque dur, afin de ne pas risquer de la 
perdre.

Pour annuler l'autorisation de Soft SampleCell :

1  Insérez la disquette d'autorisation dans le 
lecteur de disquette.

2  Cliquez deux fois sur l'application 
d'annulation de l'autorisation.

3  Cliquez sur Setup. Dans le menu contextuel 
Authorization, sélectionnez Remove, puis 
sélectionner le disque dur concerné. (Le lecteur 
autorisé est indiqué par une clé.)

4  Cliquez sur Remove. 

5  Lorsque l'autorisation est annulée, cliquez sur 
Done, puis sur Quit, afin de retourner au Finder. 

Configuration d’OMS
Pour utiliser Soft SampleCell avec des 
applications MIDI compatibles OMS, ou pour 
utiliser les services MIDI dans l'éditeur 
Soft SampleCell, vous devez installer le logiciel 
Open Music System (OMS).

Ce logiciel rassemble les informations 
concernant les branchements et la 
configuration du studio MIDI dans des 
documents Studio Setup, modifiables via 
Guide Soft SampleCell
l'application OMS Setup. OMS supervise 
également l’assignation des données MIDI entre 
Soft SampleCell, les séquenceurs compatibles 
OMS et les interfaces MIDI.

Avant de commencer :

■ Si vous ne l'avez pas déjà fait, installez le 
logiciel OMS inclus dans Soft SampleCell.

■ Si OMS est déjà installé et configuré sur votre 
ordinateur, vous devez mettre à jour le Studio 
Setup actuel pour qu'il reconnaisse 
Soft SampleCell.

Pour mettre à jour le Studio Setup OMS actuel :

1  Connectez l'interface MIDI, les claviers de 
contrôle et les autres appareils MIDI. Référez-
vous à leur documentation si nécessaire.

2  Allumez les périphériques MIDI puis démarrez 
l'ordinateur.

3  Lancez l'application OMS Setup.

4  Sélectionnez Studio > MIDI Cards and 
Interfaces.

OMS recherche alors, puis prend en compte les 
périphériques MIDI, ainsi que le pilote 
Soft SampleCell, et les affiche dans le document 
Studio Setup.

5  Cliquez deux fois sur l'icône Soft SampleCell, 
afin de configurer sa boîte de dialogue MIDI 
Device Info.

Vérifiez que l'application est configurée en 
réception sur tous les canaux (1-16), sauf si vous 
souhaitez qu'elle ne reçoive les données MIDI 
que sur certains d'entre eux, puis cliquez sur OK.

6  Sélectionnez File > Save and Make Current, 
puis Quit.



                             
Pour créer une nouvelle configuration de studio 
OMS (Studio Setup OMS) :

1  Connectez l'interface MIDI, les claviers de 
contrôle et les autres périphériques MIDI. 
Référez-vous à leur documentation si nécessaire.

2  Allumez les périphériques MIDI puis démarrez 
l'ordinateur.

3  Lancez l'application OMS Setup.

4  Choisissez File > New Studio Setup.

OMS recherche puis prend en compte les 
périphériques MIDI, ainsi que le pilote 
Soft SampleCell, et les affiche dans le document 
Studio Setup.

5  Cliquez deux fois sur l'icône Soft SampleCell, 
afin de configurer sa boîte de dialogue MIDI 
Device Info.

Vérifiez que l'application est configurée en 
réception sur tous les canaux (1-16), sauf si vous 
souhaitez qu'elle ne reçoive les données MIDI 
que sur certains d'entre eux, puis cliquez sur OK.

6  Sélectionnez File > Save and Make Current, 
puis Quit.

Dans Soft SampleCell

1  Lancez l'éditeur Soft SampleCell.

2  Sélectionnez SampleCell > OMS Input 
Devices. 

3  Sélectionnez le contrôleur MIDI, ainsi que 
tous les périphériques que vous souhaitez 
utiliser pour jouer Soft SampleCell.

4  Pour de meilleures performances MIDI, 
désactivez tout périphérique ne servant pas au 
contrôle MIDI de Soft SampleCell.
Utilisation de Free MIDI

Pour utiliser Soft SampleCell avec un logiciel 
compatible avec FreeMIDI™ de Mark of the 
Unicorn (MOTU), vous devez régler Free MIDI 
sur le mode de compatibilité OMS. Plus tout 
renseignement supplémentaire sur la 
configuration, référez-vous à la documentation 
FreeMIDI.

Configuration de 
Soft SampleCell
Avant d'utiliser Soft SampleCell, vous devez 
configurer plusieurs paramètres, tels que la 
polyphonie (nombre de voix), la mémoire 
d'échantillon et la sortie audio, dans la boîte de 
dialogue Soft SampleCell Setup. 

Vous trouverez ci-dessous la description de ces 
paramètres, ainsi que des instructions pour leur 
configuration.

Boîte de dialogue Soft SampleCell Setup
Chapitre 1 : Démarrage de Soft SampleCell 5
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Sortie audio

Il existe trois options de sortie audio :

DirectConnect. Sélectionnez cette option si vous 
possédez une interface audio Digidesign et 
souhaitez utiliser Soft SampleCell dans 
Pro Tools ou dans une autre application 
audionumérique compatible DAE, telle que 
Logic Audio ou Digital Performer. Dans ce cas, 
vous devez utiliser l'interface audio Digidesign 
pour les connexions audio. DirectConnect 
permet d'acheminer jusqu'à 32 sorties 
Soft SampleCell indépendantes dans des 
applications compatibles DAE.

Direct I/O. Sélectionnez cette option si vous 
possédez une interface audio Digidesign, mais 
souhaitez exécuter Soft SampleCell en tant 
qu’application autonome. Vous devez tout de 
même utiliser l'interface audio Digidesign pour 
les connexions audio. Direct I/O permet de 
disposer d’un maximum de 16 sorties 
analogiques ou numériques pour 
Soft SampleCell sur un matériel Digidesign.

Sound Manager. Sélectionnez cette option si 
vous ne possédez pas d’interface audio 
Digidesign. Dans ce cas, vous devez utiliser le 
connecteur de sortie audio de votre Macintosh 
pour les connexions audio. Le Sound Manager 
du Macintosh permet un maximum de 2 sorties 
Soft SampleCell. 

Soft SampleCell choisit par défaut la sortie 
Sound Manager lors de la première 
installation. Utilisez la boîte de dialogue 
Soft SampleCell Setup pour sélectionner une 
option de sortie audio différente, si vous le 
souhaitez.
Guide Soft SampleCell
Latence audio

L'utilisation du processeur de l'ordinateur par 
Soft SampleCell pour les tâches audio crée un 
léger retard audio, ou latence, selon l'option de 
sortie audio sélectionnée. Plus le paramètre de 
latence est faible, plus la charge de travail du 
processeur d’ l’unité centrale est importante.

Vous pouvez choisir un paramètre de temps de 
latence faible (Low) ou élevé (High). L'option de 
latence Low permet de réduire le retard audio, 
mais réduit également le nombre de voix dans 
Soft SampleCell. L'option de latence High 
augmente le retard audio, mais autorise un 
nombre de voix maximal dans Soft SampleCell.

Mémoire pour les échantillons

La quantité de mémoire vive disponible pour la 
lecture d'échantillons n'est limitée que par la 
quantité de mémoire vive de l'ordinateur. Vous 
pouvez définir une limite pour l'allocation de 
mémoire grâce au menu contextuel Sample 
Memory. Evitez de définir une limite trop élevée 
car les autres applications (dont Mac OS) 
risqueraient de ne plus avoir suffisamment de 
mémoire pour fonctionner correctement. 

Lorsque l'option de sortie audio 
DirectConnect est sélectionnée, il est 
impossible de régler la latence audio 
manuellement. DirectConnect gère 
automatiquement la latence audio. Référez-
vous au guide de référence de Pro Tools pour 
de plus amples informations.

Si vous réglez le paramètre Sample Memory 
sur All, toute la RAM de l'ordinateur est 
assignée à la lecture d'échantillons, au 
détriment des autres applications. Ceci peut 
avoir une incidence sur les performances du 
système. Il est recommandé de réserver au 
moins 10% de la mémoire vive totale du 
système aux autres applications.



    
Pour vérifier la mémoire vive disponible :

1  Ouvrez l'éditeur Soft SampleCell, ainsi que 
toutes les applications audio utilisées 
simultanément.

2  Allez dans le Finder et sélectionnez « À propos 
de votre ordinateur » dans le menu Pomme. La 
quantité de mémoire vive restant disponible est 
indiquée en tant que « Plus gros bloc inutilisé ». 
Pour des performances de système fiables, 
attribuez à Soft SampleCell une quantité de 
mémoire d'échantillon bien inférieure à la 
quantité indiquée.

Polyphonie

Soft Sample offre un maximum de 64 voix de 
lecture d'échantillon. La polyphonie maximale 
dépend cependant des performances de 
l'ordinateur. Des UC moins rapides risquent 
d'offrir moins de 64 voix. Pour des performances 
système maximales, n'attribuez que le nombre 
de voix nécessaires.

Pour configurer Soft SampleCell :

1  Lancez l'éditeur Soft SampleCell.

2  Sélectionnez SampleCell > Soft SampleCell 
Setup.

3  Sélectionnez l'option de sortie audio 
appropriée.

Vérification de la mémoire vive disponible
Si vous sélectionnez Direct I/O, cliquez sur 
Hardware Setup et sélectionnez les options de 
sortie correspondant à votre carte et à votre 
interface Digidesign, puis cliquez sur Done.

Si vous sélectionnez Direct I/O ou Sound 
Manager, choisissez une latence High 
(importante) ou Low (faible), selon vos besoins.

4  Dans le menu contextuel Sample Memory, 
définissez la limite d'allocation de mémoire 
pour la lecture d'échantillon.

5  Dans le menu contextuel Number of Voices, 
entrez le nombre de voix désiré. 

6  Cliquez sur OK.

L'allocation d'un nombre de voix trop 
important par rapport à la puissance de 
l'ordinateur risque de causer des parasites 
(clicks) pendant la lecture. Sélectionnez 
SampleCell > Soft SampleCell Setup et, si 
Soft SampleCell utilise plus de 50% des 
ressources de l'UC, réduisez la polyphonie 
vocale dans la boîte de dialogue 
Soft SampleCell Setup.
Chapitre 1 : Démarrage de Soft SampleCell 7
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Test de lecture
Vous pouvez utiliser la Soundcheck demo Bank, 
fournie avec Soft SampleCell, pour vérifier 
rapidement les connexions audio et MIDI. 

Pour tester vos connexions audio et MIDI :

1  Dans l'éditeur Soft SampleCell Editor, 
sélectionnez File > Open.

2  Sélectionnez la Soundcheck demo Bank puis 
cliquez sur Open.

3  Cliquez deux fois sur Basic Left Instrument, 
afin d'ouvrir la fenêtre Sample Map.

4  Dans la fenêtre Sample Map, cliquez sur le 
clavier, afin d'écouter la lecture de l'échantillon.

5  Jouez quelques notes sur le clavier de contrôle 
MIDI afin de vérifier la communication MIDI.

6  Assurez-vous que les canaux de droite et de 
gauche des sorties audio sont correctement 
connectés en cliquant sur le bouton Solo et en 
jouant l’instrument basique de gauche (Basic 
Left Instrument). Répétez l'opération pour 
l’instrument basique de droite (Basic Right 
Instrument).

Activation de la lecture 
d'arrière-plan MIDI et des 
périphériques d'entrée
L'éditeur Soft SampleCell achemine (via OMS) 
les données MIDI issues du clavier de contrôle 
vers les instruments assignés au canal. 

Si vous avez choisi DirectConnect comme 
option de sortie audio, passez à l'option 
Direct I/O ou Sound Manager pour effectuer 
ce test. Après le test, vous pouvez à nouveau 
sélectionner l'option DirectConnect.
Guide Soft SampleCell
Vous pouvez également déclencher les 
instruments Soft SampleCell à partir d'un 
clavier MIDI même lorsque l'éditeur 
Soft SampleCell n'est pas l'application en cours, 
en activant l'opération MIDI en arrière-plan 
(Background MIDI Operation) dans OMS MIDI 
Setup. Cette option permet également à un 
séquenceur compatible OMS de poursuivre une 
lecture MIDI lorsque l'application n'est plus 
active (permettant ainsi d'écouter des 
modifications effectuées dans l'éditeur 
Soft SampleCell en continuant la lecture sur le 
séquenceur).

N'oubliez pas que lorsque la fonction Run MIDI 
in Background est activée et que l'éditeur 
Soft SampleCell, ainsi que le séquenceur, 
répercutent simultanément les données reçues 
en MIDI Thru vers le même instrument, des 
notes doublées risquent d'apparaître. 

Pour pallier ce problème, assurez-vous que 
l'option Pass MIDI Thru in Background est 
désélectionnée dans la boîte de dialogue 
Soft SampleCell Preferences, si vous avez activé 
l'option MIDI in Background dans OMS MIDI 
Setup.

Pour activerle MIDI en arrière-plan (Background) :

1  Dans l'éditeur Soft SampleCell, choisissez 
SampleCell > Preferences.

2  Sélectionnez SampleCell > MIDI Setup.

3  Dans la boîte de dialogue OMS MIDI Setup, 
sélectionnez Run MIDI in Background.

4  Cliquez sur OK.



Activation des périphériques 
d'entrée OMS

Si vous utilisez Soft SampleCell comme 
application autonome, vous devez activer votre 
contrôleur MIDI, ainsi que les autres 
périphériques d'entrée MIDI, afin de pouvoir les 
utiliser avec Soft SampleCell.

Pour activer les périphériques d'entrée MIDI :

1  Dans l'éditeur Soft SampleCell Editor, 
sélectionnez SampleCell > OMS Input Devices.

2  Sélectionnez les périphériques que vous 
souhaitez utiliser, puis cliquez sur OK.

Activation des périphériques d'entrée OMS
Chapitre 1 : Démarrage de Soft SampleCell 9



10
 Guide Soft SampleCell



chapitre 2 

Utilisation de banques et d’instruments
Ce chapitre explique les principes de base 
relatifs à l’utilisation de banques et 
d’instruments dans l’éditeur Soft SampleCell.

Pour plus d’informations sur la création 
d’instruments et de banques, et sur l’utilisation 
de vos propres échantillons, reportez-vous au 
Chapitre 3, « Création et modification 
d'instruments ».

Types de fichiers SampleCell

Echantillons

Un échantillon correspond aux données brutes 
décrivant la forme d’onde d’un son 
échantillonné.

SampleCell ne permet pas directement 
l’enregistrement de formes d’onde numériques, 
ni de échantillons. De nombreux échantillons 
« tout faits » sont disponibles auprès de 
développeurs de sons de tierce partie. 

Fichier Echantillon 

Les échantillons peuvent également être 
enregistrés à l’aide de Pro Tools. Voir 
annexe B, « Enregistrement 
d'échantillons ».
Les échantillons ne peuvent pas être lus 
directement par Soft SampleCell – ils doivent 
être chargés dans un instrument. 

Instruments

Un instrument consiste en un ou plusieurs 
échantillons, affectés à différentes séries de 
touches et de vélocités. 

De nombreuses options de modulation, telles 
que les enveloppes et les LFO, peuvent être 
utilisées au niveau des instruments.

Fichiers d’instruments (en haut) et d’échantillons
Chapitre 2 : Utilisation de banques et d’instruments 11
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Banques

Les instruments sont assemblés en groupes de 
jeu, appelés Banques. 

On parle de banques lorsque différents 
instruments sont affectés à des sorties, 
panoramiqués et atténués. Chaque instrument 
d’une banque peut être paramétré pour réagir 
sur un canal MIDI distinct et une tessiture (plage 
de notes) différente, constituant ainsi un 
générateur de sons multitimbral, pour 
utilisation avec un séquenceur (ou un autre 
dispositif pouvant transmettre plusieurs canaux 
MIDI).

Les instruments ne peuvent pas être ouverts 
dans plusieurs banques, ni ouverts 
simultanément, mais ils peuvent être copiés et 
collés. 

Les banques sont un bon moyen de rassembler 
tous les instruments requis par un morceau ou 
une séquence MIDI en un seul document, ou 
d’assembler tous les éléments d’un prémixage 
(différents stems ou instruments de 
musique/effets) sur une seule page d’écran.

Banques (en haut), fichiers d’instruments et 
d’échantillons

Pour éviter les notes coincées, arrêtez votre 
séquenceur lorsque vous ouvrez les fichiers 
Bank ou Instrument, ou lors de l’ouverture 
de la fenêtre Edit Loops.
Guide Soft SampleCell
Structure de fichiers des 
CD-ROM
La structure des fichiers sur de nombreux CD-
ROM de bibliothèques d’échantillons de tierce 
partie reflète la hiérarchie présentée dans la 
section précédente. Les échantillons, 
instruments et banques sont conservés dans des 
dossiers portant ces appellations respectives. 

Un dossier de banques contient normalement 
des fichiers Bank, qui contiennent eux-mêmes 
généralement un ou plusieurs instruments. 

Un dossier d’instruments contient 
normalement des fichiers Instrument, qui sont 
liés chacun à leurs échantillons associés. 

Ces dossiers emboîtés permettent de faire 
apparaître plus facilement par catégorie les 
instruments contenus sur le CD-ROM, tels que 
guitares, synthétiseurs ou bois...

Un dossier d’échantillons ne contient 
normalement que des échantillons bruts, classés 
selon les instruments d’origine.

Lorsque vous travaillez avec vos propres 
échantillons, il est conseillé de créer des dossiers 
pour les banques, les instruments et les 
échantillons de la même manière, afin de 
conserver une structure organisée.

Hiérarchie des fichiers
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Ouverture d'une banque
Pour ouvrir une banque existante, suivez les 
instructions suivantes : 

Pour charger une banque existante :

1  Choisissez File > Open.

2  Sélectionnez la banque et cliquez sur Open.

Tous les instruments sélectionnés vont être 
chargés. Pour omettre des instruments 
spécifiques, désélectionnez-les. 

3  Cliquez sur OK.

Ouverture d'une banque

Boîte de dialogue Select Instrument

Si vous utilisez Soft SampleCell en plus 
d’une carte Digidesign SampleCell II, vous 
pouvez utiliser le menu contextuel 
SampleCell de la boîte de dialogue pour 
choisir l’emplacement où vous voulez 
charger l’instrument.
Chapitre 2 : Utilisation de banques et d’instruments 1

Mémoire vive insuffisante

Si la mémoire vive disponible est insuffisante 
pour charger tous les échantillons 
correspondant à un ou plusieurs instruments 
d’une banque, des instruments seront chargés 
sans leurs données d’échantillons. Vous pouvez 
rechercher les échantillons non chargés en 
ouvrant la fenêtre Sample Map pour un 
instrument spécifique. (Voir « Mapping 
(assignation) d'échantillons » à la page 29.) Les 
échantillons non chargés apparaissent en 
italiques.

Recherche de fichiers

Si Soft SampleCell ne peut pas localiser un 
instrument ou un échantillon requis pour 
charger une banque ou un instrument, la boîte 
de dialogue Find File s’affiche.

Pour localiser les fichiers manquants :

■ Choisissez la destination de recherche dans 
les menus contextuels situés dans la partie 
inférieure de cette boîte de dialogue, puis 
cliquez sur New Search.

Si la préférence « Preview Using Sound 
Manager » est sélectionnée dans la boîte de 
dialogue SampleCell Preferences, vous pouvez 
écouter des échantillons depuis la boîte de 

Boîte de dialogue Find File
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dialogue Find File, en sélectionnant le nom d’un 
fichier d’échantillon puis en cliquant sur Play. 
Cliquez à nouveau sur ce bouton pour arrêter la 
lecture.

Priorité du chargement d’échantillons

Lorsqu’une banque d’instruments est ouverte, 
vous pouvez choisir l’ordre de chargement des 
échantillons en réorganisant l’ordre des 
instruments des banques. Les instruments (et 
leurs échantillons) sont chargés de gauche à 
droite (en affichage « pleine hauteur ») ou de 
haut en bas (en affichage réduit). (Voir « Vues de 
banques » à la page 14.)

Utilisation de banques
Lors de l’ouverture d’une banque, la fenêtre 
Banque apparaît. Elle sert à régler les niveaux 
des instruments, le panoramique, les sorties et 
d’autres paramètres.

Vues de banques

SampleCell offre deux vues de banques (petite et 
grande). La vue Large Bank affiche une voie de 
console de hauteur intégrale pour tous les 
instruments de la banque. La vue Small Bank 
affiche tous les instruments de manière 
compacte, en ligne. 
Guide Soft SampleCell
Pour changer la vue Bank :

■ Choisissez Windows > Switch Bank Size ou 
appuyez sur les touches Pomme + [B].

Par défaut, Soft SampleCell affiche les banques 
en mode Large Bank. Pour économiser de 
l’espace sur l’écran, vous pouvez changer ce 
paramètre par défaut au mode Small Bank.

Vue Large Bank

Vue Small Bank



Pour régler le paramètre par défaut Bank View sur 
Small Bank View :

1  Choisissez SampleCell > Preferences.

2  Sélectionnez Default to Small Bank View et 
cliquez sur OK.

Création d’une banque

Vous pouvez créer vos propres banques pour 
regrouper les instruments les plus fréquemment 
utilisés.

Lorsque vous utilisez des instruments et des 
échantillons provenant de plusieurs sources (par 
exemple, plusieurs CD-ROM), vous pouvez 
classer les fichiers provenant de chaque volume 
dans leur propre banque. Cette opération peut 
nettement simplifier les choses lorsque vous 
enregistrez une banque qui contient des 
instruments et/ou des échantillons provenant 
de plusieurs CD-ROM.

Pour créer une banque :

1  Sélectionnez File > New.

2  Sélectionnez Bank, puis cliquez sur OK.

Vous pouvez maintenant ajouter des 
instruments existants à la banque ou créer vos 
propres nouveaux instruments. (Voir 
Chapitre 3, « Création et modification 
d'instruments »..)

Boîte de dialogue Select Document Type
Choisissez File > Save Bank As. Vous pouvez 
ainsi effectuer un enregistrement groupé des 
échantillons et des instruments vers de 
nouveaux emplacements, par exemple pour 
l’enregistrement depuis un CD-ROM sur le 
disque dur. 

Chargement d’instruments dans 
une banque

Vous pouvez ajouter des instruments à une 
banque nouvelle et vide, ou ajouter des 
instruments supplémentaires à une banque 
existante, si la mémoire vive le permet.

Pour charger des instruments dans une banque 
ouverte :

1  Choisissez File > Open.

2  Sélectionnez un instrument, puis cliquez sur 
Open.

3  Répétez cette opération pour les instruments 
supplémentaires.

Vous pouvez également ouvrir les 
instruments par glisser/déposer de leurs 
icônes sur l’éditeur Soft SampleCell dans le 
Finder.

Pour éviter des notes coincées, essayez de ne 
pas ouvrir de banques, d’instruments, ou la 
fenêtre Loop de l’éditeur SampleCell alors 
que le séquenceur est en lecture.
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Les échantillons peuvent également être 
sélectionnés et chargés à l’aide de cette boîte de 
dialogue. L’échantillon sélectionné va être 
chargé dans un nouvel instrument, ne 
comportant que cet unique échantillon, dans la 
banque actuelle, ou dans une nouvelle banque 
si aucune banque n’est ouverte.

Si les échantillons utilisés par un instrument se 
trouvent déjà en mémoire, ils ne seront pas 
rechargés.

Ouverture d’un instrument

Un instrument tel qu’il est affiché dans une banque
Guide Soft SampleCell
Banques multiples
Les banques multiples peuvent être ouvertes et 
activées en même temps. Par exemple, des 
banques différentes peuvent contenir des 
instruments correspondant à différents 
morceaux ou séries de morceaux pour sets de 
concerts. Ou, une banque peut contenir un 
ensemble de sons constituant une batterie rock, 
tandis qu’une autre banque peut contenir les 
sons d’une batterie de jazz. Vous constaterez que 
cette approche modulaire facilite la 
configuration des banques et des instruments, 
quelle que soit la diversité des morceaux et des 
sources. 

Sauf si vous avez transféré les échantillons sur 
votre disque dur, évitez de rassembler dans une 
même banque des fichiers provenant de 
plusieurs CD-ROM, sous peine de devoir passer 
sans arrêt d’un CD à l’autre pour charger la 
totalité des fichiers.



Utilisation de plusieurs copies 
d’un instrument dans une banque

Une technique de production courante consiste 
à utiliser deux instruments identiques 
légèrement désaccordés pour grossir le son. Pour 
mettre en œuvre ce type d’effet, vous devrez 
créer deux instruments identiques dans une 
banque. 

Cependant, comme Soft SampleCell ne permet 
pas de charger deux fois le même instrument 
dans une banque, pour le dupliquer vous devrez 
copier puis coller l’instrument.

Pour dupliquer un instrument dans une banque :

1  Sélectionnez l’instrument à copier en cliquant 
sur son nom.

2  Choisissez Edit > Copy Instrument.

3  Choisissez Edit > Paste.

Contrôle des échantillons utilisés dans plusieurs 
instruments

Lorsque vous copiez et collez pour dupliquer un 
instrument, certains paramètres d’échantillons, 
tel le panoramique, peuvent être édités 
indépendamment pour chaque instrument. 

D’autres paramètres d’échantillons, dont 
Sample Start Coarse/Medium et Loop Detune, 
sont des réglages globaux qui affecteront tous 
les instruments utilisant cet échantillon. Ceci 
est dû au fait que les instruments copiés font 
référence aux mêmes échantillons. Ceci permet 
à Soft SampleCell d’économiser de la mémoire 
vive. 
Suppression des instruments 
d’une banque

Les instruments peuvent être retirés des 
banques. 

Pour supprimer un instrument dans une banque :

1  Sélectionnez l’instrument en cliquant sur son 
nom dans la fenêtre Bank.

2  Choisissez Edit > Clear Instrument ou appuyez 
sur la touche Suppression.

Autres méthodes d’entrée de 
données
La plupart des paramètres d’instruments et de 
banques de Soft SampleCell sont commandés 
par des curseurs et des boutons à l’écran. Vous 
pouvez également utiliser le clavier de votre 
contrôleur MIDI ou celui de votre ordinateur 
pour entrer les valeurs des paramètres. 
Chapitre 2 : Utilisation de banques et d’instruments 17
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Utilisation des contrôleurs 
continus MIDI

Vous pouvez régler un contrôle à l’écran à l’aide 
d’un contrôleur continu MIDI (molette de 
modulation, joystick ou curseur de données 
MIDI). 

Pour régler une commande à l’aide d’un contrôleur 
MIDI : 

1  Cliquez sur le contrôle à régler tout en 
maintenant la touche Ctrl enfoncée. Une icône 
MIDI s’affiche.

2  Déplacez le contrôleur continu MIDI. La 
valeur du paramètre est réglée en conséquence.

Pour désaffecter le contrôleur MIDI :

■ Cliquez n’importe où sur l’écran.

Pour remettre un contrôle à l’écran sur sa valeur 
par défaut :

■ Cliquez sur la commande en maintenant la 
touche Option enfoncée.

Utilisation des numéros de notes 
MIDI

Certains paramètres utilisent pour leurs valeurs 
des numéros de notes MIDI. Pour ces 
paramètres, vous pouvez entrer une valeur en 
jouant la note correspondante sur votre 
contrôleur MIDI.

Affectation d’un contrôle de panoramique à un 
contrôleur MIDI externe
Guide Soft SampleCell
Pour entrer un numéro de note MIDI à l’aide d’un 
appareil MIDI :

1  Cliquez sur la boîte de texte du paramètre tout 
en maintenant la touche Ctrl enfoncée. Une 
petite icône MIDI apparaît.

2  Jouez la note choisie sur le clavier de votre 
contrôleur MIDI.

Utilisation d’un clavier 
d’ordinateur

Vous pouvez également utiliser le clavier de 
votre ordinateur pour entrer rapidement les 
valeurs des paramètres.

Pour régler une valeur à l’aide d’un clavier 
d’ordinateur :

1  Cliquez sur la boîte de texte du paramètre tout 
en maintenant la touche Ctrl enfoncée. Une 
icône MIDI apparaît. 

2  Appuyez sur la flèche en haut, la flèche à 
droite ou sur la touche plus (+) de votre 
ordinateur pour augmenter la valeur.

3  Appuyez sur la flèche en bas, la flèche à gauche 
ou sur la touche moins (-) de votre ordinateur 
pour diminuer la valeur.

4  Pour quitter le mode d’entrée par clavier, 
cliquez n’importe où sur l’écran.



Configuration des canaux 
MIDI
Le canal MIDI des instruments existants peut 
être réglé à l’aide du menu contextuel du canal 
MIDI sur la bande des instruments.

Pour régler le canal MIDI d’un instrument :

1  Cliquez sur le numéro situé au-dessus de 
l’indicateur MIDI Chan. Un menu contextuel 
apparaît.

2  Faites glisser jusqu’à ce que le numéro de 
canal souhaité apparaisse en surbrillance.

Configuration des zones MIDI

Lorsqu’un instrument est d’abord chargé dans 
une banque, il réagit sur toute l’étendue des 
notes MIDI. Cette plage de réaction peut être 
modifiée pour chaque instrument. Par exemple, 
pour créer un clavier splitté, vous souhaiterez 
que le son de basse sonne pour les notes situées 
avant le que ce soit l’orgue qui parle pour les 
notes situées après le Do2. Les menus 
contextuels de claviers Hi/Lo Note permettent 
de définir rapidement les points de split, en 
déterminant les plages de notes haute et basse 
pour l’instrument. 

Configuration du canal MIDI (affichage réduit de la 
banque)

Lors de la création de nouveaux 
instruments, Soft SampleCell peut affecter 
automatiquement un canal MIDI unique à 
chaque nouvel instrument. Pour en savoir 
plus, reportez-vous à la section 
« Préférences d’instruments » à la page 89.
Pour modifier la note MIDI la plus basse à laquelle 
un instrument va réagir :

1  Cliquez sur la petite icône du clavier à droite 
de Lo. Un « clavier contextuel » s’affiche.

2  Faites défiler le clavier jusqu’à ce que la note 
désirée passe en surbrillance. L’instrument ne 
réagira plus aux notes plus basses que celle que 
vous avez sélectionnée.

Pour modifier la note MIDI la plus haute à laquelle 
un instrument va réagir :

1  Cliquez sur la petite icône du clavier à droite 
de Hi. Un clavier contextuel s’affiche.

2  Faites défiler le clavier jusqu’à ce que la note 
désirée soit en surbrillance. L’instrument ne 
répondra plus aux notes plus hautes que celle 
que vous avez sélectionnée. 

Vous pouvez cliquer sur la valeur Hi/Lo tout en 
maintenant la touche Ctrl enfoncée, puis entrez 
une nouvelle valeur en jouant une note sur 
votre clavier MIDI.

Réglage de Lo MIDI Note

Le canal MIDI et les zones MIDI peuvent 
être enregistrés comme valeurs par défaut 
pour l’instrument. Pour plus d’informations 
sur la commande Set Instrument Default, 
reportez-vous au Chapitre 3, « Création et 
modification d'instruments ».
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Assignation de sorties audio
Ce n’est pas le fait du hasard si les panneaux de 
commande des instruments ressemblent 
beaucoup à une console de mixage. Les 
fonctions sont quasiment identiques, chaque 
instrument se comportant comme une voie de 
console traditionnelle.

Chaque instrument peut être assigné à l’une des 
paires de sorties audio de Soft SampleCell. Le 
nombre de sorties dépend de l’option de sortie 
audio sélectionnée dans la boîte de dialogue 
Soft SampleCell Setup. Voir « Sortie audio » à la 
page 6.

Tout comme la réception des données MIDI 
correspondant aux sons de piano, de basse et de 
batterie peut intervenir sur des canaux MIDI 
séparés, leurs sorties respectives peuvent être 
assignées à trois différentes sorties audio stéréo. 
Ces sorties peuvent se voir, à leur tour, assignées 
à trois voies stéréo séparées sur une console de 
mixage en vue d’un prémixage. 

De même, chaque paire de sortie d’un film ou 
d’une post-session vidéo peut être dédiée à un 
prémixage différent (musique et effets, 
bruitages, ambiances).

Pour assigner un instrument à une paire de sortie 
audio :

■ Cliquez sur le bouton Output associé à la paire 
de sortie souhaitée. Les signaux audio générés 
par l’instrument apparaîtront uniquement sur 
les sorties correspondantes.
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À un instant précis, on ne peut sélectionner 
qu’une seule paire de sorties à la fois pour un 
instrument donné.

Si vous utilisez Soft SampleCell avec Pro Tools et 
DirectConnect, la modification de ces contrôles 
d’assignation de sortie analogique change 
également l’assignation du signal. 

Réglage des canaux de sortie

La sortie audio peut être enregistrée comme 
valeur par défaut d’instrument. Pour plus 
d’informations sur la commande Set 
Instrument Default, reportez-vous à la 
section « Set Instrument Defaults » à la 
page 86.



Panoramique des instruments
Le panoramique détermine la balance de 
l’instrument dans la paire de sortie stéréo 
sélectionnée. Par exemple, si la sortie 1-2 est 
sélectionnée, un panoramique à fond à gauche 
envoie un instrument mono uniquement sur la 
sortie 1 ; un panoramique à fond à droite envoie 
l’instrument uniquement à la sortie 2. 

Les instruments stéréo envoient les canaux 
impairs à fond vers la gauche et les canaux pairs 
à fond vers la droite. 

Le curseur de panoramique décale le centre de 
l’image stéréo de l’instrument. Les valeurs 
négatives envoient le son avec une 
prédominance vers la sortie gauche, et les 
valeurs positives vers la sortie droite. 

Pour changer le panoramique des échantillons 
individuels dans l’image stéréo de l’instrument, 
reportez-vous à la section « Panoramique du 
groupe de touches » à la page 39.

Le panoramique des groupes de touches 
vient s’ajouter au contrôle de panoramique 
principal d’un instrument. Vous ne pouvez 
pas l’utiliser pour panoramiquer, dans un 
même instrument, un échantillon à 
l’extrême gauche et un autre à l’extrême 
droite.
Pour panoramiquer un instrument dans la paire de 
sortie sélectionnée :

■ Faites glisser le contrôle de panoramique dans 
la direction souhaitée. Le nombre à l’intérieur 
du curseur indique la quantité exacte de 
panoramique.

Pour plus d’informations sur la modulation de 
panoramique avec des LFO ou d’autres sources 
de modulation, reportez-vous à la section 
« Modulation de matrice » à la page 49.

Contrôle de panoramique des instruments

Le panoramique des instruments peut être 
enregistré comme valeur par défaut. Pour 
plus d’informations sur la commande Set 
Instrument Default, reportez-vous à la 
section « Set Instrument Defaults » à la 
page 86.
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Coupure (Mute) et lecture en Solo 
d’un instrument

Comme une console de mixage, la coupure 
(Mute) fait disparaître le son de l’instrument 
associé, tandis que la lecture en solo garantit que 
seuls les instruments sélectionnés sont 
entendus. 

Il est possible de couper simultanément le son 
de plusieurs instruments, ou de les écouter en 
solo en même temps. Activer un instrument en 
Solo coupe tous les autres instruments dans 
toutes les banques ouvertes.

Pour couper le son d’un instrument :

■ Cliquez sur le bouton Mute de l’instrument. 

Pour revenir à un fonctionnement normal, 
cliquez à nouveau sur Mute. Cliquez tout en 
appuyant sur la touche Option pour rétablir le 
son de tous les instruments. 

Pour écouter un instrument en solo :

■ Cliquez sur le bouton Solo de l’instrument. 

Pour revenir à un fonctionnement normal, 
cliquez à nouveau sur Solo. Cliquez tout en 
appuyant sur la touche Option pour ne plus lire 
en solo tous les instruments. 

Boutons Solo et Mute
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Volume des instruments

Le niveau d’un instrument se règle via son fader.

Pour modifier le niveau d’un instrument :

■ Faites glisser le fader de volume de 
l’instrument au niveau souhaité. Une mesure 
numérique indique la valeur exacte.

Cliquez sur le fader de volume tout en maintenant 
la touche Ctrl enfoncée pour assigner 
temporairement un contrôleur MIDI (molette de 
modulation, etc) au volume de l’instrument. 

Fader de volume de l’instrument

Le volume de l’instrument peut être 
enregistré comme valeur par défaut. Pour 
plus d’informations sur la commande Set 
Instrument Default, reportez-vous au 
Chapitre 6, « Menus de Soft SampleCell ».



Commentaires concernant les 
instruments et les banques

SampleCell permet d’entrer des commentaires 
relatifs aux instruments et aux banques. Les 
commentaires s’affichent dans la boîte de 
dialogue Open File lorsque vous sélectionnez 
une banque ou un instrument.

Pour entrer ou modifier les commentaires relatifs à 
une banque :

1  Lorsque le fichier Bank est ouvert et qu’aucun 
instrument n’est sélectionné, choisissez File > 
Get Bank Info.

2  Entrez ou modifiez à votre guise les 
commentaires.

3  À la fermeture de la fenêtre, vos commentaires 
vont être stockés dans le fichier Bank actuel. 

Pour entrer ou modifier les commentaires relatifs à 
un instrument :

4  Sélectionnez un instrument dans une banque 
et choisissez File > Get Instrument Info, ou 
cliquez sur le bouton Info.

5  Entrez ou modifiez à votre guise les 
commentaires.

6  À la fermeture de la fenêtre, vos commentaires 
vont être stockés dans le fichier Bank actuel. 

Les commentaires associés aux instruments sont 
également entrés dans cette fenêtre. Ces 
commentaires restent associés à ces instruments 
lorsqu’ils sont utilisés dans d’autres banques.

Bouton Info
Accord des instruments
SampleCell n’a pas de contrôles d’accord de 
banques général. Mais, chaque instrument 
possède ses propres paramètres d’accord. Ces 
contrôles se trouvent dans la fenêtre Misc de 
chaque instrument.

Pour accéder aux commandes d’accord d’un 
instrument :

1  Sélectionnez l’instrument dans la fenêtre 
Bank. 

2  Choisissez Windows > Misc Parameters, ou 
cliquez sur le bouton Misc de la barre d’outils 
Bank.

Pour transposer un instrument par octaves :

■ Faites glisser le curseur Pitch Octave à la 
position appropriée. La hauteur d’origine peut 
être modifiée jusqu’à trois octaves au-dessus et 
quatre octaves en dessous.

Bouton Misc

Fenêtre Misc
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Pour transposer un instrument par demi-tons :

■ Faites glisser le curseur Pitch Semitone à la 
position appropriée. La hauteur d’origine peut 
être modifiée jusqu’à 12 demi-tons vers le haut 
ou vers le bas.

L’accord précis est extrêmement utile lorsqu’un 
effet de chorus ou un effet de désaccord est 
souhaité entre deux copies identiques d’un 
instrument.

Pour effectuer un accord précis ou désaccorder un 
instrument :

■ Faites glisser le curseur Detune à la position 
appropriée. La hauteur d’origine peut être 
modifiée d’un quart de ton vers le haut ou vers 
le bas. 

Désaccord égal

Les contrôles Detune ne réagissent pas de la 
même manière selon les différentes plages de 
l’instrument, en fonction du réglage Equal 
Detune dans la fenêtre Misc.

Désaccord égal désactivé. Lorsque l’option 
Equal Detune est désactivée, la lecture de 
Soft SampleCell repose sur un accord au 
tempérament égal (exponentiel) et le curseur 

Si vous utilisez des valeurs extrêmes de 
transposition, vous allez entendre des 
échantillons adjacents dans Sample Map. 
Pour un meilleur contrôle de la plage de 
hauteurs pour un échantillon particulier, 
créez un instrument pour l’échantillon et 
utilisez les touches Hi/Low pour spécifier la 
gamme de hauteurs souhaitée dans laquelle 
l’échantillon peut être lu.

Chaque échantillon peut être accordé 
individuellement depuis la fenêtre Sample 
Parameters. Pour en savoir plus, reportez-
vous à la section « Fenêtre Sample 
Parameters » à la page 38.
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Detune modifie l’accord de toutes les notes du 
nombre de cents sélectionné (un cent = 
1/100ème de demi-ton). Autrement dit, un 
désaccord de moins 5 cents aura le même effet 
sur toute la plage d’un instrument. Le La1 sera 
donc aussi « bémolisé » que le La6 ou le Ré7. Ce 
phénomène est dû au décalage en cents qui est 
logarithmique. 

Désaccord égal activé. Lorsque l’option Equal 
Detune est activée, la fréquence est désaccordée 
par une valeur constante en Hz dans toute 
l’échelle. Si vous avez deux échantillons, et si 
l’un est très légèrement désaccordé par rapport à 
l’autre en mode Equal Detune, les deux 
échantillons vont « battre » l’un contre l’autre à 
la même fréquence dans toute la plage du 
clavier. Le décalage de hauteur varie en fonction 
de la fréquence :

◆ Pour un échantillon lu à sa note racine MIDI, 
le curseur Detune possède une plage de plus ou 
moins un demi-ton. 

◆ Si un échantillon est lu une octave en dessous 
de sa note racine MIDI, le curseur Detune crée 
une plage de désaccord de plus ou moins un ton 
(deux demi-tons).

◆ Si un échantillon est lu une octave au-dessus 
de sa note racine MIDI, le curseur Detune crée 
une plage de désaccord de plus ou moins un 
quart de ton.

Essayez l’option Equal Detune sur les 
instruments non-occidentaux ou sur les 
instruments anciens. Ou, utilisez-la lorsque 
vous essayez d’adapter des boucles à une autre 
rythmique. Elle peut fournir le léger 
changement de la vitesse (vitesse/hauteur de 
lecture) nécessaire pour « ancrer » un groove.



Enregistrement d’une banque
Une fois que vous avez configuré une banque 
avec des instruments et leurs paramètres de 
base, enregistrer la banque permet de la 
retrouver pour une utilisation ultérieure. 

Vous pouvez enregistrer tous les instruments et 
les échantillons associés à une banque en 
utilisant la commande Save Bank As. 

Pour enregistrer la banque actuelle avec son nom 
et sa destination d’origine :

■ Choisissez File > Save Bank.

Pour enregistrer une banque avec un nouveau nom 
ou une nouvelle destination :

1  Choisissez File > Save Bank As. 

2  Entrez un nom et choisissez la destination 
pour la banque.

3  Sélectionnez « Save all instruments to a new 
location » si vous souhaitez enregistrer des 
nouvelles copies des instruments associés à la 
banque.

Soft SampleCell ne fait pas 
automatiquement la distinction entre les 
échantillons, les instruments et les 
banques : vous pouvez donc très bien 
écraser par inadvertance un échantillon si 
vous enregistrez par mégarde un instrument 
du même nom au même emplacement. Pour 
des raisons de sécurité, créez des dossiers 
séparés pour les banques, les instruments et 
les échantillons.

Si la commande Save Bank n’apparaît pas 
dans le menu File, ceci est dû au fait qu’un 
instrument est actuellement sélectionné à 
l’écran dans la fenêtre Bank. 
Désélectionnez l’instrument en cliquant sur 
une zone vide dans la fenêtre Bank avant 
d’enregistrer une banque.
4  Sélectionnez « Save all referenced samples to a 
new location » si vous souhaitez enregistrer des 
nouvelles copies des échantillons associés à 
chaque instrument.

Pour enregistrer tous les instruments et banques 
modifiés :

■ Choisissez File > Save All Changed. 

Fermeture d'une banque

Pour fermer une banque :

■ Cliquez sur la case de fermeture de la fenêtre 
Bank ou choisissez File > Close.

Enregistrement d’une banque et des instruments

Pour plus d’informations sur la fermeture 
de Soft SampleCell Banks, reportez-vous à 
la section « Automatically delete unused 
samples » à la page 89.
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Enregistrement d’un 
instrument
La plupart des paramètres évoqués dans ce 
chapitre sont enregistrés avec une banque et 
avec l’instrument. Si vous modifiez les 
commentaires d’un instrument ou tout 
paramètre associé à un instrument, l’instrument 
doit être enregistré pour conserver ces 
modifications. 

Même si vous êtes invité automatiquement à 
enregistrer ces changements d’instruments 
lorsque vous refermez une banque, vous pouvez 
également enregistrer un instrument 
manuellement.

Pour enregistrer un instrument avec son nom et sa 
destination d’origine :

■ Choisissez File > Save Instrument. 

Pour enregistrer un instrument avec un nouveau 
nom ou une nouvelle destination :

1  Choisissez File > Save Instrument As. 

2  Entrez un nom et choisissez la destination 
pour l’instrument.

3  Sélectionnez « Save all referenced sample to a 
new location » si vous souhaitez enregistrer des 
nouvelles copies des échantillons associés à 
l’instrument.

Pour enregistrer tous les instruments et banques 
modifiés :

■ Choisissez File > Save All Changed. 

Si la commande Save Instrument ne 
s’affiche pas dans le menu File, ceci est dû 
au fait qu’un instrument n’est pas 
actuellement sélectionné à l’écran dans la 
fenêtre Bank. Sélectionnez l’instrument en 
cliquant dessus avant de l’enregistrer.
Guide Soft SampleCell



chapitre 3 

Création et modification d'instruments
Ce chapitre décrit les fonctions de modification 
d'instruments de Soft SampleCell.

Les commandes Instrument Volume, Pan, 
Audio Output, MIDI Channel et Range de 
Soft SampleCell sont associées à des banques. 
Ces banques regroupent ces commandes avec 
des paramètres de jeu. Pour plus d'informations 
sur les banques, consultez Chapitre 2, 
« Utilisation de banques et d’instruments ».

Principes de base des 
instruments
Un instrument est un groupe d'échantillons, 
affectés à des touches spécifiques pour pouvoir 
être joués à l'aide d'un contrôleur MIDI ou d'un 
séquenceur. Les instruments peuvent être 
chargés à partir d'un CD-ROM pour être ensuite 
modifiés, ou peuvent être créés et configurés à 
l'aide d'échantillons, d’assignations de touches 
et de paramètres de modulation personnels. 
Chaque instrument possède des paramètres 
personnalisables spécifiques, accessibles par 
l’intermédiaire des boutons suivants de la barre 
d'outils Edit :

Fenêtre Sample Map

La fenêtre Sample Map regroupe des commandes 
permettant l’assignation d'échantillons sur 
différentes régions de de notes MIDI et de plages 
de vélocités.

Fenêtre Misc Parameters

La fenêtre Misc Parameters (paramètres divers) 
regroupe des commandes permettant de définir 
l’accord, la priorité, le recouvrement, la réponse 
en vélocité, la molette de hauteur et le filtre. Elle 
comprend également les cases à cocher 
Instrument Crossfade, Monophonic, Key Track, 
Equal Detune et Disable MIDI Volume/Pan.
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Fenêtre Envelope

La fenêtre Envelope propose 3 enveloppes à 
quatre points, avec des commandes 
supplémentaires pour les options Key Track, 
Envelope Amount et Gate Time.

Fenêtre Matrix Modulation

La fenêtre Matrix Modulation permet de faire 
correspondre un grand nombre de sources de 
commandes de modulation, à divers paramètres 
de destination.

Fenêtre Modulators

La fenêtre Modulators propose 2 oscillateurs avec 
des modes de vitesse, d'amplitude, de forme et 
de déclenchement variables. Elle propose 
également un générateur de rampe et 2 
contrôleurs MIDI variables.

Fenêtre Trackers

La fenêtre Trackers affiche une représentation 
graphique à neuf points d’inflexion pour le tracé 
de courbes de réponse personnalisées 
correspondant à chaque paramètre. 
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Création de nouveaux 
instruments
Il existe deux types d'instruments de base : les 
instruments à échantillon unique et les 
instruments à échantillons multiples. Ces 
instruments peuvent être soit mono, soit stéréo.

Instruments à échantillon unique

Les instruments à échantillon unique possèdent 
un seul groupe de touches, une seule région de 
vélocité, mais aucun chemin de modulation (ces 
instruments à échantillon unique 
correspondent souvent à des effets sonores ou à 
des boucles rythmiques). Pour cette raison, les 
fenêtres Envelope, Matrix, Modulators et 
Trackers ne sont pas disponibles pour ce type 
d'instruments. 

Instruments à échantillons 
multiples

Les instruments à échantillons multiples 
peuvent posséder plusieurs groupes de touches 
et plusieurs zones de vélocité, ainsi que plusieurs 
chemins de modulation. Ils peuvent également 
être modifiés à partir de n'importe quelle fenêtre 
de modification d'instrument. Soft SampleCell 
peut ouvrir un maximum de 60 instruments 
mono, ou de 30 instruments stéréo. 

Instruments mono et stéréo

Les instruments peuvent être soit mono, soit 
stéréo. Les caractéristiques mono/stéréo des 
échantillons utilisés dans l'instrument 
déterminent la définition du nouvel instrument 
lui-même. Soft SampleCell peut ouvrir un 
maximum de 60 instruments mono, ou de 30 
instruments stéréo.



Pour créer un instrument :

1  Après avoir ouvert une banque, sélectionnez 
File > New ou cliquez sur le bouton Create New 
Instrument dans la barre d'outils Edit. 

2  Sélectionnez le type d'instrument à créer, puis 
cliquez sur OK.

Création automatique 
d'instruments

Si vous faites glisser dans le Finder des fichiers 
d'échantillons sur l'éditeur Soft SampleCell, 
Soft SampleCell crée automatiquement des 
instruments à partir de ces fichiers.

Si l'option Make One Instrument when Multiple 
Sound Files are Dragged Onto the Editor est 
sélectionnée dans la boîte de dialogue 
Preferences, Soft SampleCell crée un seul 
instrument à partir de tous les échantillons 
importés par glissement.

Lorsque des échantillons mono sont chargés 
dans des instruments stéréo, chaque 
échantillon mono utilise quand même 2 
voix.

Bouton Create New

Boîte de dialogue Create New Instrument
Si cette option n'est pas sélectionnée, un 
instrument est créé pour chaque échantillon.

Pour créer automatiquement un ou plusieurs 
instruments : 

■ Dans le Finder, faites glisser autant 
d'échantillons que vous le souhaitez dans 
l'éditeur Soft SampleCell.

Mapping (assignation) 
d'échantillons
Un instrument consiste essentiellement en un 
certain nombre d'échantillons assignés à 
certaines régions du clavier MIDI (groupe de 
touches, ou Key Group) et/ou en fonction de 
plages de valeurs de vélocité MIDI (zones de 
vélocité, ou Velocity Zones). Cette 
correspondance peut être affichée, modifiée ou 
changée dans la fenêtre Sample Map.

Pour ouvrir la fenêtre Sample Map :

■ Cliquez sur l'icône Instrument Sample Map de 
la fenêtre Bank, ou cliquez deux fois sur le nom 
d'un instrument.

Il n'est pas possible de créer 
automatiquement des zones de vélocité. Ces 
zones doivent être ajoutées 
individuellement.

Icône Sample Map
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Principes de base de l’assignation 
des touches

Le mapping des touches consiste à placer 
plusieurs échantillons sur l’étendue des touches 
jouables d'un instrument à échantillons 
multiples.

Ces échantillons multiples sont généralement 
nécessaires à une reproduction réaliste du 
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timbre et des registres de nombreux instruments 
de musique. En enregistrant plusieurs 
échantillons sur différents registres et 
différentes plages dynamiques, puis en les 
assignant à différents groupes de touches et 
zones de vélocité, il est possible de simuler 
l’instrument d'origine de façon très réaliste. 
Figure 1.  Fenêtre Sample Map

Case à cocher MIDI Selects Zone

Menu contextuel 
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Sample Parameters

New Key Group

New Velocity Zone

Limite de la zone 
de vélocité
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Loop Window

Reload Sample

Change Sample

Set Root Note

Order Key 
Groups by 
Root Note

Spread Key Groups Groupe de touches Note de base MIDI Clavier Limite du groupe de notes
Groupes de touches

Les échantillons sont répartis le long de l'axe 
horizontal à diverses régions de notes, appelées 
groupes de notes. Le nombre de groupes de 
touches peut être compris entre 1 (ce groupe 
unique couvre alors la totalité du clavier) et 60 
(si la mémoire le permet).



Zones de vélocité

Chaque groupe de notes contient des zones de 
vélocité. La plupart des instruments acoustiques 
et des sons naturels possèdent des timbres 
différents selon leur volume. Pour cette raison, 
on utilise aussi un mapping de vélocité (en plus 
du mapping selon la hauteur de notes), pour 
permettre à différents échantillons enregistrés à 
des intensités variables d'être attribués aux 
gammes de vélocité correspondantes.

Soft Soft SampleCell permet d’inclure jusqu'à 6 
échantillons/zones de vélocité par groupe de 
touches. C’est l'échantillon de la zone de 
vélocité correspondant à la valeur de vélocité 
MIDI entrante qui est déclenché. 

La fenêtre Sample Map de la Figure 1 représente 
un instrument possédant 3 zones de vélocité et 5 
groupes de touches.

Cet instrument est par conséquent composé de 
15 échantillons. Les noms d'échantillons 
portent un suffixe, tel que soft, med, ou loud, 
indiquant leur zone de vélocité cible.

Les zones de vélocité peuvent également être 
utilisées pour commuter deux sons totalement 
différents. Un exemple typique serait un 
échantillon de guitare basse jouée avec les doigts 
dans la zone de vélocité inférieure et un 
échantillon de basse slappée dans la zone 
supérieure. Les notes les plus fortes déclenchent 
les échantillons « frappés », tandis que les 
vélocités MIDI plus basses déclenchent les 
échantillons de basse jouée au doigt.
Ajout/importation 
d'échantillons
Une fois que vous avez créé un nouvel 
instrument, à échantillon unique ou à 
échantillons multiples, vous pouvez lui ajouter 
d’autres échantillons. Cet ajout d’échantillons 
peut s’effectuer par groupes ou séparément. 

Pour ajouter un seul nouvel échantillon :

1  Sélectionnez Windows > Sample Map ou 
cliquez sur l'icône Sample Map.

2  Sélectionnez Instruments > New Key Group, 
ou cliquez sur le bouton New Key Group de la 
fenêtre Sample Map :

3  Sélectionnez un échantillon à importer. Vous 
pouvez sélectionner des fichiers de sons entiers 
ou certaines régions de ces fichiers.

4  Cliquez sur Play pour écouter l'échantillon.

5  Cliquez sur Open pour charger l'échantillon 
sélectionné. Le nouveau groupe de touches est 
placé en Do8. 

6  Répétez l'opération pour charger des 
échantillons supplémentaires.

Bouton New Key Group

Boîte de dialogue New Key Group
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Une fois les échantillons supplémentaires 
ajoutés, le groupe de touches situé 
immédiatement à gauche est rétréci, afin de 
faire place aux nouveaux échantillons. Tous les 
groupes de touches à note unique sont décalés 
d'une note vers la gauche.

Pour ajouter plusieurs échantillons :

1  Sélectionnez Instruments > Add Multiple Key 
Groups.

2  Sélectionnez des échantillons dans la liste 
Select Files to Add, puis cliquez sur Add.

• Cliquez sur Add All pour ajouter la totalité du 
contenu du dossier actif. 

• Pour retirer un échantillon de la liste Files 
Added, sélectionnez-le puis cliquez sur 
Remove. 

3  Cliquez sur Done lorsque l'opération est 
terminée. 

Tous les nouveaux groupes de touches sont 
répartis de façon uniforme sur la gamme de 
l'instrument, dans la fenêtre Sample Map. 

Boîte de dialogue Add Multiple Key Groups (Macintosh)
Guide Soft SampleCell
Pour ajouter un échantillon à une nouvelle zone de 
vélocité :

1  Dans la fenêtre Sample Map, sélectionnez un 
échantillon correspondant au groupe de 
touches auquel vous souhaitez ajouter une 
nouvelle zone de vélocité.

2  Sélectionnez Instruments > New Velocity 
Zone ou cliquez sur le bouton New Velocity 
Zone :

3  Sélectionnez l'échantillon puis cliquez sur 
Open. 

Le nouvel échantillon est placé dans la plage de 
vélocité la plus haute pour le groupe de touches 
sélectionné. 

4  Faites glisser l'échantillon vers la zone de 
vélocité souhaitée dans le groupe de touches 
sélectionné. Si nécessaire, réglez les limites de la 
zone de vélocité, afin de définir la plage de 
valeurs de vélocité qui déclenchera 
l'échantillon.

Bouton New Velocity Zone



Modification du groupe de 
touches
Une fois que plusieurs échantillons sont chargés 
dans la fenêtre Sample Map de l'instrument, leur 
emplacement et la taille de leur groupe de 
touches peuvent être modifiés de différentes 
façons. Différents paramètres de groupe de 
touches, tels que le début de zone 
(l'emplacement auquel la lecture de 
l’échantillon commence), peuvent également 
être modifiés depuis la fenêtre Sample 
Parameters. Lorsque vous déplacez un groupe de 
touches, toutes les zones de vélocité de ce 
groupe sont déplacées en même temps et la 
largeur du groupe de touches (le nombre de 
touches concernées) reste identique. 

Sélection de Samples dans la 
fenêtre Sample Map

Avant de modifier les paramètres Sample d'un 
groupe de touches ou d'une zone de vélocité, 
vous devez sélectionner l'échantillon 
correspondant dans la fenêtre Sample Map. 

Pour sélectionner un échantillon manuellement :

■ Cliquez sur le groupe de touches/la zone de 
vélocité de votre choix dans la fenêtre Sample 
Map. 

– ou –

■ Cliquez sur le clavier à l'écran pour 
sélectionner un groupe de touches, puis cliquez 
sur l'échelle de vélocité pour sélectionner une 
zone comprise dans le groupe de touches.
Pour sélectionner un échantillon à l'aide du clavier 
de l'ordinateur :

◆ Pour chaque zone déjà sélectionnée, appuyez 
sur la flèche de droite (ou la touche Tab), afin de 
sélectionner les groupes de touches situés à 
droite. Appuyez sur la flèche de gauche (ou les 
touches Maj et Tab), afin de sélectionner les 
groupes de touches situés à gauche. Appuyez sur 
les flèches du haut/du bas, afin de sélectionner 
une zone de vélocité supérieure/inférieure. 

Pour sélectionner un échantillon depuis un 
contrôleur MIDI :

◆ Sélectionnez l'option MIDI Selects Zone, 
située dans la partie supérieure droite de la 
fenêtre Sample Map. 

Lorsque cette option est sélectionnée, jouer une 
note sur le contrôleur MIDI sélectionne 
l'échantillon correspondant à la vélocité et la 
gamme de note MIDI. La possibilité de 
sélectionner des groupes de touches/des zones 
via MIDI reste effective en cours d’édition dans 
la fenêtre Sample Parameters.

Déplacement, modification, 
remplacement et suppression 
d'échantillons

Il existe différentes façons de modifier la 
disposition des échantillons dans la fenêtre 
Sample Map d'un instrument.

Vous pouvez changer l'ordre des groupes de 
touches en les faisant glisser vers de nouveaux 
emplacements, et vous pouvez modifier leur 
étendue en faisant glisser leurs limites. Vous 
pouvez également utiliser différents boutons de 
fonctions spéciales.
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Pour faire glisser un groupe de touches vers un 
nouvel emplacement : 

■ Faites glisser l'échantillon inférieur du groupe 
de touches vers un nouvel emplacement. Toutes 
les zones de vélocité de ce groupe sont 
déplacées, en conservant leur étendue.

La commande Reorder Key Groups By Root Note 
réassigne les groupes de touches en fonction de 
leur note de base, de la plus grave à la plus aiguë. 
Si vous venez de charger plusieurs échantillons, 
cette méthode permet de les classer rapidement 
par note de base dans la fenêtre Sample Map. 

Si le groupe de touches comprend plus d'une 
zone de vélocité, celles-ci se déplacent avec leur 
groupe. Autrement dit, toutes les zones se voient 
réassignées en fonction de la note de base de la 
zone de vélocité la plus basse de leur groupe. 
(See « Définition de la note MIDI de base » à la 
page 36 pour plus de détails.)

Pour trier les emplacements des groupes de 
touches par note de base :

■ Cliquez sur le bouton Reorder Key Groups By 
Root Note, ou sélectionnez Instruments > 
Reorder Key Groups By Root Note.

Tous les groupes de touches de l'instrument sont 
reclassés en fonction de leur note MIDI de base. 

Bouton Reorder Key Groups By Root Note
Guide Soft SampleCell
Redimensionnement des groupes 
de touches

Vous pouvez redimensionner les groupes de 
touches manuellement ou automatiquement.

Pour changer l’étendue d'un groupe de touches :

■ Faites glisser la limite du groupe vers 
l’emplacement souhaité. L’étendue du groupe 
adjacent diminue ou augmente, pour permettre 
l'opération de redimensionnement.

Vous pouvez redimensionner des groupes de 
touches sélectionnés pour qu'ils soient répartis 
uniformément sur le clavier. La taille de tous les 
groupes de touches situés à droite du groupe 
sélectionné (ou de tous les groupes si aucun 
n'est sélectionné) devient uniforme.

La Figure 2 représente la fenêtre Sample Map 
d'un instrument avant l'utilisation de la 
commande Spread Key Groups.

Bouton Spread Key Groups

Figure 2.  Fenêtre Sample Map avant l'utilisation de la 
commande Spread Key Groups



Lorsque vous cliquez sur le bouton Spread Key 
Groups, la fenêtre Sample Map de l'instrument 
devient uniforme, comme le montre la Figure 3.

Pour répartir uniformément tous les groupes de 
touches sur l’étendue de l'instrument :

■ Cliquez sur le bouton Spread Key Groups de la 
fenêtre Sample Map. Tous les groupes de touches 
situés à droite du groupe sélectionné, y compris 
ce groupe, sont répartis uniformément sur le 
clavier.

Redimensionnement des zones de 
vélocité

Chaque groupe de touches de la fenêtre Sample 
Map peut contenir jusqu'à 6 zones de vélocité. 
Vous pouvez réorganiser les échantillons dans 
ces zones en faisant glisser ou en modifiant les 
limites de leur zone de vélocité.

Pour déplacer un échantillon vers une nouvelle 
zone de vélocité à l'intérieur d'un même groupe de 
touches :

■ Faites glisser l'échantillon vers la zone de 
vélocité souhaitée à l'intérieur du groupe de 
touches.

Figure 3.  Fenêtre Sample Map après l'utilisation de la 
commande Spread Key Groups
Pour régler l’étendue d'une zone de vélocité :

■ Faites glisser la limite de la zone de vélocité à 
l’emplacement souhaitée.

Remplacement et suppression 
d'échantillons

Vous pouvez remplacer ou supprimer des 
échantillons dans la fenêtre Sample Map. Ceci 
permet de créer des modèles d'instruments 
prémappés, afin de construire rapidement des 
instruments.

Pour supprimer un groupe de touches ou une zone 
de vélocité :

1  Sélectionnez l'échantillon à supprimer.

2  Choisissez Edit > Clear ou appuyez sur la 
touche Suppression. 

Cette opération supprime le groupe de touches 
ou la zone de vélocité de la fenêtre Sample Map.

Vous pouvez rapidement remplacer un 
échantillon par un autre à l'aide du bouton 
Change Sample. 

Pour remplacer un échantillon :

1  Sélectionnez l'échantillon à changer en 
cliquant sur le groupe de touches ou sur la zone 
de vélocité approprié(e). 

2  Cliquez sur le bouton Change Sample, ou 
sélectionnez Instruments > Change Sample.

Vous pouvez modifier simultanément toutes 
les étendues de toutes les zones de vélocité 
en maintenant la touche Option enfoncée et 
en faisant glisser la limite de l'une des 
zones. Toutes les zones auront alors le 
même paramètre de limite.
Chapitre 3 : Création et modification d'instruments 35



36
3  Sélectionnez un nouvel échantillon pour 
remplacer l'original.

4  Cliquez sur Open pour charger l'échantillon 
sélectionné. 

Le nouvel échantillon apparaît dans la fenêtre 
Sample Map, dans le même groupe de touches et 
la même zone de vélocité que l'échantillon 
d'origine.

Pour décharger un échantillon sélectionné :

1  Sélectionnez l'échantillon à supprimer.

2  Sélectionnez Instruments > Unload Sample. 

L'échantillon sélectionné est supprimé de la 
mémoire vive et l'instrument conserve les 
limites du groupe de touches et de la zone de 
vélocité de l'échantillon. Les échantillons 
déchargés apparaissent en italique dans la 
fenêtre Sample Map.

Pour recharger un échantillon déchargé :

1  Sélectionnez le groupe de touches/la zone de 
vélocité de l'échantillon. 

Cliquez sur le bouton Reload Sample, ou 
choisissez Instruments > Load Sample.

Bouton Change Sample

Bouton Load Sample
Guide Soft SampleCell
Les échantillons restent généralement en 
mémoire après la fermeture de la banque ou la 
suppression de l'instrument. Vous pouvez 
configurer Soft SampleCell pour qu'il décharge 
automatiquement tous les échantillons lors de 
la fermeture des banques ou de la suppression 
des instruments.

Pour décharger automatiquement les échantillons 
lors de la fermeture des banques ou de la 
suppression des instruments :

1  Sélectionnez SampleCell > Preferences.

2  Sélectionnez Automatically Delete Unused 
Samples.

Modification des paramètres 
spécifiques à l'échantillon
Grâce aux outils de la fenêtre Sample Map, et 
d'autres fenêtres, vous pouvez modifier toute 
une série de paramètres spécifiques aux 
échantillons, dont la note MIDI de base, la 
boucle d'échantillon et le décalage du début de 
l'échantillon, pour ne citer que ces exemples.

Définition de la note MIDI de base 

Lorsqu'un échantillon est assigné à la Sample 
Map, l'échantillon d'origine doit être attribué à 
une note de base, appelée note de base MIDI. 
Lorsqu'il est lu, l’échantillon est alors transposé 
à une hauteur inférieure ou supérieure à celle de 
sa note de base MIDI.

En règle générale, la note de base MIDI doit 
correspondre à la hauteur d'origine de 
l'échantillon. Vous pouvez, cependant, modifier 
des sons en réglant la note de base à une hauteur 
différente. Si, par exemple, vous chargez un 



échantillon de Do3 de trompette et que vous 
réglez la note de base MIDI sur Do4, la trompette 
sonnera une octave plus bas, ce qui en fera un 
substitut acceptable pour un tuba. 

Soft SampleCell peut lire un échantillon jusqu'à 
trois octaves au-dessus de la hauteur d'origine. 

Vous pouvez ouvrir la fenêtre Sample 
Parameters d'un groupe de touches et définir 
manuellement des notes de base individuelles, 
ou faire glisser l'indicateur de note de base vers 
un emplacement approprié, le long du clavier de 
la fenêtre Sample Map à l’écran.

Pour définir la note de base MIDI d'un échantillon :

1  Dans la fenêtre Sample Map, cliquez sur 
l'échantillon dont vous souhaitez régler la note 
de base MIDI.

Un carré noir apparaît au-dessus du clavier, 
indiquant la note de base actuelle de 
l'échantillon.

2  Faites glisser ce carré jusqu'à la note de base 
souhaitée.

Définition de la note de base MIDI

Note de base MIDI réglée sur Do4
Pour définir la note de base de tous les groupes de 
touches d'un instrument :

1  Cliquez sur le bouton Set Root Note, ou 
sélectionnez Instruments > Set Root Notes.

2  Choisissez l’une des options suivantes :

◆ Lowest : place la note de base sur la note la 
plus grave du groupe de touches.

◆ Middle : place la note de base au milieu du 
groupe de touches.

◆ Highest : place la note de base sur la note la 
plus aiguë du groupe de touches.

◆ Use Audio File : place la note de base comme 
suit :

• Si l'échantillon est un fichier AIFF, la note 
de base stockée dans ce fichier est utilisée.

• Si l'échantillon est un fichier Sound 
Designer II (SDII), la note de base par 
défaut est Do4 (C moyen).

3  Cliquez sur OK pour changer la note de base.

Bouton Set Root Note

Boîte de dialogue MIDI Root Note
Chapitre 3 : Création et modification d'instruments 37



38
Fenêtre Loop
De nombreux échantillons contiennent des 
boucles de lecture leur permettant d'être 
« maintenus » aussi longtemps que la note est 
maintenue enfoncée sur le clavier. La fenêtre 
Sample Loop permet de créer et modifier des 
boucles pour un échantillon particulier. 

Pour ouvrir la fenêtre Loop :

1  Sélectionnez un échantillon dans la fenêtre 
Sample Map.

2  Cliquez sur le bouton Loop.

Cette fenêtre permet de régler les points de 
début des boucles, le type de boucle, ainsi que 
d’autres paramètres se rapportant à la boucle. 
Vous trouverez une description plus détaillée 
des boucles, ainsi que d’autres techniques 
d’édition, est disponible dans le chapitre 
Chapitre 4, « Modification et bouclage 
d’échantillons ». 

Bouton Loop

Fenêtre Loop
Guide Soft SampleCell
Fenêtre Sample Parameters
La fenêtre Sample Parameters rassemble des 
commandes permettant de définir l'amplitude 
et le sens de lecture de l'échantillon, ainsi que le 
décalage du point de départ et l’accord de la 
boucle.

Pour ouvrir la fenêtre Sample Parameters : 

1  Sélectionnez un échantillon dans la fenêtre 
Sample Map.

2  Cliquez sur le bouton Sample Parameters, ou 
cliquez deux fois sur l'échantillon de votre choix 
dans la fenêtre Sample Map. 

Bouton Sample Parameters

Fenêtre Sample Parameters



Utilisation des flèches de 
sélection d'échantillon

Vous pouvez sélectionner différents 
échantillons à l'aide des flèches de sélection 
d'échantillon (ou des touches du clavier de 
l'ordinateur), afin de les modifier à l'intérieur 
d'un instrument, comme suit :

• La flèche du haut (ou la touche Page préc.) 
sélectionne la zone de vélocité directement 
supérieure, dans le groupe de touches 
concerné. 

• La flèche de droite (ou la touche Tab) 
sélectionne la zone la plus basse dans le 
groupe de touches directement supérieur. 

• La flèche du bas (ou la touche Page suiv.) 
sélectionne la zone de vélocité directement 
inférieure, dans le groupe de touches 
concerné. 

• La flèche de gauche (ou les touches Maj + Tab) 
sélectionne la zone la plus basse dans le 
groupe de touches directement inférieur. 

• La touche Origine sélectionne la zone de 
vélocité inférieure gauche. 

Vous pouvez également sélectionner des 
échantillons dans leur groupe de touches et 
dans leur zone en utilisant le MIDI, si l'option 
MIDI Selects Zone a été choisie.

Définition du début de 
l'échantillon

Vous pouvez modifier l'emplacement auquel la 
lecture commence à l'intérieur de la forme 
d'onde d'un échantillon. Ceci est utile pour le 
réglage précis du point d'attaque d'un 

Flèches de sélection d'échantillon
échantillon, afin de modifier son caractère ou de 
modifier les caractéristiques non souhaitées, 
telles que le bruit d’attaque d'un échantillon de 
guitare. 

Le point de départ peut être réglé à l'aide de 3 
curseurs : Coarse, Medium et Fine. Le curseur 
Fine règle le point de départ de l'échantillon de 
la façon la plus précise. 

Pour régler le point de départ d'un échantillon :

1  Dans la fenêtre Sample Map, sélectionnez 
l'échantillon concerné et cliquez sur le bouton 
Sample Parameters (ou cliquez deux fois sur 
l'échantillon).

2  Réglez la position du curseur Fine. 

Chaque unité de déplacement du curseur 
représente 256 échantillons numériques, ce qui 
représente un décalage total possible de 32512 
échantillons. Le décalage de l'échantillon est 
affiché dans la partie Start Offset de la section 
Zone Parameters.

Panoramique du groupe de 
touches

Le panoramique de chaque groupe de touches 
appartenant à la fenêtre Sample Map peut être 
réglé individuellement. Vous pouvez utiliser 
cette fonction pour créer des effets, tels qu'un 
piano stéréo, dans lesquels les panoramiques des 
échantillons inférieurs sont placés plus à gauche 
et ceux des échantillons supérieurs plus à droite.

Bouton Sample Parameters

L'image stéréo globale d'un instrument est 
contrôlée par son curseur Pan dans la 
fenêtre Bank.
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Pour changer le panoramique d'un groupe de 
touches :

■ Dans la fenêtre Sample Map, sélectionnez 
l'échantillon désiré puis faites glisser le curseur 
Key Group Pan (tout en lisant l'échantillon 
depuis un contrôleur MIDI, si vous le souhaitez).

Le panoramique de l'ensemble du groupe de 
touches de l'échantillon est désormais situé à 
l'intérieur de l'image stéréo de l'instrument. 

Note de base MIDI

Lorsqu’il est joué au clavier, un échantillon est 
transposé vers le haut ou le bas par rapport à sa 
note de base MIDI. La note de base par défaut est 
Do4. Pour en savoir plus, reportez-vous à la 
section « Définition de la note MIDI de base » à 
la page 36.

Sens de lecture des échantillons

Un échantillon peut être lu « à l’endroit » (du 
début à la fin) ou « à l’envers » (de la fin au 
début). La lecture arrière est utile pour la 
création d'effets spéciaux, tels que des caisse 
claires à l’envers. Lorsque le sens de lecture est 
réglé sur arrière, toutes les boucles de 
l'échantillon sont ignorées.

Pour changer le sens de lecture d'un échantillon :

◆ Dans la fenêtre Sample Map, sélectionnez 
l'échantillon concerné, puis sélectionnez 
l'option Forward ou Backward.

Vous pouvez simuler un effet stéréo sans 
avoir à modifier le panoramique du groupe 
de touches de chaque échantillon. Utilisez 
la fenêtre Matrix afin d’assigner des 
numéros de note MIDI au contrôle du 
panoramique de l'instrument. Pour en 
savoir plus, reportez-vous à la section 
« Modulation de matrice » à la page 49.
Guide Soft SampleCell
Amplitude des échantillons

Le volume d'un échantillon particulier peut être 
réduit à l'aide du curseur Amplitude. Si vous 
utilisez un instrument dont les échantillons ont 
été enregistrés à des niveaux différents, vous 
pouvez utiliser cette commande pour égaliser les 
éventuelles différences de volumes. 

Pour réduire le volume d'un échantillon :

◆ Dans la fenêtre Sample Map, sélectionnez 
l'échantillon concerné, puis modifiez la position 
du curseur Amplitude. 

Chaque « cran » de déplacement représente 
0.5 dB, sur une plage totale de 50 dB.

Accord des échantillons

Les échantillons, ainsi que leurs boucles, 
peuvent être accordés individuellement. Dans 
certains cas, l'accord global d'un échantillon 
doit être réglé pour que sa hauteur soit 
compatible avec d'autres échantillons de 
l'instrument. 

Pour accorder un échantillon :

1  Dans la fenêtre Sample Map, sélectionnez 
l'échantillon concerné et réglez la position du 
curseur Sample (dans la section Sample Fine 
Tuning), afin de monter ou d’abaisser la hauteur 
de l'échantillon. 

Vous pouvez régler la position du curseur tout 
en « jouant » l'échantillon via le contrôleur 
MIDI. 

La plage couverte par le curseur s'étend d'un 
quart de ton vers le bas à un quart de ton vers le 
haut. Si un échantillon chargé en mémoire est 
utilisé par plus d'un instrument, plus d'un 



groupe de touches ou plus d'une zone de 
vélocité, cette méthode de modification de 
l'accord affecte tous les instruments utilisant cet 
échantillon. 

Accord des boucles d'échantillons

Dans certains cas, la partie lue en boucle d'un 
échantillon doit être accordée pour 
correspondre à la hauteur de la partie d'attaque 
de cet échantillon. 

Si un échantillon possède une seule boucle, 
celle-ci fonctionne à la fois comme boucle de 
sustain (partie soutenue du son) et comme 
boucle de release (fin du son). Si l’échantillon 
possède deux boucles, la première sert de boucle 
de sustain et la deuxième de boucle de release. 

Pour accorder une boucle d'échantillon :

◆ Dans la fenêtre Sample Map, sélectionnez 
l'échantillon désiré, puis effectuez l'une des 
opérations suivantes :

• Si l'échantillon possède une seule boucle, 
accordez la hauteur de la partie lue en boucle 
de cet échantillon à l'aide du curseur Sus/Rel 
Loop.

• Si l'échantillon possède deux boucles, réglez la 
hauteur de la boucle de sustain à l'aide du 
curseur Sus Loop. Utilisez le curseur Sus/Rel 
Loop pour régler la hauteur de la boucle de 
release.

Commandes d'accord de boucle
La plage du curseur s'étend d'un quart de ton 
vers le bas à un quart de ton vers le haut. Vous 
pouvez régler la position du curseur tout en 
« jouant » l'échantillon via le contrôleur MIDI.

Désactivation d'une boucle 
d'échantillon

Les boucles de sustain et de release peuvent être 
activées ou désactivées individuellement.

Pour activer ou désactiver une boucle :

1  Dans la fenêtre Sample Map, sélectionnez 
l'échantillon concerné, puis effectuez l'une des 
opérations suivantes :

• Si l'échantillon possède une seule boucle, 
sélectionnez Sus/Rel Loop pour activer cette 
dernière. Désélectionnez Sus/Rel Loop pour la 
désactiver.

• Si l'échantillon possède deux boucles, 
sélectionnez Sus Loop Enable pour activer la 
boucle de sustain. Désélectionnez Sus Loop 
Enable pour la désactiver. Sélectionnez Rel 
Loop pour activer la boucle de release. 
Désélectionnez Rel Loop pour la désactiver.

Accord et activation de boucle

Dans le cas d'échantillons de parole, tels que la 
voix et les extraits de discours, la manipulation 
des deux boucles peut avoir des résultats 
intéressants. Utilisez les fenêtres Matrix 
Modulation et Envelope pour contrôler 
l'équilibre entre la première et la seconde 
boucle, puis déclenchez et contrôlez la 
synchronisation à l'aide d'une seule touche sur 
le contrôleur MIDI.

Activateurs de boucle
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Fenêtre Misc Parameters
La fenêtre Misc Parameters contient des 
commandes de hauteur, de fréquence de filtre, 
de crossfade, de suivi de touche, de suivi de 
hauteur, d'intonation, de filtrage MIDI, de 
recouvrement et de priorité de voix, ainsi que de 
sensibilité de vélocité. 

Ces paramètres s'appliquent globalement aux 
instruments. Le réglage de la fréquence de 
filtrage, par exemple, concerne tous les 
échantillons de l'instrument.

Pour ouvrir la fenêtre Misc Parameters :

■ Sélectionnez Windows > Misc, ou cliquez sur 
le bouton Misc Parameters.

Le nom de l'instrument sélectionné apparaît 
dans le menu contextuel Instrument. Utilisez ce 
menu contextuel pour choisir n’importe quel 
instrument dans la banque active et modifier ses 
paramètres.

Bouton Misc Parameters

Fenêtre Misc Parameters
Guide Soft SampleCell
Désactivation du suivi de touche

Il est parfois souhaitable de lire les échantillons 
à leur hauteur d'origine, quelle que soit la note 
MIDI jouée. Les effets sonores et les batteries en 
sont deux exemples typiques. 

Par défaut, le suivi de touche est activé. 
Autrement dit, les notes MIDI jouées modifient 
la hauteur des échantillons de l'instrument.

Lorsque le suivi de touche est désactivé, les 
notes MIDI jouées ne modifient pas la hauteur 
des échantillons. Ils seront donc lus à leur 
hauteur d'origine, définie par leur note de base 
MIDI.

Pour désactiver le suivi de touche d'un 
instrument :

1  Dans une banque activée, sélectionnez 
l'instrument souhaité. 

2  Dans la fenêtre Misc Parameters, 
désélectionnez Key Track.

SampleCell peut être configuré pour que le suivi 
de touche soit désactivé par défaut lorsque de 
nouveaux instruments sont créés. Ceci s'avère 
utile lors de la création d'instruments 
comprenant des sons sans hauteur définie, tels 
que les sons de batterie et les effets sonores.

Pour désactiver le suivi de touche par défaut :

1  Sélectionnez SampleCell > Preferences.

2  Sélectionnez l'option Default New 
Instruments to Key Track Off et refermez la 
fenêtre Preferences.

Pour plus d’informations sur les préférences 
Soft SampleCell, reportez-vous à la section 
« Preferences » à la page 89.



Réponse de vélocité MIDI

La vélocité MIDI contrôle la réponse en niveau 
d'un instrument lorsque vous jouez de cet 
instrument plus fort, ou plus doucement, sur un 
contrôleur MIDI. Le curseur Velocity de la 
fenêtre Misc Parameters permet de régler la 
réponse en vélocité MIDI de chaque instrument, 
individuellement. 

La valeur du contrôle de vélocité MIDI peut être 
positive ou négative. Si elle est positive, le 
volume de l'instrument augmente lorsque la 
vélocité MIDI augmente. Si elle est négative, le 
volume de l'instrument diminue lorsque la 
vélocité MIDI augmente. Lorsque la vélocité 
MIDI est réglée sur 0, elle n'a aucun effet sur le 
volume.

Utilisation de vélocité MIDI négatives

Les valeurs de vélocité négatives sont utiles 
lorsque vous effectuez un crossfade entre deux 
instruments en fonction de la force avec 
laquelle vous tapez sur les touches du contrôleur 
MIDI. 

Supposons que vous ayez deux instruments, des 
cordes et des cuivres, attribués au même canal 
MIDI. Vous souhaitez ne jouer que les cordes 
lorsque vous jouez doucement sur les touches, 
alors que seuls les cuivres doivent être entendus 
que lorsque vous jouez plus agressivement. Vous 
souhaitez également que les deux instruments 
soient lus lorsque vous tapez normalement sur 
les touches. 

Pour ce faire, il suffit d’attribuer une valeur 
négative à la vélocité MIDI des cordes et une 
valeur positive à celle des cuivres.

Pour modifier la réponse de vélocité MIDI d'un 
instrument :

1  Dans une banque activée, sélectionnez 
l'instrument souhaité. 
2  Dans la fenêtre Misc Parameters, placez le 
curseur Velocity à l'emplacement souhaité. 

Crossfade de vélocité 
d'instrument

La fenêtre Misc Parameters offre un autre moyen 
d'effectuer un crossfade contrôlé par la vélocité 
entre les deux instruments : l'option Instrument 
Velocity Crossfade. Lorsque celle-ci est activée, 
les instruments ne réagissent vraiment qu'aux 
faibles vélocités MIDI. 

En assignant deux instrument à un même canal 
MIDI et en activant l'option Instrument 
Velocity Crossfade sur l'un d'eux seulement, il 
est possible d'effectuer un crossfade contrôlé par 
la vélocité entre les deux.

Pour effectuer un crossfade contrôlé par la 
vélocité entre deux instruments :

1  Dans la fenêtre Bank, assignez deux 
instruments au même canal MIDI.

2  Sélectionnez l'instrument qui devra réagir aux 
faibles valeurs de vélocité, puis cliquez sur le 
bouton Misc Parameters.

3  Dans la fenêtre Misc Parameters, sélectionnez 
Ins Vel Crossfade.

4  Tapez sur les touches du contrôleur MIDI. 

En jouant doucement, seuls les sons du premier 
instrument devraient être déclenchés. Jouer plus 
fort devrait déclencher le second. 

Si, dans une banque, aucun instrument ne 
réagit aux changements de la vélocité MIDI 
lorsque vous tapez sur le contrôleur MIDI, 
vérifiez les paramètres de la courbe de 
vélocité sur le contrôleur. Lorsque la courbe 
de vélocité est correctement configurée sur le 
contrôleur, les instruments réagissent 
comme il le faut à la vélocité MIDI.
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Priorité de voix, recouvrement et 
polyphonie

Par défaut, les instruments sont polyphoniques. 
Vous pouvez cependant les configurer pour 
qu'ils réagissent de façon monophonique, si 
vous le souhaitez. Lorsque la lecture 
monophonique est sélectionnée, les 
instruments réagissent à la dernière note jouée 
(la plus récente).

Pour sélectionner la lecture monophonique :

1  Dans une banque activée, sélectionnez 
l'instrument souhaité. 

2  Dans la fenêtre Misc Parameters, sélectionnez 
Monophonic.

Priorité de voix

Si vous jouez de plusieurs instruments en même 
temps, vous risquez de manquer de voix. 
Lorsque vous tentez de jouer plus de voix que 
vous n'en possédez, Soft SampleCell 
« emprunte » des voix à certains instruments et 
les attribue à d'autres, en fonction des besoins. 

Vous pouvez définir des priorités parmi les 
instruments, de façon à ce que leurs voix soient 
plus ou moins susceptibles d'être empruntées si 
nécessaire. En règle générale, les instruments 
principaux doivent avoir la priorité, alors que les 
instruments d'arrière-plan ou de nappes sont 
secondaires. 

Les crossfades d'instruments utilisent deux 
voix pour chaque note jouée. Si vous jouez 
quatre notes avec un crossfade entre deux 
instruments, par exemple, vous utiliserez 
huit voix.
Guide Soft SampleCell
Pour définir la priorité d'allocation des voix d'un 
instrument :

1  Dans une banque activée, sélectionnez 
l'instrument souhaité. 

2  Dans la fenêtre Misc Parameters, réglez le 
curseur Sound Priority à la valeur désirée. 

Recouvrement de voix

Soft Soft  SampleCell propose une fonction 
Voice Overlap qui rend plus réalistes les 
instruments dont les échantillons sont 
habituellement déclenchés de façon répétitive 
et à intervalles courts. 

Lorsque l'option Voice Overlap est sélectionnée, 
un échantillon redéclenché avant sa fin 
« normale » continue d’être lu, d’autres lectures 
étant lancées au fur à mesure des besoins, avec 
recouvrement entre les notes ainsi répétées. 
Cette méthode permet de ne pas couper 
artificiellement des sons de cymbales ride ou 
crash, par exemple, lorsqu'ils sont lus de façon 
répétitive.

La valeur 0 ne détermine aucun recouvrement 
(chaque nouvelle note étouffe ou coupe les 
notes précédentes). La valeur 99 permet aux 
échantillons de sonner pendant toute la durée 
de leur enveloppe de relâche.



Pour spécifier le recouvrement des notes 
redéclenchées :

1  Dans une banque activée, sélectionnez 
l'instrument souhaité. 

2  Dans la fenêtre Misc Parameters, réglez la 
position du curseur Overlap Amount. 

Essayez d'effectuer cette opération en jouant la 
même note sur le contrôleur MIDI de façon 
répétitive. 

Filtre

Soft SampleCell intègre un filtre passe-bas 
résonant. Ce type de filtre permet de supprimer 
ou d'accentuer certaines fréquences ou 
harmoniques dans un échantillon de forme 
d'onde. 

Vous pouvez utiliser le filtre pour modifier le 
contenu et le caractère harmoniques des 
instruments, comme vous le feriez avec les 
filtres d'un synthétiseur analogique. Les effets 
wah-wah et les balayages de filtre de type 
synthétiseur ne sont que deux des nombreux 
effets pouvant être créés.

La commande Filter Frequency détermine la 
fréquence de coupure (la fréquence en dessous de 
laquelle les harmoniques d'un échantillon de 
forme d'onde sont supprimés). Plus cette 
fréquence est élevée, plus le son est clair. Plus 
cette fréquence est basse, plus le son est sourd.

La commande Filter Resonance détermine le 
degré d'accentuation des sons au voisinage de la 
fréquence de coupure, ainsi que la suppression 
de celles qui en sont éloignées. Pour des valeurs 
élevées de résonance, les sons deviennent plus 
« nasillards » et « métalliques ».

L'utilisation excessive de la fonction 
Overlap emprunte des voix appartenant à 
d'autres instruments.
Le filtre peut fonctionner soit en mode 1 pôle, 6 
 dB/octave, soit en mode 4 pôles, 24  dB/octave. 
Le filtre à 4 pôles est mieux adapté à la création 
d'effets de filtre résonants, de type synthétiseur.

Pour régler le filtre :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Cliquez sur le bouton Misc Parameters pour 
ouvrir la fenêtre correspondante.

3  Réglez les commandes Filter Frequency et 
Filter Resonance de l'effet concerné.

Contrôle du filtre à l'aide d'une 
enveloppe

Le filtre est habituellement utilisé 
conjointement au générateur d'enveloppe. le 
but est de contrôler le comportement du filtre, à 
l'aide d'une enveloppe, chaque fois qu'une note 
est jouée. Soft SampleCell propose 3 enveloppes 
différentes. L'enveloppe 1 est attribuée, par 
défaut, à la fréquence de coupure de filtre.

Les commandes Filter Resonance ne sont 
pas disponibles lorsque le filtre fonctionne 
en mode 1 pôle.

Commandes de filtre

Pour plus d'informations sur l'utilisation 
du générateur d'enveloppe, consultez 
« Enveloppes » à la page 47.
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Pour contrôler le filtre à l'aide d'une enveloppe :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Misc Parameters en cliquant 
sur le bouton du même nom, ou en 
sélectionnant Windows > Misc Parameters. 

3  Dans le menu contextuel Filter Poles, 
sélectionnez 4 pole.

4  Choisissez une valeur moyenne fréquence de 
filtre.

5  Choisissez une valeur moyenne de résonance 
de filtre. 

6  Ouvrez la fenêtre Matrix Modulation en 
cliquant sur le bouton du même nom, ou en 
sélectionnant Windows > Matrix Modulation. 

7  Réglez le curseur Amount du chemin de 
modulation Envelope 1-to-Filter Frequency sur 
30.

8  Ouvrez la fenêtre Envelope en cliquant sur le 
bouton du même nom, ou en sélectionnant 
Windows > Envelopes.

9  Jouez une note de façon répétée sur le 
contrôleur MIDI et réglez en même temps les 
paramètres Attack, Decay, Sustain, Sustain 
Decay et Release de l'enveloppe 1.

10  Essayez plusieurs valeurs pour les paramètres 
Envelope, Envelope Amount, Filter Frequency et 
Resonance, afin d'obtenir l'effet recherché.

Qualité de rééchantillonnage

Si un instrument ne possède qu’un nombre 
réduit d'échantillons, répartis sur une étendue 
relativement large, vous risquez d'entendre des 
artefacts audio lorsque les échantillons sont lus 
7 demi-tons ou plus au-dessus de leur note de 
base MIDI.
Guide Soft SampleCell
Le menu contextuel Resampling Quality permet 
de minimiser ces artefacts en choisissant 
l’interpolation de hauteur et la qualité de 
rééchantillonnage de Soft SampleCell. Les choix 
possibles sont :

No Resampling. Désactive le rééchantillonnage, 
ce qui provoque des artefacts audio dès que les 
échantillons sont lus au-dessus de leur note de 
base MIDI. Ceci permet de créer des effets 
intéressants.

Standard. Sélectionne une qualité de 
rééchantillonnage standard. Des artefacts audio 
risquent d'apparaître si les échantillons sont lus 
7 demi-tons ou plus au-dessus de leur note de 
base MIDI.

High. Sélectionne une qualité de 
rééchantillonnage supérieure. Ceci minimise les 
artefacts audio, mais nécessite une puissance de 
calcul plus importante. Le nombre de voix 
Soft SampleCell disponibles en est réduit.

Pour sélectionner la qualité de rééchantillonnage :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Misc Parameters en cliquant 
sur le bouton du même nom, ou en 
sélectionnant Windows > Misc Parameters. 

3  Dans le menu contextuel Resampling Quality, 
sélectionnez le type de rééchantillonnage à 
utiliser.

Menu contextuel Resampling Quality



Enveloppes
Les générateurs d'enveloppe mettent en forme, 
entre autres, le volume et la fréquence de 
coupure de filtre d'un instrument, chaque fois 
qu'une note est jouée.

Soft SampleCell propose trois générateurs 
d’enveloppe distincts, avec des paramètres 
d'attaque, de retombée, de maintien et de 
relâchement, ainsi que d'autres paramètres.

Attack. Détermine le temps nécessaire à 
l'enveloppe pour atteindre son niveau maximal 
lorsqu'une note est jouée pour la première fois. 
Plus cette valeur est élevée, plus l'attaque est 
douce et lente.

Decay. Détermine le temps nécessaire à 
l'enveloppe pour passer de son niveau crête au 
niveau de maintien (Sustain).

Sustain. Détermine le niveau auquel l'enveloppe 
se maintient après la phase de retombée 
(Decay). Plus cette valeur est élevée, moins le 
son « retombe » après l’attaque. Higher Attack 
values produce softer, slower attacks.

Sustain Decay. Ajoute un niveau de maintien 
secondaire, vers lequel l'enveloppe descend 
pendant la phase de maintien.

Release. Détermine la vitesse à laquelle le 
volume diminue une fois que la note est 
relâchée. Plus cette valeur est élevée, plus le 
volume met de temps à passer du niveau de 
maintien au niveau zéro (silence).

Paramètres d'enveloppe
Envelope Amount. Détermine la façon dont 
l'enveloppe influence le volume, la fréquence de 
coupure du filtre ou tout autre paramètre de 
l'instrument auquel elle est assignée. Plus cette 
valeur est élevée, plus l'enveloppe a d'influence.

Gate Time. Détermine la durée « d’ouverture » 
de l'enveloppe, même si la note est relâchée. 

L'ajout d'une valeur de Gate Time à une 
enveloppe est utile lorsque vous travaillez 
avec des instruments de type batterie, dont 
les notes sont brèves, car il permet de 
maintenir plus facilement l'ambiance de la 
pièce à la fin des échantillons. Cette 
ambiance risque sinon d'être perdue lorsque 
la note est relâchée aussitôt après avoir été 
frappée.
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Utilisation des enveloppes

Les enveloppes sont principalement utilisées 
pour le contrôle du volume et du contenu 
harmonique des sons. Pour cette raison, 
l'enveloppe 3 est constamment assignée à 
l'amplitude et l'enveloppe 1 à la fréquence de 
coupure du filtre, par défaut. 

L'utilisation de la matrice de modulation permet 
l'utilisation de n’importe quel paramètre de 
contrôle des trois enveloppes pour agir sur la 
hauteur, le panoramique, la vitesse de 
l'oscillateur à basse fréquence, pour ne citer que 
ces exemples. 

Pour plus d'informations sur l'utilisation de la 
matrice de modulation pour l'attribution des 
enveloppes et des autres sources de modulation, 
consultez « Modulation de matrice » à la 
page 49.

Pour ouvrir la fenêtre Envelope :

1  Dans la fenêtre Bank, cliquez sur le bouton 
Envelope, ou sélectionnez Windows > Envelope.

Format d'affichage de l'enveloppe

Les paramètres de l'enveloppe peuvent être 
affichées sous forme de segments ou de curseurs. 
Utilisez la boîte de dialogue SampleCell 
Preferences pour choisir le format d'affichage. 

Bouton Envelope
Guide Soft SampleCell
Pour sélectionner le format d'affichage des 
paramètres de l'enveloppe :

1  Sélectionnez SampleCell > Preferences.

2  Pour afficher les commandes de l'enveloppe 
sous forme de segments, sélectionnez Display 
Line Segment Envelopes.

– ou –

3  Pour afficher les commandes de l'enveloppe 
sous forme de curseurs, désélectionnez Display 
Line Segment Envelopes.

4  Refermez puis ouvrez à nouveau la fenêtre 
Envelope pour que les modifications prennent 
effet.

5  Pour modifier les paramètres de l'enveloppe, 
faites glisser le curseur ou le point d’inflexion du 
segment correspondant.

Commandes de l'enveloppe sous forme de segments



Valeurs des paramètres de l'enveloppe

Les valeurs des paramètres d'enveloppe et des 
autres paramètres peuvent être affichées en 
millisecondes, décibels et autres unités usuelles, 
ou en unités propres à Soft SampleCell. Utilisez 
la boîte de dialogue SampleCell Preferences pour 
choisir le format à utiliser.

Pour sélectionner le format d'affichage des 
valeurs de paramètres :

1  Sélectionnez SampleCell > Preferences, puis 
Display Controls in Real Units pour utiliser les 
millisecondes, les décibels et autres unités 
usuelles.

– ou –

2  Désélectionnez Display Controls in Real Units 
pour utiliser les unités de Soft SampleCell.

3  Refermez puis ouvrez à nouveau la fenêtre 
Envelope pour que les modifications prennent 
effet.

Commandes de l'enveloppe sous forme de curseurs
Suivi de touche de l'enveloppe

Les enveloppes peuvent « suivre » le clavier, de 
façon à voir leur durée diminuer 
progressivement lorsque les notes MIDI 
deviennent plus aiguës, ou augmenter 
lorsqu'elles deviennent plus graves. Cette 
possibilité est utile pour la simulation 
d'instruments acoustiques (cuivres, par 
exemple), où les instruments de haut registre, 
tels que les trompettes, possèdent des attaques 
beaucoup plus rapides que les instruments de 
bas registre, tels que les tubas.

Pour activer le suivi de touche de l'enveloppe :

■ Dans la fenêtre Envelope, sélectionnez 
Keyboard Track.

Modulation de matrice
La matrice de modulation permet d'assigner 
toute une gamme de sources de modulation à 
toute une série de destinations de modulation. 
Les assignations de modulation les plus 
courantes sont :

• Le contrôle de la fréquence de coupure du 
filtre avec la molette de modulation d'un 
contrôleur MIDI

• Le contrôle du volume de l'instrument avec 
un oscillateur à basse fréquence pour des 
effets trémolo.

• Le contrôle de la fréquence de coupure du 
filtre avec un oscillateur à basse fréquence 
pour des effets wah-wah automatiques.

• Le contrôle de la hauteur de l'échantillon avec 
le générateur aléatoire pour des effets 
d'échantillonnage et de maintien (S&H).
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Tous les nouveaux instruments possèdent cinq 
chemins de modulation prédéfinis :

Fenêtre Matrix Modulation

Sources de modulation

Destinations de modulation
Guide Soft SampleCell
• Vélocity to Sample Select (la vélocité MIDI 
déclenche les échantillons dans les zones de 
vélocité appropriées)

• LFO 1 to Pitch (vibrato)

• Modulation Wheel to LFO 1 Amplitude (la 
molette de modulation contrôle l’intensité du 
vibrato)

• Sustain Pedal to Envelope 3 Release (pédale de 
maintien standard, comme sur un piano)

• Envelope 1 to Filter Frequency

Ces assignations de modulation par défaut 
peuvent être supprimées en sélectionnant 
l'espace blanc situé en bas des menus 
contextuels Source et Destination.

Paramètres de modulation

Il existe en tout 20 chemins de modulation 
paramétrables par l'utilisateur. Chaque chemin 
est définis par les paramètres Source, 
Destination, Gate enable et Modulation 
Amount. 

Source. Sélectionne la source de modulation.

Destination. Sélectionne la destination de 
modulation.

Amount. Détermine l'intensité de la modulation. 
Plus cette valeur est élevée, plus la modulation 
est importante. Les valeurs négatives inversent 
l'effet de modulation. Pour définir ce paramètre, 
cliquez sur le curseur du menu local situé à côté 
de la zone de texte.

Les assignations de la matrice de 
modulation peuvent être enregistrées comme 
paramètres par défaut pour les nouveaux 
instruments en sélectionnant Instruments > 
Set Instrument Defaults.



Gated. Lorsque ce paramètre est sélectionné, la 
modulation ne s'applique que lorsqu'une note 
MIDI est maintenue. Elle s'interrompt dès que la 
note est relâchée. 

Pour utiliser la matrice de modulation :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Matrix Modulation en 
cliquant sur le bouton du même nom, ou en 
sélectionnant Windows > Matrix Modulation.

3  Dans le menu contextuel Source, sélectionnez 
une source de modulation.

4  Dans le menu contextuel Destination, 
sélectionnez une destination de modulation.

5  Réglez la position du curseur Amount sur le 
degré de modulation souhaité.

Touches de raccourci

Il existe plusieurs touches de raccourci pour les 
paramètres de la matrice de modulation.

Pour régler l'amplitude sur la valeur maximale 
(+99) :

■ Maintenez les touches Option et Maj 
enfoncées, et cliquez sur la valeur d'amplitude 
(et non sur le curseur). 

Bouton Matrix Modulation

Pour obtenir une intensité de modulation 
supérieure à l’amplitude normale, créez un 
deuxième (voire un troisième) chemin de 
modulation avec la même source et la même 
destination.
Pour régler l'amplitude sur la valeur minimale 
(-99) :

■ Maintenez les touches Option et Contrôle 
enfoncées, et cliquez sur la valeur d'amplitude.

Pour remettre l'amplitude à zéro :

■ Maintenez la touche Option enfoncée et 
cliquez sur la valeur d'amplitude.

Pour supprimer une source ou une destination :

■ Maintenez la touche Option enfoncée et 
cliquez sur le menu contextuel Source ou 
Destination. 

Sources de modulation avec leurs 
propres commandes Amount

Certaines sources de modulation, telles que les 
enveloppes, les oscillateurs à basse fréquence et 
les contrôleurs MIDI, possèdent leur propre 
commande Amplitude. Cette commande a 
priorité sur la commande Amount de la matrice 
de modulation et détermine le degré total de 
modulation disponible. 

Si la commande Amplitude de l'une de ces 
sources de modulation est réglée sur 0, aucune 
modulation ne peut être appliquée. Assurez-
vous que la commande Amplitude de vos 
sources de modulation est correctement réglée 
avant de les utiliser pour la modulation de 
matrice.

Modulation du panoramique des 
instruments stéréo

 Dans le cas d’instruments stéréo, pour créer un 
effet de panoramique stéréo en assignant un 
oscillateur à basse fréquence au panoramique, il 
faut créer deux chemins de modulation avec la 
même assignation LFO-to-Panning pour que 
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Soft SampleCell effectue un panoramique sur les 
deux canaux. Dans le cas des instruments 
monophoniques, il suffit de créer un seul 
chemin de modulation LFO-to-Panning. 

Modulateurs
La fenêtre Modulators renferme les paramètres 
de 5 modulateurs différents : LFO 1, LFO 2, 
Ramp Generator, MIDI Controller A et MIDI 
Controller B. Ces paramètres peuvent être 
utilisés à la fois comme sources et comme 
destinations de modulation dans la fenêtre 
Matrix Modulation.

Pour ouvrir la fenêtre Modulators :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Cliquez sur le bouton Misc Parameters, ou 
sélectionnez Windows > Modulators. 

Bouton Modulators

Fenêtre Modulators
Guide Soft SampleCell
LFO 1 et 2

Les oscillateurs à basse fréquence LFO1 et LFO2 
produisent chacun des formes d'onde 
périodiques correspondant aux paramètres 
suivants :

Waveform. Sélectionne la forme d'onde Sine, 
Triangle, Upward Sawtooth, Downward 
Sawtooth, Square, Random ou Noise. Les ondes 
Sine et Triangle sont habituellement utilisées 
pour moduler la hauteur des effets de vibrato. 
Les ondes Square sont habituellement utilisées 
pour moduler la hauteur ou l'amplitude des 
trilles ou des effets trémolo.

Mode Trigger. Sélectionne la méthode et le 
moment de création de la forme d'onde.

• Free Run crée une forme d'onde libre, sans 
synchronisation de phase entre LFO ni 
redéclenchement. Par conséquent, lorsque la 
modulation est enclenchée, la forme d’ondes 
peut commencer à n'importe quel moment du 
cycle. Ceci confère un caractère plutôt 
aléatoire à la modulation LFO.

• Sync synchronise la phase de toutes les formes 
d'ondes des LFOs dans toutes les voix 
Soft SampleCell, afin de simuler une 
modulation uniforme assurée par un seul 
oscillateur à basse fréquence. 

• Trig relance la forme d'onde du LFO chaque 
fois qu'une note MIDI est jouée. Ce procédé 
s'avère utile pour les trilles et pour les effets 
qui nécessitent une modulation régulière 
d'une note à l'autre.

• Sync & Trig combine les attributs des 
paramètres Sync et Trig.

Speed. Règle la fréquence de l'oscillateur à basse 
fréquence. Plus la fréquence est élevée, plus la 
modulation est rapide.



Amplitude. Détermine le degré global de 
modulation disponible pour une matrice de 
modulation. Plus l'amplitude est forte, plus la 
modulation est intense.

Pour déterminer la forme d'onde d'un oscillateur à 
basse fréquence :

1  Sélectionnez une forme d'onde dans le menu 
contextuel Waveform.

Générateur de rampe

Le générateur de rampe produit un signal de 
contrôle discontinu ouen rampe. Le signal 
commence à un niveau normal, puis augmente 
à une vitesse définie pour atteindre un autre 
niveau. Les valeurs d'amplitude de modulation 
positives font monter la rampe. Les valeurs 
d'amplitude de modulation négatives la font 
descendre.

Le curseur Ramp Time détermine la vitesse à 
laquelle la rampe du signal monte ou descend.

L'assignation du générateur de rampe à la 
hauteur (pitch), par exemple, produit un effet de 
glissement de hauteur du son. Une amplitude de 
modulation de +50 fait glisser la hauteur sur une 
octave. Une amplitude de modulation de -50 
fait descendre la hauteur sur une octave.

Formes d'onde LFO
Contrôleurs MIDI A et B

Soft SampleCell permet de choisir deux 
contrôleurs MIDI (dans une liste de 120) comme 
sources de modulation. Ceci permet, par 
exemple, d'utiliser un contrôleur de souffle 
(contrôleur MIDI n˚2) pour moduler le volume, 
ou une pédale (contrôleur MIDI n˚4) pour 
moduler l'amplitude du LFO.

Pour assigner le contrôleur MIDI A ou B :

■ Cliquez sur le menu contextuel MIDI 
Controller et sélectionnez le numéro de 
contrôleur de votre choix : 

Pour connaître la liste des numéros de 
contrôleurs MIDI, consultez annexe C, 
« Numéros de contrôleur MIDI ».

Sélection d'un numéro de contrôleur MIDI

Pour assigner directement un contrôleur 
MIDI, il suffit de maintenir la touche 
Contrôle enfoncée tout en cliquant sur la 
zone de texte MIDI Controller, puis de 
manipuler le contrôleur souhaité (une 
molette de modulation, par exemple) sur le 
clavier de contrôle MIDI.
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Trackers
Le générateur de suivi permet d’agir sur un 
signal de modulation en fonction d'une courbe 
modifiable, comportant neuf points d’inflexion. 

Pour ouvrir la fenêtre Trackers :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Cliquez sur le bouton Trackers, ou 
sélectionnez Windows > Trackers. 

Par défaut, la courbe de modulation du 
générateur de suivi est linéaire. La forme de la 
courbe qui fait varier le signal de modulation est 
créée par déplacement des points d’inflexion. 

Bouton Trackers

Fenêtre Trackers
Guide Soft SampleCell
Un menu contextuel situé au-dessus de chaque 
générateur de suivi permet de sélectionner la 
source de modulation correspondant au tracker. 
Lorsque le générateur de suivi est ensuite utilisé 
dans la matrice de modulation, son 
comportement habituel est modifié par la 
courbe que vous avez créée.

Voici quelques applications du générateur de 
suivi :

• Modifier la réponse de la molette de hauteur 
via une courbe de suivi exponentielle, ce qui 
produit une variation de hauteur beaucoup 
plus grande à la fin de la course de la molette 
de pitch. 

• Modifier la réponse de la molette de 
modulation via une courbe de suivi 
exponentielle, ce qui produit une modulation 
beaucoup plus intense à la fin de la course de 
la molette de modulation. 

• La modification de la réponse au numéro de 
note MIDI pour la création d'échelles 
microtonales. 

Cibles de modulation du générateur de suivi

Courbe exponentielle



Pour utiliser le générateur de suivi :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Cliquez sur le bouton Trackers, ou 
sélectionnez Windows  > Trackers. 

3  Dans le menu contextuel, sélectionnez la 
source de modulation à modifier.

4  Faites glisser les points d’inflexion sur le 
tracker, afin de créer la courbe de suivi 
souhaitée.

5  Ouvrez la fenêtre Matrix Modulation et 
assignez la source de modulation à la 
destination de votre choix.

6  Faites glisser le curseur Amount jusqu'au 
niveau souhaité. Les valeurs négatives inversent 
l'effet de modulation.

Pour des exemples supplémentaires, 
consultez « Utilisation de trackers 
(« suiveurs ») » à la page 71.

Pour rétablir la position d'origine d’un point 
d’inflexion, maintenez la touche Option 
enfoncée et cliquez dessus.
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chapitre 4 

Modification et bouclage d’échantillons
L’éditeur Soft SampleCell possède sa propre 
fenêtre Loop permettant d’ajouter, de modifier 
et de supprimer des points de bouclage dans les 
échantillons. Elle fournit tous les outils requis 
pour transformer les échantillons en boucles de 
qualité. 

La fenêtre Loop comporte également des 
fonctions de trim de l’audio, permettant de 
trimmer (« rogner ») des données audio inutiles 
situées avant et/ou après la boucle.

Utilisez la fenêtre Loop pour :

◆ Créer jusqu’à deux boucles dans un fichier 
audio

◆ Trimmer l’audio (supprime l’ensemble de 
l’audio non sélectionné)

◆ Effectuer des crossfades, des boucles en 
avant/en arrière, etc.

◆ Enregistrer les fichiers directement depuis la 
fenêtre Loop

◆ Ouvrir les fichiers audio depuis le disque ou 
depuis les instruments Soft SampleCell

◆ Afficher les infos concernant les données de 
boucles, écouter et modifier/déplacer les boucles 
tout en suivant et en déclenchant l’échantillon 
depuis les contrôleurs MIDI externes
Types de boucles
Soft SampleCell prend en charge un maximum 
de deux boucles dans un fichier audio.

Echantillons à boucle unique

Si un fichier audio possède une seule boucle, 
Soft SampleCell va lire l’échantillon depuis le 
début de la boucle, puis passe à la lecture de la 
partie mise en boucle de l’échantillon tant que 
la note est maintenue enfoncée.  Lorsque cette 
note est relâchée, Soft SampleCell va continuer 
de lire la boucle tandis que le son s’affaiblit en 
fonction de son enveloppe actuelle. 

Si un fichier audio ne possède qu’une seule 
boucle, on parle de boucle de Sustain/Release, 
puisqu’elle est utilisée à la fois pour la partie 
tenue et la partie relâchée de la note. 
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Echantillons à deux boucles

Si un fichier audio possède deux boucles, Soft 
SampleCell lit la première boucle (la boucle de 
maintien) tant que la note dure. Lorsque la note 
est relâchée, il lit la deuxième boucle (la boucle 
de retombée) pour « accompagner » la 
disparition de la note.

Les deux conditions suivantes doivent être 
remplies pour les boucles :

• Les deux boucles ne doivent pas se 
chevaucher (la boucle 1 doit finir avant le 
début de la boucle 2)

• La durée de chaque boucle doit correspondre 
au moins à celle d’un cycle complet de forme 
d’onde, ou de cinq images de l’échantillon

La Fenêtre Loop
La fenêtre Loop permet de travailler sur un 
échantillon de manière non destructive, jusqu’à 
ce que vous décidiez d’enregistrer vos 
modifications.

Vous pouvez ouvrir un échantillon déjà utilisé 
dans un instrument, ou charger un fichier audio 
depuis le disque.

Pour ouvrir un échantillon en cours d’utilisation 
dans un instrument :

1  Dans la fenêtre Bank, sélectionnez 
l’instrument souhaité, puis cliquez sur le bouton 
Sample Map.

2  Dans la fenêtre Sample Map, sélectionnez 
l’échantillon à modifier, puis cliquez sur le 
bouton Loop ou choisissez Instruments > Edit 
(nom d’échantillon).

Pour éviter les notes coincées, arrêtez 
toujours la lecture du séquenceur avant 
d’ouvrir la fenêtre Loop.
Guide Soft SampleCell
Pour ouvrir un échantillon sur le disque (et non pas 
dans un instrument) :

1  Choisissez Instruments > Edit Loops.

Outils de la fenêtre Loop

Cette fenêtre contient des outils permettant de 
définir, de modifier et d’écouter des boucles, 
ainsi que de sélectionner et de trimmer de 
l’audio.

Menu Loop

Il s’agit d’un menu contextuel permettant 
d’enregistrer un fichier audio après l’avoir 
modifié. 

Save Audio File. Permet d’enregistrer 
l’échantillon modifié. S’il est en cours 
d’utilisation dans l’instrument actuel, 
l’échantillon est aussi mis à jour dans 
l’instrument. 

Save Audio File As. Permet d’enregistrer 
l’échantillon modifié sous un nouveau nom ou 
dans un nouvel emplacement. Cette commande 
crée automatiquement un instrument utilisant 
l’échantillon sur tout son groupe de touches. 

Bouton Loop

Menu Loop et outils Loop



Save As Audio File Copy. Permet d’enregistrer 
une copie de l’échantillon modifié sur le disque 
sans mise à jour (ni création) de l’instrument. 

Save Audio Selection As. Permet d’enregistrer le 
segment audio actuellement sélectionné comme 
nouveau fichier sur le disque. 

Revert Audio File. Permet de restaurer l’état 
d’origine, tel que précédemment enregistré, de 
l’échantillon actuel.

Bouton Haut-parleur

Le bouton Haut-parleur lit l’échantillon actuel 
(via le Sound Manager du Macintosh) par la 
sortie audio de l’ordinateur, au niveau sonore 
défini actuellement. 
Pour ne pas utiliser Sound Manager et lire 
l’échantillon à l’aide de la configuration 
audio de Soft SampleCell, cliquez sur le 
bouton Send to Instrument et déclenchez 
l’échantillon en lisant les notes sur votre 
contrôleur MIDI.

Bouton Haut-parleur
Fenêtre Loop

SélecteurEnvoyer à l’instrument

Supprimer
le marqueur de
boucle

Marqueur de fin de
boucle

Passage à zéro

Haut-parleur
(lire l’échantillon)

Menu de boucle

Echanger les boucles

Trimmer la sélection

Flèches de zoom

Début de la
boucle
Marqueur

Marqueur de fin de
boucle

Affichage de la
boucle

Défilement

Forme
d'onde
Affichage
(stéréo)

Faire défiler
jusqu’au Point de
bouclage

Sélectionner la
boucle
Type/Sens

Zones de
données de
boucles

Zones de
données de
sélection

Sélectionner
la boucle

Sélectionner le canal
Ecoute
en stéréo

Lire la boucle
uniquement

Boucle de
crossfade

Fin de la
boucle

Début de la boucle Recherche automatique
du point de bouclage

Marqueur de début
de boucle
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Bouton Send to Instrument

Si vous cliquez sur ce bouton, le contenu de la 
fenêtre Loop est envoyé à Soft SampleCell pour 
être lu. Si l’échantillon n’est pas actuellement 
utilisé dans un instrument, un nouvel 
instrument, à échantillon unique, est 
automatiquement créé. Si l’échantillon est 
utilisé actuellement dans un instrument, 
l’instrument est mis à jour pour utiliser 
l’échantillon modifié. Vous pouvez lire 
l’échantillon en le déclenchant à partir de votre 
contrôleur MIDI.

Bouton Swap Loops

Si un échantillon contient une seule boucle 
(boucle 1), celle-ci deviendra la boucle 2 si vous 
cliquez sur ce bouton. La boucle de 
maintien/retombée devient une boucle de 
retombée seule. Vous pouvez alors créer une 
boucle de retombée qui la précède. 

Cette option est pratique si, après avoir trouvé 
un bon point de bouclage Sustain/Release, vous 
décidez de l’utiliser comme boucle de retombée 
seule (ce qui permet de trouver et de créer un 
emplacement de boucle de maintien).

Bouton Send to Instrument

Bouton Swap Loops
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Outil Trim

L’outil Trim supprime les données audio situées 
avant et après une sélection, pour ne conserver 
que la sélection. Sélectionnez l’audio avec l’outil 
Selector, puis cliquez sur l’outil Trim, afin 
d’effectuer le trim.

Flèches de zoom

Ces flèches effectuent un zoom avant sur la 
forme d’onde audio dans la fenêtre Loop. Les 
flèches du haut/du bas augmentent/diminuent 
la hauteur de la forme d’onde, tandis que les 
flèches droite/gauche effectuent un zoom 
avant/arrière le long de la timeline (axe des 
temps). Cliquez sur une flèche Zoom tout en 
maintenant la touche Option enfoncée pour 
effectuer un zoom avant ou arrière pour une 
résolution maximale.

Ne trimmez pas trop d’audio à proximité 
des points de boucle, ou vous risquez de ne 
plus pouvoir créer une boucle de crossfade. 
Les boucles de crossfade utilisent les points 
de boucle de bordure de l’audio.

Bouton Trim Tool

Vous pouvez également utiliser les touches 
de flèches du clavier de votre ordinateur 
pour effectuer un zoom avant ou arrière.

Flèches de zoom



Sélecteur

Utilisez le sélecteur pour déplacer les marqueurs 
de boucle ou sélectionner l’audio dans la fenêtre 
Loop. Pour sélectionner des données audio, 
faites glisser le sélecteur dans la forme d’onde. 
Pour déplacer un marqueur de boucle, faites-le 
glisser. 

Marqueurs de début et de fin de boucle

Pour définir les points de début ou de fin de 
boucle, faites glisser un marqueur de début ou 
de fin de boucle sur une forme d’onde. Les 
premiers marqueurs placés sur une forme 
d’onde sont définis automatiquement comme 
marqueurs de boucle 1 (Sustain/Release). Faites-
en glisser une deuxième paire pour définir la 
boucle 2 (retombée uniquement).

Consultez « Création de boucles » à la page 63 
pour plus d'informations sur l’ajout des 
marqueurs de boucle.

Supprimer le marqueur de boucle

Sélectionnez cet outil, puis cliquez sur un 
marqueur de boucle pour le supprimer. 

Sélecteur

Marqueurs de début et de fin de boucle

Supprimer le marqueur de boucle
Affichage de la boucle

Cette fenêtre présente un gros plan de la partie 
mise en boucle d’un échantillon. La partie 
gauche présente la fin de la boucle. La partie 
droite présente le début de la boucle. 

Flèches de défilement

Cliquer sur ces flèches envoie un marqueur de 
boucle plus tôt (flèche gauche) ou plus tard 
(flèche droite) dans le fichier audio. Les flèches 
de défilement sont particulièrement bien 
adaptées aux ajustements par incréments des 
points de boucle. Pour des ajustements plus 
importants, faites glisser l’un des marqueurs de 
boucle dans la partie supérieure de l’affichage de 
la forme d’onde.

Recherche automatique du point de 
bouclage

Si vous cliquez sur la flèche Auto-Locate Loop 
Point, un point de bouclage approprié est 
automatiquement recherché dans un 
échantillon en fonction de la valeur et de la 
pente du marqueur de boucle correspondant. 

Outils d’affichage de la boucle

Cliquez sur les flèches de défilement tout en 
maintenant la touche Pomme enfoncée pour 
ralentir le défilement.

Flèches de défilement

fin de la boucle début de la boucle
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Si, par exemple, vous ajustez la fin de la boucle, 
le fait de cliquer sur la flèche droite Auto-Locate 
Loop va entraîner le déplacement du point de 
fin de boucle sur le prochain cycle d’onde 
correspondant à la pente et à l’amplitude du 
début de boucle. 

Si vous cliquez sur la flèche gauche Auto-Locate 
Loop, le même marqueur est déplacé plus tôt 
dans le fichier audio pour trouver un 
emplacement convenable. 

N’oubliez pas que même si ces outils font 
correspondre l’emplacement d’un marqueur à la 
pente et à l’amplitude d’un autre, vous n’avez 
aucune garantie d’obtenir une boucle parfaite. 
Vous devrez probablement vous servir de vos 
oreilles et de l’outil Crossfade Loop pour parfaire 
la plupart des boucles.

Flèches de zoom de boucle

Ces flèches permettent de régler le niveau de 
zoom. Les flèches vers le bas/vers le haut 
permettent d’augmenter/diminuer la hauteur 
des formes d’onde. Les flèches gauche/droite 
permettent d’augmenter/diminuer le zoom 
horizontal. 

Recherche automatique du début/de la fin de la boucle

Flèches de zoom de boucle
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Case Stéréo

Cette case permet d’écouter les canaux séparés 
d’une boucle stéréo. Lorsqu’elle est 
sélectionnée, les deux canaux d’un échantillon 
stéréo sont écoutés. Lorsqu’elle est 
désélectionnée, c’est le canal sélectionné avec le 
bouton Channel Select qui est écouté.

Bouton Crossfade Loop

Si vous cliquez sur ce bouton, la boîte de 
dialogue Crossfade Loop s’ouvre et vous permet 
de sélectionner le type et la durée du crossfade. 
Vous pouvez choisir un crossfade linéaire ou un 
crossfade de puissance constante, ainsi qu’une 
boucle avant ou arrière.

Bouton Loop Select

Cliquer sur ce bouton détermine quelle boucle 
(s’il y en a deux dans l’échantillon) sera affichée 
pour édition dans Loop Display. 

Bouton Channel Select

Si vous cliquez sur ce bouton, la boucle du canal 
droit ou gauche d’un échantillon stéréo 
s’affiche. 

Pour en savoir plus, reportez-vous à la 
section « Création de crossfades » à la 
page 66.

Bouton Crossfade Loop

Bouton Loop Select



Bouton haut-parleur

Le bouton haut-parleur lit la boucle 
sélectionnée via les sorties audio de l’ordinateur, 
en utilisant le Sound Manager du Macintosh. Si 
le bouton Send to Instrument est sélectionné, 
vous pouvez écouter la boucle lorsque vous la 
modifiez en la déclenchant à nouveau sur votre 
contrôleur MIDI. 

Loop Info

La région Loop Info offre des zones de texte 
modifiables pour les points de début et de fin de 
boucle et de sélection audio. Si vous cliquez sur 
l’icône Loupe, le point de bouclage sélectionné 
s’affiche. Un menu contextuel sélectionne le 
type de boucle.

Pour définir  numériquement les points de boucle 
ou de sélection :

1  Cliquez sur la zone de texte. 

2  Entrez une valeur numérique, puis appuyez 
sur la touche Return. 

Bouton Channel Select

Bouton haut-parleur
Création de boucles
Dans cette section, vous allez apprendre à créer 
des boucles. La première étape consiste à ouvrir 
l’échantillon dans la fenêtre Loop.

Pour ouvrir un échantillon utilisé actuellement 
dans un instrument :

1  Dans la fenêtre Bank, sélectionnez 
l’instrument souhaité, puis cliquez sur le bouton 
Sample Map.

2  Dans la fenêtre Sample Map, sélectionnez 
l’échantillon à modifier, puis cliquez sur le 
bouton Loop ou choisissez Instruments > Edit 
(nom de l’échantillon).

Pour ouvrir un échantillon sur le disque (et non pas 
dans un instrument) :

1  Choisissez Instruments > Edit Loops.

Loop Info

Bouton Loop
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Recherche de bons points de 
boucle

Pour créer une bonne boucle d’instrument, vous 
devez rechercher une zone dans une forme 
d’onde où les données audio, aux points de 
début et de fin de boucle, se ressemblent le plus 
possible au niveau du timbre, du niveau et de la 
forme d’onde. 

Vous éviterez de la sorte toute saute de niveau, 
click numérique et autre artefact audio audible 
au point de jonction–le point où le début et la fin 
de boucle se rencontrent. Les meilleurs points 
de boucle se trouvent généralement dans une 
zone de la forme d’onde plutôt stable et 
répétitive. 

Utilisez l’affichage de la forme d’onde pour 
rechercher, si possible, un motif répétitif dans la 
forme d’onde. Ensuite, faites glisser les 
marqueurs de boucle aux points approximatifs 
de début et de fin de la boucle.

Pour créer une boucle :

1  Cliquez sur le marqueur de début de boucle, 
puis sur le point souhaité dans l’affichage de la 
forme d’onde.

Bon emplacement de boucle

Marqueurs de début et de fin de boucle

Motif répétitif
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2  Ensuite, cliquez sur le marqueur de fin de 
boucle, puis sur le point souhaité dans 
l’affichage de la forme d’onde.

3  Cliquez sur le bouton Haut-parleur dans 
l’affichage Loop pour écouter la boucle. Les 
boucles sont toujours écoutées via le Sound 
Manager du Macintosh.

Affinage d’une boucle

A ce moment, il est rare qu’une boucle soit 
parfaite. Utilisez Loop Display pour afficher le 
point de jonction et affiner précisément sa 
position. 

Pour régler une boucle avec précision :

1  Cliquez sur les flèches de défilement pour 
déplacer les marqueurs de début ou de fin de 
boucle. Cliquez tout en appuyant sur la touche 
Pomme pour ralentir le défilement.

2  Faites correspondre les pentes ascendante et 
descendante de la forme d’onde au passage à 
zéro–le point de croisement dans Loop Display.

Voir « Ecoute de boucles » à la page 65 pour 
plus d’informations sur les autres méthodes 
d’écoute de la boucle ou de l’ensemble de 
l’échantillon.

Bon point de jonction

bonne correspondance de la jonction au passage par zéro



3  Si vous ne trouvez pas de bon point de 
jonction, essayez de cliquer sur l’un des boutons 
Auto-Locate Loop Point.

Ecoute de boucles

Vous pouvez écouter une boucle de différentes 
manières. Le bouton Haut-parleur de l’affichage 
Loop ne permet d’écouter que la boucle elle-
même. Vous pouvez écouter le reste de 
l’échantillon via le Sound Manager du 
Macintosh ou dans un instrument 
Soft SampleCell et votre configuration audio 
actuelle Soft SampleCell.

Utilisation de Sound Manager

Pour lire un échantillon dans la fenêtre Loop :

■ Cliquez sur le bouton Haut-parleur. 
L’échantillon est lu depuis son début juusqu’à la 
partie audio mise en boucle, qui se répète.

Pour lire l’ensemble de l’échantillon, en ne tenant 
pas compte des boucles et des sélections :

■ Cliquez sur le bouton Haut-parleur tout en 
appuyant sur la touche Option.

Mauvaise jonction

Cliquez sur la forme d’onde dans la partie 
droite ou gauche de l’affichage Loop, pour 
que le marqueur de boucle correspondant se 
positionne à cet emplacement.

mauvaise correspondance du point de jonction
Pour ne lire que la boucle :

■ Cliquez sur le bouton Haut-parleur dans la 
zone Loop Display.

Pour ne lire que les données audio sélectionnées :

1  Choisissez une partie de la forme d’onde à 
l’aide du sélecteur.

2  Cliquez sur le bouton Haut-parleur.

Utilisation de Soft SampleCell

Pour écouter un échantillon dans la 
configuration audio Soft SampleCell, vous allez 
utiliser le bouton Send to Instrument. Ceci 
permet également de déclencher l’échantillon à 
l’aide d’un contrôleur MIDI.

Si vous cliquez sur le bouton Send to 
Instrument, le contenu de la fenêtre Loop est 
envoyé à Soft SampleCell pour être lu. Si 
l’échantillon n’est pas actuellement utilisé dans 
un instrument, un instrument à échantillon 
unique est créé automatiquement. Si 
l’échantillon est utilisé actuellement dans un 
instrument, l’instrument est mis à jour pour 
utiliser l’échantillon modifié.

Vous pouvez également appuyer sur la barre 
d’espacement pour lancer la lecture.

Bouton Send to Instrument
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Pour lire un échantillon dans un instrument Soft 
SampleCell :

1  Cliquez sur le bouton Send to Instrument. Ce 
bouton reste sélectionné tant que vous ne 
cliquez pas dessus une autre fois.

2  Tapez sur les touches du contrôleur MIDI.

Création de crossfades 

Pour créer une bonne boucle, il est souvent 
nécessaire d’effectuer le crossfade dans la 
transition entre les points de début et de fin de 
boucle afin de « lisser » les artefacts audio. 

Avant de créer une boucle de crossfade, il est 
important de rechercher un bon point de 
bouclage et d’essayer d’ajuster le point de 
jonction le mieux possible. Même un crossfade 
ne peut pas corriger une jonction réellement 
mauvaise.

Pour assurer une bonne lecture des transitions 
de boucle, les crossfades sont centrés sur les 
points de début et de fin de boucle. Pour cette 
raison, il est essentiel qu’il y ait suffisamment de 
données audio dans l’échantillon avant et après 
les points de boucle. Celles-ci feront en effet 
partie du crossfade.

Lorsque le bouton Send to Instrument est 
sélectionné, à chaque fois que vous modifiez 
un échantillon dans la fenêtre Loop, 
l’échantillon est mis à jour dans 
l’instrument dans lequel il se trouve. 
Toutefois, les modifications restent 
provisoires, tant que vous n’avez pas 
enregistré à nouveau l’échantillon ou 
l’instrument.
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Paramètres de crossfade

Crossfade Type. Offre un crossfade linéaire ou à 
puissance constante. Un crossfade linéaire utilise 
une courbe de crossfade plate (linéaire) et est 
mieux adapté à la plupart des applications. Un 
crossfade à puissance constante utilise une 
courbe non linéaire. Ce type de crossfade est 
utile si le milieu de votre crossfade semble 
chuter en niveau. 

Crossfade Length. Détermine la durée de forme 
d’onde, située de part et d’autre des points de 
bouclage, qui sera incluse dans le crossfade. Pour 
cette raison, la durée du crossfade doit être 
inférieure à la durée totale de la boucle ; 
inférieure à la durée de la forme d’onde entre le 
tout début du fichier audio et le début de la 
boucle ; et inférieure à la durée de la forme 
d’onde entre la fin de la boucle et la fin du 
fichier audio.

Pour créer une boucle de crossfade :

1  Lorsque l’échantillon est ouvert dans la 
fenêtre Loop et lorsque les points de bouclage 
sont définis, cliquez sur le bouton Crossfade.

Boîte de dialogue Crossfade Loop

Bouton Crossfade



2  Sélectionnez le type et la durée de crossfade 
souhaités, puis cliquez sur OK.

Ajout d’une deuxième boucle

Soft SampleCell peut reconnaître deux boucles 
distinctes dans un fichier audio. Lorsqu’il 
n’existe qu’une seule boucle, c’est celle-ci qui est 
lue pendant les parties de maintien et de 
retombée du fichier audio.

Lorsqu’une deuxième boucle est ajoutée à un 
fichier, elle devient une boucle de retombée 
(Release), tandis que la première boucle devient 
une boucle de maintien (Sustain). 

Pour créer une boucle de retombée :

1  Cliquez sur le marqueur de début de boucle, 
puis sur le point souhaité dans l’affichage de la 
forme d’onde.

2  Ensuite, cliquez sur le marqueur de fin de 
boucle, puis sur le point souhaité dans 
l’affichage de la forme d’onde.

3  Cliquez sur le bouton Loop pour sélectionner 
la boucle 2, afin de l’afficher, de l’écouter et de la 
modifier dans l’affichage Loop.

4  Cliquez sur le bouton haut-parleur dans 
l’affichage Loop pour écouter la boucle.

Marqueurs de début et de fin de boucle

Bouton Loop Select
Echange de boucles

Si, après avoir défini une seule boucle 
Sustain/Release, vous souhaitez l’utiliser comme 
boucle de retombée, vous pouvez appuyer sur le 
bouton Swap Loops. Vous devrez créer 
ultérieurement une boucle de maintien pour le 
fichier.

Pour échanger les boucles :

1  A l’aide des marqueurs de boucle, définissez la 
boucle 1 dans l’échantillon.

2  Cliquez sur le bouton Loop Switch. Les 
marqueurs de la boucle 1 se transforment en 
marqueurs de boucle 2, et la boucle se 
transforme en boucle de retombée.

3  A l’aide des marqueurs de boucle, définissez 
une nouvelle boucle de maintien (Boucle 1). 

Suppression de boucles

Pour supprimer un ou plusieurs marqueurs de 
boucle, utilisez l’outil Delete Loop Marker.

Pour supprimer une boucle :

1  Cliquez sur l’icône Eraser. Le curseur se 
transforme en gomme. 

2  Cliquez sur les marqueurs de début et de fin de 
boucle à supprimer. 

Bouton Swap Loops

Supprimer le marqueur de boucle
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Trimming de l’audio
Vous pouvez trimmer l’audio rapidement avant 
et après une sélection dans une forme d’onde à 
l’aide du bouton Trim. 

Pour trimmer les données non souhaitées d’un 
fichier audio :

1  Sélectionnez la zone du fichier audio à 
conserver.

2  Cliquez sur le bouton Trim. 

Toutes les données sont supprimées à 
l’exception celles de la zone sélectionnée. Pour 
annuler cette commande, choisissez Edit > 
Undo. 

3  Choisissez Save Selection As dans le menu 
Loop pour enregistrer l’échantillon trimmé. 

Assurez-vous de donner un nouveau nom à 
l’échantillon trimmé, pour qu’il n’écrase pas le 
fichier audio d’origine. Vous devez également 
fermer l’échantillon d’origine sans enregistrer 
les changements apportés, pour qu’il ne soit pas 
modifié.

Sélection des couleurs de la 
fenêtre Loop
Vous pouvez personnaliser les couleurs utilisées 
pour afficher chaque canal audio et l’arrière-
plan dans la fenêtre Loop. 

Pour choisir des couleurs personnalisées pour la 
fenêtre Loop :

1  Sélectionnez SampleCell > Preferences. 

Bouton Trim
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2  Cliquez sur l’une des trois options pour choisir 
la couleur souhaitée.

3  Répétez cette opération pour les options des 
autres canaux ou de l’arrière-plan.

Sélection d’un autre éditeur 
d’échantillons
Si vous préférez utiliser une autre application 
pour modifier les échantillons, vous pouvez le 
faire avec Soft SampleCell. Utilisez la 
commande Select Sample Editor pour 
sélectionner une application de montage audio 
compatible.

Pour choisir un autre éditeur d’échantillons :

1  Choisissez Instrument > Select Sample Editor.

2  Recherchez l’application, puis cliquez sur 
Ouvrir.

3  Soft SampleCell se souvient de l’application 
sélectionnée et l’ouvre à chaque fois que vous 
utilisez la commande Launch Sample Editor.

Pour lancer l’éditeur d’échantillons sélectionné :

1  Dans la fenêtre Sample Map, sélectionnez 
l’échantillon à éditer.

2  Choisissez Instrument > Launch Sample 
Editor.

L’échantillon est ouvert par le même éditeur que 
vous avez sélectionné.

Sélection de couleurs personnalisées pour la fenêtre 
Loop



chapitre 5 

Techniques avancées
Ce chapitre décrit différentes techniques 
permettant d’augmenter la variété et 
d'optimiser le réalisme des instruments et des 
échantillons. Utilisez ces exemples comme 
point de départ pour vos propres créations.

Modèles
Le rôle principal d'un modèle d'instrument est 
de mémoriser l’assignation des groupes de 
touches, ainsi que les paramètres de 
l’Instrument. Les modèles peuvent servir de 
point de départ lors de la création 
d'instruments.

Les modèles Soft SampleCell comprennent les 
paramètres Sample Map, Matrix Modulation, 
Envelope et Tracker, ainsi que d'autres 
paramètres Instrument.

Chargement automatique des 
échantillons

Lorsque l'option Automatically Load Samples 
(de la fenêtre Preferences) est sélectionnée, 
Soft SampleCell charge tous les échantillons 
nécessaires aux banques et aux instruments 
actifs. Lorsqu'elle n'est pas sélectionnée, 
l’instrument s’ouvre avec des banques vides, et 
la carte des échantillons (Sample Map) affiche 
les noms des échantillons en italique.
Vous pouvez sélectionner des groupes de 
touches et des zones de vélocité individuels, 
puis remplacer leurs échantillons, ou bien 
charger l'échantillon d'origine en sélectionnant 
sa zone et en activant la commande Load 
Sample.

Les modèles peuvent être chargés avec des 
échantillons fictifs comprenant peu ou pas 
d'informations audio,  pour accélérer leur 
chargement. Vous pouvez ensuite remplacer les 
échantillons par de véritables fichiers de sons.

Les modèles sont utiles pour la configuration 
d'instruments complexes. Les instruments de 
type batterie, par exemple, possèdent un grand 
nombre de groupes de touches et de zones de 
vélocité, ainsi que de paramètres et 
d'échantillons individuels. 

Une fois que vous avez réglé, entre autres, le 
mappage MIDI, la vélocité, les enveloppes, le 
filtre et le panoramique de tous les sons d'un 
instrument de type batterie, vous pouvez, grâce 
à la commande Save Instrument As, en 
enregistrer une copie qui pourra servir de 
modèle.

Si vous souhaitez utiliser plusieurs fois un 
modèle d'instrument, vous pouvez l'enregistrer 
sous forme de Stationery Pad, grâce à la 
commande Get Info du Finder.
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Pour créer un modèle d'instrument :

1  Ouvrez ou créez un instrument et configurez 
ses paramètres comme désiré. 

2  Configurez la fenêtre Sample Map et modifiez 
les fenêtres Misc, Envelope, Matrix Modulation, 
Modulators, Trackers et Sample Parameters 
selon vos besoins.

3  Sélectionnez File > Save Instrument As et 
enregistrez le fichier en lui attribuant un nom 
l'identifiant comme modèle.

4  Ouvrez le modèle de l'une des façons 
suivantes :

◆ Pour l'ouvrir rapidement sans charger 
d'échantillon, ouvrez la fenêtre Preferences et 
désélectionnez l'option Automatically Load 
Samples.

– ou –

◆ Pour ouvrir le modèle et charger tous ses 
échantillons, assurez-vous que l'option 
Automatically Load Samples est bien 
sélectionnée dans la fenêtre Preferences, puis 
ouvrez le fichier.

Enregistrement d'un instrument sous forme de 
Stationery Pad
Guide Soft SampleCell
5  Sélectionnez Save Instrument As, si vous 
souhaitez enregistrer l'instrument sous un 
nouveau nom, ou sélectionnez Save Instrument, 
si vous souhaitez en enregistrer une nouvelle 
version.

6  Une fois le fichier du modèle ouvert, 
remplacez ou chargez les échantillons, selon vos 
besoins.

Utilisation d'échantillons vides

Les modèles d'instruments peuvent utiliser des 
échantillons vides, afin d’économiser l’espace 
disque et d'accélérer leur chargement initial. Un 
échantillon vide est un fichier audio de très 
petite taille. Une fois l'instrument activé, vous 
pouvez commencer à charger les échantillons 
dans la fenêtre Sample Map, à la place des 
échantillons vides.

Paramètres par défaut et modèles 
d'instruments

De nombreux paramètres Soft SampleCell 
peuvent être enregistrés comme paramètres 
Instrument par défaut. Il est cependant 
important de comprendre en quoi ces 
paramètres par défaut se différencient des 
modèles d'instruments décrits dans les 
paragraphes précédents. 

Les paramètres Instrument par défaut.
S'appliquent à tous les nouveaux instruments. 
Tous les instruments, qu’ils soient mono ou 
stéréo, à échantillons unique ou multiples, 
seront configurés en fonction des paramètres 
Instrument par défaut existants. 

Des paramètres par défaut sont créés chaque fois 
que vous sélectionnez Instrument > Set 
Instrument Defaults. Ceci permet de mémoriser 
les paramètres Instrument et Bank existants, 
sans les assignations des échantillons aux 
groupes de touches.



Lorsqu'un instrument est créé par la suite, les 
paramètres Instrument et Bank par défaut, 
définis précédemment, lui sont appliqués. Les 
paramètres spécifiques aux instruments 
(Envelope, Matrix Modulation, Modulators, 
Trackers et Misc Parameters) sont définis en 
fonction du fichier d'instrument ouvert.

Les modèles d'instruments. Permettent non 
seulement d'enregistrer différents ensembles de 
paramètres d’Instrument par défaut, mais 
également de mémoriser les assignations 
d'échantillons aux groupes de touches (ces 
assignations ne sont pas mémorisées avec les 
paramètres d’Instrument par défaut).

Utilisation de trackers 
(« suiveurs »)
Les générateurs de suivi permettent d'effectuer 
de nombreuses opérations, telles que la création 
de courbes de réponse personnalisées, 
l'augmentation de la résolution des paramètres 
de la matrice de modulation, l'ajout d'un 
élément de hauteur aléatoire et l'optimisation 
de l'effet de vibrato, ainsi que des autres 
paramètres de performance.

Si vous utilisez à la fois une carte 
SampleCell II et Soft SampleCell, la 
commande Set Instrument Defaults ne 
définit des valeurs par défaut que pour le 
périphérique SampleCell auquel 
l'instrument sélectionné est assigné. Si vous 
souhaitez utiliser un ensemble particulier 
de paramètres par défaut pour la carte 
SampleCell et pour Soft SampleCell, 
sélectionnez Set Instrument Defaults pour 
chaque application.
Courbes de réponse 
personnalisées

Les courbes de réponse personnalisées sont 
utilisées pour augmenter ou diminuer un 
paramètre en fonction des valeurs d'un autre 
paramètre d’entrée. Les trackers permettent de 
dessiner une courbe de réponse personnalisée 
qui facilite l'augmentation de la résolution de la 
plupart des assignations de matrice de 
modulation, afin d'optimiser les effets, tels que 
le vibrato.

Les exemples suivants décrivent différentes 
utilisations possibles des courbes de réponse 
personnalisées.

Augmentation de la résolution de la 
matrice de modulation 

Les générateurs de suivi peuvent être utilisés 
pour augmenter la résolution de la matrice de 
modulation, ce qui est appréciable notamment 
lorsque par exemple une valeur d'amplitude de 
matrice de 2 est insuffisante, mais une valeur de 
3 est trop élevée.

Ce problème peut survenir lors de l’assignation 
de la vélocité à la hauteur, afin de simuler les 
variations naturelles pour les batteries et autres 
instruments de percussion. Dans ce cas, un 
paramètre de modulation trop élevé peut 
provoquer des variations de hauteur trop 
importantes pour les échantillons (les toms 
commencent à ressembler à des timbales, par 
exemple), alors qu'un paramètre trop faible 
risque de donner des résultats non satisfaisants. 

En outre, vous ne souhaitez peut-être pas que la 
hauteur d'un son de grosse caisse ou d'une 
cloche varie autant que celle des autres 
composants de la batterie. 
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L'exemple suivant illustre l’utilisation du 
générateur de suivi pour moduler légèrement un 
modulateur de contrôle (dans le cas présent la 
vélocité), afin d'optimiser la résolution des 
valeurs provenant d'une assignation de matrice 
de modulation.

Essayez de travailler sur un instrument comme 
une batterie. Utilisez le générateur de suivi pour 
« animer » les sons de fûts, sans modifier les 
cymbales.

Pour utiliser le générateur de suivi :

1  Ouvrez la fenêtre Trackers et sélectionnez 
l'instrument de votre choix dans le menu 
contextuel Instrument.

2  Choisissez Velocity dans le menu contextuel 
Tracker 1.

3  Modifiez la courbe de suivi pour qu'elle dévie 
légèrement de sa forme d'origine. Essayez de 
déplacer légèrement les points d’inflexion vers 
le haut ou vers le bas, par rapport au centre. 
Faites plusieurs essais de paramétrage, jusqu'à ce 
que vous obteniez l'effet recherché.

4  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

5  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec le Tracking 
Generator 1 comme source et Pitch comme 
destination. 

6  Réglez l'amplitude de modulation sur 5 et 
lancez une lecture avec l'instrument. 

Si des ajustements supplémentaires sont 
nécessaires, augmentez ou diminuez l'amplitude 
de l'assignation (via la matrice de modulation) 
du tracker à la hauteur du son, ou retournez au 
générateur de suivi et modifiez la courbe de 
réponse. Faites des essais avec ces deux 
paramètres jusqu'à ce que vous obteniez une 
réponse satisfaisante pour l'instrument.
Guide Soft SampleCell
Hauteur aléatoire

Le générateur de suivi peut être utilisé pour faire 
varier la hauteur des instruments de façon 
aléatoire, afin de les rendre plus réalistes et 
« animés ». Ceci s'avère particulièrement utile 
lors de la simulation d'instruments tels que les 
dulcimers, les koras et autres instruments à 
cordes non occidentaux. 

Variation de hauteur sans demi-ton

L'exemple suivant décrit la création d'une 
variation de hauteur sans demi-ton à l'aide du 
générateur de suivi.

Pour rendre une hauteur aléatoire par incréments 
sans demi-ton :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Misc Parameters et 
désélectionnez Key Track. 

3  Ouvrez la fenêtre Trackers et sélectionnez 
MIDI Note # dans le menu contextuel. Réglez le 
Tracker sur sa courbe par défaut, si ce n'est pas 
déjà le cas. Maintenez la touche Option 
enfoncée puis cliquez sur les points d’inflexion 
pour qu'ils retrouvent leur position initiale, si 
nécessaire.

4  Ouvrez la fenêtre Matrix Modulation puis 
créez une assignation de modulation : Tracking 
Generator dans le menu contextuel Source et 
Pitch dans le menu contextuel Destination. 

5  Réglez l'amplitude sur 99.

Ceci devrait produire des incréments sans demi-
ton. Faites plusieurs essais en modifiant 
l'amplitude de matrice de modulation et la 
courbe du tracker, jusqu'à ce que vous obteniez 
l'intonation recherchée.



Désaccord léger avec hauteur aléatoire

L'exemple suivant décrit la création d'une légère 
variation de hauteur à l'aide du générateur de 
suivi.

Pour rendre une hauteur aléatoire par légers 
incréments :

1  Ouvrez la fenêtre Trackers et sélectionnez 
l'instrument de votre choix dans le menu 
contextuel Instrument.

2  Choisissez Random Generator dans le menu 
contextuel Tracker 1.

3  Modifiez la courbe de suivi pour qu'elle dévie 
de sa forme linéaire par défaut. Les régions où 
vous faites monter la courbe utiliseront 
davantage les valeurs créées par le générateur 
aléatoire. 

La courbe obtenue servira de base au caractère 
aléatoire de l'instrument : elle représente 
visuellement les régions sur lesquelles l'accord 
de l'instrument sera un peu plus « haut » (diésé) 
ou neutre.

4  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Tracking 
Generator 1 comme source et Pitch comme 
destination. 

5  Réglez l'amplitude de modulation sur 10 et 
lancez l'instrument en lecture. 

L'instrument sera alors légèrement désaccordé, 
mais autour d’une hauteur centrale correcte.

Pour une variation de hauteur plus prononcée dans 
la réponse de l'instrument : 

1  Retournez à la fenêtre Matrix Modulation et 
créez une assignation de modulation avec 
Random Generator comme source et Pitch 
comme destination.
2  Réglez cette fois l'amplitude de modulation 
sur 12. 

3  Jouez une note de façon répétée sur le 
contrôleur MIDI, en écoutant la variation de 
hauteur produite par le générateur aléatoire. 

Le générateur aléatoire sert habituellement de 
légère source de modulation. Il « déstabilise » la 
tonalité de l'instrument de façon très naturelle.

Vibrato dynamique

Le générateur de suivi peut également servir à 
créer un effet de vibrato dynamique. 
Soft SampleCell propose un vibrato par défaut 
assignant l'oscillateur à basse fréquence  (LFO) 1 
à la hauteur. A l'aide du générateur de suivi, vous 
pouvez appliquer une courbe de réponse faisant 
varier l’amplitude du vibrato en fonction de la 
hauteur relative de la note.

Pour cet exemple, analysons le son du vibrato 
sur des instruments à cordes, tels que les 
violons. Le vibrato est habituellement plus 
ample dans les registres supérieurs que dans les 
registres inférieurs. Ce phénomène est facile à 
comprendre lorsque l'on observe le manche 
d'une guitare : plus les notes sont hautes, plus 
les sillets se rapprochent. Plus la fréquence est 
haute, plus la distance « physique » entre les 
hauteurs de notes est petite. 

La même technique de vibrato (tirer sur la 
corde) peut faire varier la hauteur de plus ou 
moins un quart de ton, lorsqu'elle est appliquée 
à la note la plus basse, mais de beaucoup plus 
(un demi-ton, ou davantage) si on joue une 
octave plus haut sur la même corde.

Vous pouvez utiliser le générateur de suivi pour 
configurer une courbe qui, lorsqu'elle est 
assignée à l'amplitude du LFO 1, celui qui 
produit le vibrato, peut augmenter l’ampleur de 
ce vibrato dans les registres supérieurs, afin de 
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recréer plus précisément l’effet réel. Il est très 
facile d'obtenir un tel résultat en assignant 
simplement le numéro de note MIDI  à 
l'amplitude du LFO 1 dans la fenêtre Matrix 
Modulation : toutefois, , la résolution de 
l'amplitude de la modulation de matrice risque 
d'être trop grossière pour obtenir l'effet 
souhaité.

Les trackers peuvent permettre d'obtenir une 
variation de vibrato plus subtile, en particulier 
lorsque le registre d'un instrument est limité.

Pour ajouter un vibrato dynamique :

1  Ouvrez la fenêtre Trackers et sélectionnez 
l'instrument de votre choix dans le menu 
contextuel Instrument.

2  Choisissez MIDI Note # dans le menu 
contextuel Tracker 1.

3  Modifiez la courbe de suivi en déplaçant 
légèrement les points d’inflexion supérieurs vers 
le haut et les points d’inflexion inférieurs vers le 
bas.

4  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

5  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Tracking 
Generator 1 comme source et LFO 1 comme 
destination. 

6  Créez une seconde assignation de modulation 
avec LFO 1 comme source et Pitch comme 
destination. (Si cette assignation existe déjà, 
ignorez cette étape.)

7  Réglez l'amplitude de modulation sur 15 et 
lancez l'instrument en lecture. 

8  Réglez l'amplitude de modulation jusqu'à ce 
que vous obteniez l'effet recherché.
Guide Soft SampleCell
Retard de vibrato

Le retard de vibrato est un autre type d'effet 
expressif. De nombreux chanteurs et 
instrumentistes n'appliquent pas le vibrato dès 
le début de l’émission de la note. En fait, ils 
tiennent une note longue « plate » pendant une 
durée variable, puis passent progressivement à 
un vibrato croissant.

Vous pouvez obtenir cet effet dans 
Soft SampleCell, en assignant la molette de 
modulation de votre contrôleur MIDI sur 
l'amplitude du LFO, ou en utilisant le générateur 
de rampe, afin de retarder le vibrato d'une durée 
constante, ou encore en utilisant une 
enveloppe, afin de le retarder d'une durée 
variable.

Molette de modulation. Il est beaucoup plus 
facile d'obtenir un retard de vibrato en 
contrôlant l'amplitude du LFO avec la molette 
de modulation. Cette méthode est idéale si vous 
avez une main libre, mais inapplicable lorsque 
vos deux mains sont occupées et que vous ne 
possédez pas de pédale de contrôle.

Générateur de rampe. L'utilisation d'un 
générateur de rampe constitue une autre façon 
de configurer simplement un retard de vibrato. 
Le seul inconvénient de cette technique est que 
la vitesse du générateur de rampe lui-même ne 
peut pas être modulée par d'autres paramètres 
(tels que les paramètres Mod Wheel, MIDI Note 
# et Pressure, entre autres). 

Enveloppe. Utiliser une enveloppe pour 
contrôler la durée du retard de vibrato offre la 
plus grande flexibilité et ne nécessite que 
quelques étapes.



Pour retarder le vibrato à l'aide du générateur de 
rampe :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Modulators et saisissez une 
valeur de Ramp Time assez élevée. (Vous pourrez 
la modifier ultérieurement.)

3  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Ramp 
Generator comme source et LFO 1 comme 
destination.

4  Réglez l'amplitude de modulation sur 30.

5  Si nécessaire, réglez la valeur de Ramp Time de 
la fenêtre Modulators ou l'amplitude de 
modulation dans la fenêtre Modulation Matrix, 
jusqu'à obtenir l'effet recherché.

Retard de vibrato dynamique

Bien que la méthode précédente permette 
d'obtenir de bons résultats, la vitesse du retard 
reste la même, quelque soit la hauteur. Pour 
obtenir un vibrato moins linéaire, vous pouvez 
doter cette vitesse d’une courbe de réponse à 
l'aide d'un générateur de suivi.

Pour retarder le vibrato à l'aide d'un générateur de 
suivi :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Trackers et sélectionnez 
MIDI Note # dans le menu contextuel Tracker 1.

3  Modifiez la courbe de suivi. Pour que le 
vibrato apparaisse plus rapidement dans les 
registres les plus élevés, déplacez légèrement les 
points d’inflexion supérieurs vers le haut. Pour 
qu'il apparaisse moins rapidement sur les notes 
de registres les moins élevés, déplacez 
légèrement les points d’inflexion inférieurs vers 
le bas.
4  Ouvrez la fenêtre Envelopes et définissez une 
attaque lente pour l'enveloppe 2.

5  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Tracking 
Generator 2 comme source et Envelope 2 Attack 
comme destination. 

6  Réglez l'amplitude de modulation sur -11. 
Ceci permet aux notes les plus aiguës de réduire 
le temps d'attaque de l'enveloppe. 

7  Créez une seconde assignation de modulation 
avec Envelope 1 Attack comme source et LFO 1 
comme destination. 

8  Réglez l'amplitude de modulation sur 30.

9  Jouez des notes dans les registres inférieurs, 
moyens et supérieurs du contrôleur MIDI et 
écoutez la vitesse à laquelle le vibrato apparaît.

Si nécessaire, retournez aux fenêtres Tracking 
Generator et Matrix Modulation pour régler le 
retard de vibrato, jusqu'à ce que vous obteniez 
l'effet recherché.
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Filtres
Le filtre d'un instrument peut servir à créer un 
grand nombre d'effets. Il peut, par exemple, 
redonner de la brillance aux instruments de 
percussion, ou réduire les bruits sur les 
échantillons dont l'attaque est lente.

Utilisation du filtre pour le 
contrôle dynamique de la brillance 
des percussions

Les filtres Soft SampleCell permettent 
d'améliorer la brillance des batteries ou des 
séquences de percussions de façon simple et 
efficace.

Pour redonner de la brillance aux percussions à 
l'aide du filtre : 

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Misc Parameters en cliquant 
sur le bouton du même nom, ou en 
sélectionnant Windows > Misc Parameters. 

3  Dans le menu contextuel Filter Poles, 
sélectionnez 1 pole.

4  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Velocity 
comme source et Filter Frequency comme 
destination. 

5  Réglez l'amplitude de modulation sur ±30. Ne 
choisissez pas une valeur plus élevée car le filtre 
risquerait de ne plus laisser passer les notes 
douces. 

Cette assignation de modulation imite les 
véritables batteries qui produisent des sons plus 
brillants lorsqu’on frappe plus fort, et des sons 
plus mats quand on frappe plus doucement.
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6  Ouvrez la fenêtre Misc Parameters et réglez le 
paramètre Filter Cutoff un peu en-dessous du 
maximum. 

7  Réglez le paramètre Overlap Amount sur 75. 

Ceci empêche les notes qui se succèdent de 
couper les notes qui les précèdent, car le filtre 
réagit aux nouveaux niveaux de vélocité. 

Le seul inconvénient de cette technique est 
qu'aucun batteur ne produit de variation de 
dynamique aussi régulière que la résolution 
d'unité 0-127 d'une vélocité MIDI. Lorsque vous 
souhaitez une variation supérieure à celle du 
simple exemple vélocité/filtre, vous pouvez 
utiliser un générateur aléatoire dans le mixage, 
afin de moduler le filtre plus ou moins 
légèrement. 

Pour optimiser le filtrage à l'aide du générateur 
aléatoire :

1  Configurez le chemin Velocity to Filter Matrix 
en suivant les étapes de l'exemple précédent et 
en utilisant le filtre à 1 pôle.

2  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation supplémentaire 
avec Random Generator comme source et Filter 
Frequency comme destination. 

Vous possédez désormais deux sources de 
modulation de filtre différentes : la vélocité et le 
générateur aléatoire. 

3  Réglez l'amplitude de modulation du chemin 
Random Generator-to-Filter sur une valeur 
relativement élevée, puis faites plusieurs essais 
jusqu'à obtenir un équilibre satisfaisant entre le 
contrôle de la fréquence de filtre à l'aide de la 
vélocité et le contrôle de la fréquence de filtre à 
l'aide du générateur aléatoire. 



Souvenez-vous que le générateur aléatoire 
produit des modulations subtiles. Il sera 
éventuellement nécessaire de créer plusieurs 
assignations de générateur aléatoire à la 
fréquence de filtre avant d'observer des résultats 
notables.

Filtrage des bruits

Si votre échantillon possède un niveau de bruit 
de fond élevé, vous vous apercevrez que, vers le 
bas de la plage dynamique, le rapport 
signal/bruit est parfois insatisfaisant. Ceci est 
notamment le cas lors de la phase de retombée 
de l'échantillon, au cours de laquelle les bruits 
de fond risquent de remonter. 

Pour réduire ces bruits, essayez d'assigner 
l'enveloppe 3 à la fréquence de filtre, dans la 
matrice de modulation. Choisissez une 
amplitude de modulation moyenne, pour que le 
filtre s'ouvre lorsque le son augmente et se 
referme lorsqu'il diminue.

Filtrage des effets sonores pour le 
cinéma/la vidéo

Vous pouvez utiliser votre contrôleur MIDI 
externe, ainsi que les filtres Soft SampleCell, 
pour modifier le spectre des fréquences d'un 
effet sonore. Cette méthode est particulièrement 
efficace lorsque les sons sont riches en hautes 
fréquences. 

L'exemple suivant permet de comprendre en 
quoi ce type de filtrage peut être utile. 
Supposons que vous cherchiez à créer des effets 
sonores pour une scène de film dans laquelle un 
avion vous survole. Si la scène se passe au milieu 
d'un champ, l'échantillon non modifié de la 
bibliothèque d'effets sonores sera probablement 
réaliste. 
Mais le serait-il si la scène se déroulait dans une 
rue surplombée de gratte-ciels ? Dans une telle 
scène, le bruit des réacteurs serait d’abord sourd, 
puis augmenterait progressivement jusqu'à ce 
que l’avion passe juste au-dessus de votre tête. 

Il diminuerait ensuite, pour se transformer en 
simple ronronnement, à mesure que l’avion 
s’éloignerait.

En créant une assignation de modulation de 
matrice avec la molette de modulation du 
contrôleur MIDI contrôlant la fréquence de 
filtre, vous pouvez modifier le filtre en temps 
réel, en synchronisme avec une image de 
référence. Ceci permettrait de coordonner 
l'arrivée de l’avion (ouverture lente du filtre), 
son passage au-dessus des têtes (ouverture totale 
du filtre) et son éloignement (fermeture 
progressive du filtre).

Idées pour recréer le son 
d’ensemble d’instruments
Cette section décrit, à l'aide de plusieurs 
exemples, l'utilisation des assignations de 
matrice de modulation pour améliorer le son 
d’ensembles d’instruments : vents, cordes, etc.

Utilisation d'une molette de 
modulation

La variation de hauteur et la modulation de 
hauteur via LFO sont très efficaces sur des sons 
de synthétiseur, ainsi que pour certains 
instruments acoustiques solo, tels que les 
guitares et les trompettes. Toutefois, au sein 
d’ensembles d’instruments, les instrumentistes 
ne modulent jamais le son à la même vitesse – le 
son ainsi obtenu semble artificiel. Pour cette 
raison, mieux vaut ne pas utiliser la molette de 
modulation (ou la molette de hauteur) pour de 
tels sons d’ensembles d’instruments. Ceci libère 
Chapitre 5 : Techniques avancées 77



78
la molette de hauteur et/ou la molette de 
modulation pour le contrôle en temps réel 
d'autres paramètres (qui pourront être utilisés de 
façon très puissante et très expressive).

Augmentation de l'expression avec 
Sample Select

Cette technique requiert un instrument 
d'ensemble doté de plusieurs zones de vélocité 
par groupe de touches (plus il en possède, mieux 
c'est). Le composant principal de cet effet est le 
contrôle de la fonction Sample Select par 
l’intermédiaire de la molette de modulation.

Lorsque les zones de vélocité de l'instrument 
contiennent plusieurs variations dynamiques 
d’un même son, il en résulte une expressivité 
accrue sur l'ensemble de la plage dynamique de 
l'instrument. Lorsque les zones de vélocité 
contiennent différents riffs ou différentes 
inflexions stylistiques, la molette de modulation 
permet d'obtenir des nuances plus marquées.

Pour sélectionner des échantillons en temps réel à 
l'aide de la molette de modulation :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Mod Wheel 
comme source et Sample Select comme 
destination. 

Il se peut que vous souhaitiez désactiver toute 
autre assignation de molette de modulation (tel 
que les assignations au LFO ou autres 
assignations standard de molette de 
modulation). 

3  Faites plusieurs essais tout en jouant à 
différents niveaux dynamiques. 
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La molette de modulation peut provoquer le 
déclenchement des zones de vélocité 
supérieures, mais le contrôle du volume par la 
vélocité est maintenu. 

Vous pouvez utiliser cette technique pour 
simuler l'effet temps réel produit par 
l'actionnement de la tirette harmonique d'un 
orgue Hammond. Si vous chargez des 
échantillons de forte percussion dans les zones 
de vélocité supérieures, la molette de 
modulation déclenche les sons dont l'attaque 
est brillante, même aux basses fréquences. 

Autres astuces :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Mod Wheel 
comme source et Envelope 3 Amplitude comme 
destination.

3  Réglez l'amplitude de modulation sur -99.

Ceci la transforme en contrôle de volume 
efficace pour la création de fondus de sortie. 

4  Ouvrez la fenêtre Trackers et sélectionnez Mod 
Wheel dans le menu contextuel Tracker 1.

5  Modifiez la courbe de suivi en déplaçant les 
points d’inflexion vers le bas, afin d'obtenir une 
courbe en forme de croissant. 

La combinaison de ces deux assignations de 
matrice de modulation permet d'utiliser la 
molette de modulation sur une plus grande 
gamme d'expressions dynamiques.



Optimisation des sons de cordes

Les instruments à archet n'ont pas une attaque 
uniforme sur les différents niveaux dynamiques. 
Lorsqu'une note forte est jouée à l’archet sur un 
violoncelle, par exemple, celui-ci réagit 
instantanément et la note « sonne » 
immédiatement. Lorsque l'archet frotte les 
cordes plus lentement, l'attaque est cependant 
légèrement retardée.

Si vous n'avez pas le privilège d'utiliser des 
cordes à échantillons multiples, vous pouvez 
simuler cet effet en mappant les enveloppes 1 et 
2 à l'enveloppe 3 qui contrôle l'amplitude.

Pour améliorer le réalisme d'un ensemble de 
cordes :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Envelopes. 

3  Modifiez l'enveloppe 2 en augmentant son 
temps d'attaque pour qu'il soit supérieur au 
temps d'attaque de l'enveloppe 3 (attaque plus 
lente). 

Plus ces deux paramètres sont différents, plus 
l'effet est marqué.

4  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Velocity 
comme source et Envelope 3 Amplitude comme 
destination. Réglez l'amplitude de modulation 
sur 90.

5  Créez une seconde assignation de modulation 
avec Envelope 2 Attack comme source et 
Envelope 3 Attack comme destination. Réglez 
l'amplitude de modulation sur 30.
L'enveloppe 2 réagit aux notes jouées 
doucement, alors que l'enveloppe 3 réagit aux 
hautes vélocités.

Chorusing

Le chorus (littéralement, effet de « chœur ») 
permet de rendre plus « épais » le son des 
instruments. La méthode suivante permet 
d'obtenir des effets de chorus convaincants.

Pour utiliser le chorus :

1  Dans la fenêtre Bank, copiez et collez 
l'instrument pour que 2 copies du même 
instrument apparaissent à l'écran.

2  Sélectionnez l'instrument copié.

3  Ouvrez la fenêtre Misc Parameters et 
désaccordez légèrement l'instrument à l'aide du 
curseur Detune.

Pour plus de réalisme, mappez l'enveloppe 2 
au filtre avec une amplitude de modulation 
de 99.

Pour obtenir un effet de chorus plus 
prononcé, essayez de mapper un modulateur 
à la hauteur (Pitch) du second instrument. 
Faites plusieurs essais avec différents 
paramètres LFO Sync et Waveform.
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Autres effets et astuces
Les techniques suivantes permettent d'optimiser 
le réalisme des échantillons d'instruments.

Contrôle du début d'échantillon 
avec la vélocité

Lors de l'ajout de pas (ou autres effets similaires) 
à un projet, l'augmentation du volume de l'effet 
au fur et à mesure que le personnage s'approche 
donne rarement un résultat satisfaisant. Vous 
pouvez y remédier en modifiant les pas pour que 
l'attaque de leur son soit de plus en plus 
marquée. 

Pour cela, mappez la vélocité au point de départ 
de l'échantillon, dans la fenêtre Matrix 
Modulation. 

Pour contrôler le début de l'échantillon avec la 
vélocité :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Sample Map et cliquez deux 
fois sur l'échantillon, afin d'ouvrir la fenêtre 
Sample Parameters.

3  Réglez le début de zone pour la plus faible 
valeur de vélocité prévisible.

4  Ouvrez la fenêtre Matrix Modulation et créez 
une assignation de modulation avec Velocity 
comme source et Sample Start Point comme 
destination.

5  Réglez l'amplitude de modulation sur une 
valeur négative. Ceci fera démarrer l'échantillon 
plus tôt pour des vélocités plus importantes.
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Optimisation des sons de batterie

Il est possible de lire aléatoirement différents 
échantillons en jouant une même note MIDI. 
Ceci est particulièrement utile lorsque vous 
souhaitez que votre batterie échantillonnée 
paraisse moins répétitive. Pour utiliser cette 
technique, vous devez choisir un instrument 
possédant au moins 2 zones de vélocité dans 
chaque échantillon.

Pour obtenir une sélection aléatoire des 
échantillons :

1  Dans la fenêtre Bank, sélectionnez 
l'instrument souhaité.

2  Ouvrez la fenêtre Matrix Modulation et créez 
3 assignations de modulation identiques avec 
Random Generator comme source et Sample 
Select comme destination.

3  Réglez l'amplitude de modulation sur 99.

Comme le générateur aléatoire sélectionne 
indépendamment la gauche et la droite, cet 
exemple n'est valide que pour les échantillons 
mono. Il peut en résulter, par exemple, une 
lecture du canal gauche de l'échantillon 1 et une 
lecture du canal droit de l'échantillon 2. 

Si vous travaillez avec des échantillons stéréo, 
essayez d'utiliser un oscillateur à basse fréquence 
pour moduler la sélection d'échantillons plutôt 
que le générateur aléatoire.



chapitre 6 

Menus de Soft SampleCell
Menu File

New

Crée une banque ou un instrument. Les quatre 
types d’instruments sont les suivants :

Instrument à échantillons multiples. Instrument 
utilisant un ou plusieurs échantillons mono 
avec des options de modulation.

Instrument stéréo à échantillons multiples. 
Instrument utilisant un ou plusieurs 
échantillons stéréo avec des options de 
modulation.

Instrument à échantillon unique. Instrument 
utilisant un échantillon mono dans un seul 
groupe de touches sans options de modulation.

Menu File
Instrument stéréo à échantillon unique.
Instrument utilisant un ou plusieurs 
échantillons stéréo dans un seul groupe de 
touches, sans options de modulation.

Open

Ouvre une banque, un instrument ou un 
échantillon existant. 

Close

Referme la fenêtre active.

Close All

Referme toutes les fenêtres ouvertes 
actuellement.

Save All Changed

Enregistre toutes les modifications apportées 
aux banques ouvertes et à l’ensemble des 
instruments qu’elles contiennent.

Save Bank

Enregistre la banque actuelle sur le disque, dans 
le répertoire depuis lequel elle a été chargée. 
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Save Bank As

Enregistre la banque actuelle sur un disque et 
dans un répertoire spécifiés. Cette commande 
permet également d’enregistrer les instruments 
et les échantillons dans un nouveau répertoire. 

Revert Bank

Restaure la dernière version enregistrée de la 
banque actuelle.

Save Instrument

Enregistre l’instrument actuellement 
sélectionné sur le disque, dans le répertoire 
depuis lesquels il a été chargé.

Save Instrument As

Enregistre l’instrument actuel sur un disque 
dans un répertoire spécifiés. Permet également 
d’enregistrer tous les échantillons liés à 
l’instrument dans un nouveau répertoire.

Revert Instrument

Restaure la version de l’instrument enregistrée 
précédemment.

Get Bank Info

Affiche les commentaires relatifs à la banque 
actuelle. Les commentaires Bank Info 
apparaissent dans les boîtes de dialogue Open et 
Where Is.

Quit

Quitte Soft SampleCell.
Guide Soft SampleCell
Menu Edit

Undo

Annule la dernière commande ou modification 
(certaines commandes/modifications ne 
peuvent pas être annulées).

Cut Instrument

Supprime de la banque l’instrument 
actuellement sélectionné, et en place une copie 
dans le presse-papiers. Cette fonction ne peut 
pas être annulée.

Copy Instrument

Place une copie de l’élément actuellement 
sélectionné dans le presse-papiers sans le 
supprimer de la banque. Cette fonction ne peut 
pas être annulée.

Paste Instrument

Colle un instrument du presse-papiers dans la 
banque actuelle. Une copie de l’instrument reste 
dans le presse-papiers. Cette fonction ne peut 
pas être annulée.

Menu Edit



Clear Instrument

Supprime l’instrument actuellement 
sélectionné dans une banque sans placer une 
copie dans le presse-papiers. Cette fonction ne 
peut pas être annulée.

Show Clipboard

Affiche le contenu actuel du presse-papiers.

Instrument Menu

New Velocity Zone

Crée une nouvelle zone de vélocité dans le 
groupe de touches actuellement sélectionné, et 
charge un échantillon sélectionné dans cette 
zone de vélocité. Vous pouvez créer un 
maximum de 6 zones de vélocité par groupe de 
touches. Si un échantillon stéréo est sélectionné 
pour un instrument mono, vous pouvez 
sélectionner le canal 1 (gauche) ou 2 (droit) 
comme canal de chargement.

Menu Instrument 
New Key Group

Crée un groupe de touches pour un échantillon 
sélectionné et charge l’échantillon dans le 
groupe de touches. Chaque instrument peut 
posséder jusqu’à 60 groupes de touches. Le 
nouveau groupe de touches est placé à la fin de 
la Sample Map (carte d’échantillons), avec une 
étendue (par défaut) d’une note.

Add Multiple Key Groups

Permet de sélectionner plusieurs échantillons et 
de les charger dans un instrument. Cette 
commande est utile pour créer rapidement des 
instruments à échantillons multiples.

Load Sample

Charge un échantillon dans le groupe de 
touches ou la zone de vélocité actuellement 
sélectionnés.

Unload Sample

Décharge l’échantillon actuellement 
sélectionné depuis un instrument en conservant 
son affectation de groupe de touches/zone de 
vélocité et la référence des fichiers.

Reload Sample

Recharge un échantillon ou une région qui ont 
été déchargés ou modifiés, puis sauvegardés à 
nouveau.

Change Sample

Charge un nouvel échantillon dans le groupe de 
touches ou la zone de vélocité actuellement 
sélectionnés. Tous les paramètres définis pour 
cet échantillon (tels que le point de début, le 
réglage précis, etc.) s’appliqueront.
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Sample Parameters

Ouvre la fenêtre Sample Parameters pour 
l’échantillon actuellement sélectionné dans la 
fenêtre Sample Map.

Sample Parameters

Les informations suivantes s’affichent dans la 
fenêtre Sample Parameters :

Instrument. Affiche le nom de l’instrument 
Soft SampleCell contenant le fichier de 
l’échantillon actuellement sélectionné.

File. Affiche le nom du fichier de l’échantillon 
actuellement sélectionné.

Size. Affiche la taille du fichier de la région/du 
fichier actuellement sélectionné.

Volume. Affiche l’emplacement du fichier de 
l’échantillon actuellement sélectionné.

Region. Affiche le nom de la région 
actuellement sélectionnée.

La fenêtre Sample Parameters peut 
également être ouverte en cliquant deux fois 
sur un échantillon dans la fenêtre Sample 
Map.

Fenêtre Sample Parameters
Guide Soft SampleCell
Time. Affiche la durée du fichier/de la région (en 
secondes).

Global Parameters

Les paramètres suivants sont des paramètres 
généraux d’échantillons. Leur effet s’entend 
dans tous les instruments actuellement ouverts 
qui utilisent l’échantillon sélectionné :

Sample Start Coarse. Règle le point de début de 
l’échantillon sur toute la durée de l’échantillon.

Sample Start Medium. Fournit des réglages 
précis pour le paramètre Sample Start Coarse.

Sus Loop Fine Tune. Définit l’accord fin de la 
hauteur de l’échantillon pendant la boucle de 
maintien. Ce curseur n’est disponible que si 
l’échantillon possède deux boucles.

Sus/Rel Loop Fine Tune. Règle la hauteur de la 
boucle de maintien/retombée ou de retombée 
d’un échantillon. Cette commande n’est pas 
disponible si un échantillon ne possède pas de 
boucles. Si un échantillon ne possède qu’une 
seule boucle, la commande Sus/Rel règle avec 
précision l’audio jouée pendant les boucles de 
maintien et de retombée. Si un échantillon 
possède deux boucles, cette commande règle 
avec précision l’audio jouée pendant la boucle 
de retombée.

Sample Fine Tune. Définit l’accord fin général de 
la hauteur de l’échantillon.

Sus Loop Enable. Active la boucle de maintien 
lorsqu’elle est cochée Cliquez dessus pour 
l’activer/la désactiver. Cette commande est 
disponible uniquement si un échantillon 
possède deux boucles.

Sus/Rel Loop Enable. Lorsque cette option est 
cochée, la boucle de maintien/retombée ou la 
boucle de retombée est activée. Cliquez dessus 
pour l’activer/la désactiver.



Paramètres spécifiques aux 
instruments

Les paramètres suivants sont des paramètres 
spécifiques aux instruments. Leur effet s’entend 
uniquement dans l’instrument actuel :

Key Group Pan. Contrôle le panoramique de 
l’échantillon sélectionné dans l’image stéréo 
générale de l’instrument. Si la valeur est nulle, 
l’échantillon est placé au centre de l’image 
stéréo

Sample Amplitude. Règle le volume de 
l’échantillon sélectionné.

Fine (Zone Start). Définit le point de début de la 
lecture dans des incréments plus petits que 
sample start coarse/medium. Ce paramètre 
affecte uniquement l’échantillon actuellement 
sélectionné (et non pas les copies de 
l’échantillon utilisé dans d’autres instruments 
ouverts). Cette commande est utile pour 
supprimer le silence ou les transitoires non 
souhaités au début d’un échantillon.

MIDI Root Note. Spécifie la note MIDI qui va 
jouer l’échantillon à sa hauteur d’origine. Pour 
définir la note de base MIDI, cliquez sur le 
clavier contextuel et sélectionnez une valeur de 
note.

Direction. Détermine le sens de lecture de 
l’échantillon (à l’endroit ou à l’envers). Les 
boucles ne sont pas prises en considération si 
Backward (à l’envers) est sélectionné.

Launch Sample Editor

Sélectionne et ouvre une autre application de 
montage d’échantillons, puis ouvre 
l’échantillon sélectionné actuellement. Après le 
montage, vous devrez utiliser la commande 
Reload Sample si vous avez édité l’échantillon 
de manière destructive, ou utiliser la commande 
Change Sample pour charger une nouvelle 
version de l’échantillon.

Select Sample Editor

Sélectionne l’application de montage 
d’échantillons lancée lorsque vous cliquez sur le 
bouton Edit Sample.

Edit Loops

Sélectionne un fichier audio à charger dans la 
fenêtre Loop.

Edit « sample name »

Charge dans la fenêtre Loop l’échantillon 
actuellement sélectionné dans la fenêtre Sample 
Map.

Convert Instrument to 
Stereo/Mono

Convertit l’instrument actuellement 
sélectionné en stéréo s’il était en mono, et 
inversement. Le nouvel instrument aura la 
mention « mono » ou « stéréo » apposée à son 
nom.

Get Instrument Info

Affiche les commentaires relatifs à l’instrument 
actuellement sélectionné. Ces commentaires 
sont utiles pour faire des remarques concernant 
un instrument, par exemple « la molette de 
hauteur contrôle la hauteur, la molette de 
modulation contrôle le panoramique » etc.
Chapitre 6 : Menus de Soft SampleCell 85



86
Set Instrument Defaults

Enregistre les valeurs des paramètres 
(modulateurs, enveloppes, etc) pour 
l’instrument actuellement sélectionné comme 
paramètres par défaut lors de la création 
d’instruments ou de l’ajout d’instruments à une 
banque. Si vous créez un instrument, les valeurs 
enregistrées s’appliquent à l’ensemble de 
l’instrument. Si vous ouvrez un instrument dans 
une banque, seuls les paramètres enregistrés 
spécifiques aux banques (panoramique, canal 
MIDI, volume de l’instrument) s’appliquent, car 
les paramètres spécifiques aux instruments sont 
lus dans le fichier Instrument lui-même.

Map All Instruments

Réaffecte tous les instruments dans la banque 
actuelle et règle la plage de notes hautes et 
basses de chaque instrument de manière à 
obtenir une plage de notes unique. Si, par 
exemple, deux instruments sont ajoutés à une 
banque et si leurs deux plages de notes vont du 
La0 au Do8, la commande Map All Instruments 
va réaffecter la plage de notes Lo/Hi du premier 
instrument (celui de gauche) du La0 jusqu’au 
Fa4, et la plage du deuxième instrument (celui 
de droite) du Fa#4 jusqu’au Do8.

Set Root Notes

Définit la note de base MIDI pour un 
échantillon sélectionné automatiquement, en 
fonction de la note intermédiaire, la plus basse, 
ou la plus élevée du groupe de notes de 
l’échantillon. 

Si les fichiers sont au format AIFF, vous 
pouvez également définir la note de base 
MIDI à l’aide de la définition 
correspondante, enregistrée dans le fichier.
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Reorder Key Groups By Root Note

Réorganise les groupes de notes sélectionnés 
dans la fenêtre Sample Map (y compris tous les 
groupes de notes situés à droite du groupe de 
notes sélectionné), en les triant en fonction de 
la note de base par ordre croissant dans 
l’instrument.

Spread Key Groups

Déplace et redimensionne les groupes de notes 
sélectionnés (y compris tous les groupes de 
notes situés à droite du groupe de notes 
sélectionné) pour obtenir une largeur et une 
étendue égales.

Menu SampleCell

Load All Samples

Charge tous les échantillons requis pour la 
banque et les instruments ouverts actuellement.

Delete Unused Samples

Supprime de la mémoire tous les échantillons 
qui ne sont pas utilisés par l’instrument actuel.

Menu SampleCell



Soft SampleCell Setup

Cette boîte de dialogue sert à configurer les 
options de polyphonie vocale, de mémoire 
d’échantillon et de sortie audio de 
Soft SampleCell. Reportez-vous à la section 
« Configuration de Soft SampleCell » à la page 5 
pour en savoir plus sur l’utilisation de cette 
commande.

Soft SampleCell CPU Usage

Affiche le pourcentage de ressources processeur 
système actuellement utilisé par 
Soft SampleCell. 

Fenêtre Monitor SampleCell

Pour de meilleures performances, ne 
dépassez pas une charge système de 50%. 
Pour réduire l’utilisation du processeur, 
utilisez la boîte de dialogue Soft SampleCell 
Setup, afin de diminuer le nombre de voix 
SampleCell.
Test SampleCell

Si vous utilisez une carte SampleCell, cette 
commande teste ses divers composants de 
mémoire vive et de mémoire morte. En 
l’absence de carte SampleCell, cette commande 
n’est pas disponible. Pour plus de détails sur 
cette fonction, reportez-vous au Guide de 
l’utilisateur SampleCell II.

Monitor SampleCell

Affiche la quantité de mémoire vive disponible 
et utilisée actuellement par Soft SampleCell.

Total Memory. Indique la quantité totale de 
mémoire vive attribuée à la lecture des 
échantillons Soft SampleCell.

Available Memory. Indique la quantité de 
mémoire disponible pour des échantillons 
supplémentaires.

Largest Unused Block. Indique la taille du plus 
gros bloc continu de mémoire vive inutilisée. 
Soft SampleCell ne peut pas charger des 
échantillons plus grands que le plus gros bloc 
non utilisé, car il doit stocker les échantillons 
dans un bloc de mémoire continu.

Fenêtre Monitor SampleCell
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Open OMS Studio Setup

Lance l’application OMS Setup et ouvre le 
document Studio Setup actuel. Pour plus de 
détails relatifs à la configuration de OMS Studio 
Setup, reportez-vous à la section 
« Configuration d’OMS » à la page 4. 

OMS MIDI Setup

Ouvre la boîte de dialogue OMS MIDI Setup, 
dans laquelle vous pouvez activer et désactiver 
les ports pour la communication MIDI. Pour 
plus de détails relatifs à la configuration de OMS 
MIDI Setup, reportez-vous à la section 
« Configuration d’OMS » à la page 4.

Pour de plus amples informations, reportez-
vous au Manuel OMS.

OMS MIDI Input Devices

Ouvre la boîte de dialogue OMS MIDI Input, 
dans laquelle vous pouvez activer les 
contrôleurs MIDI et les autres dispositifs utilisés 
pour jouer Soft SampleCell. Pour plus de détails 
relatifs à la configuration de OMS MIDI Setup, 
reportez-vous à la section « Configuration 
d’OMS » à la page 4.

Boîte de dialogue OMS MIDI Setup
Guide Soft SampleCell
All Notes Off

Cette commande désactive la lecture de toutes 
les notes de tous les instruments dans 
l’ensemble des banques. Utilisez-la si les notes 
MIDI se coincent.

N’activez pas de périphériques d’entrée 
OMS si vous prévoyez d’utiliser 
Soft SampleCell avec un séquenceur. Une 
telle action produira des notes doublées, car 
les données MIDI sont envoyées deux fois : 
une fois directement depuis le périphérique 
MIDI, et une seconde fois depuis une piste 
MIDI du séquenceur.

Périphériques d’entrée MIDI OMS



Preferences
Les options de la fenêtre Preferences permettent 
de personnaliser plusieurs paramètres de 
Soft SampleCell. 

Préférences générales

Automatically delete unused samples. 
Lorsqu’une banque est fermée ou lorsqu’un 
instrument est supprimé, cette option assure 
que les échantillons associés sont effacés de la 
mémoire. L’utilisation de cette option est 
recommandée pour une gestion efficace de la 
mémoire.

Pass MIDI Thru to selected instrument’s channel. 
Permet de commuter afin de régler les 
paramètres Soft SampleCell sans avoir à définir 
le canal MIDI qui déclenche l’instrument 
sélectionné. Les données MIDI entrantes sont 
envoyées à tous les instruments actuellement 
sélectionnés, quel que soit l’affectation du canal 
MIDI. Désélectionner cette option évite tout 
double déclenchement des notes, susceptible de 

Fenêtre Preferences
se produire lorsque le séquenceur et 
l’instrument sont déjà réglés sur le même canal.

Si plusieurs instruments sont affectés au même 
canal MIDI, MIDI Thru va tous les utiliser en 
lecture, et pas uniquement celui qui est 
sélectionné.

Pass MIDI Thru unchanged. Permet de 
déclencher la lecture de Soft SampleCell depuis 
un séquenceur MIDI ou depuis une application 
MIDI sur un autre ordinateur. Lorsque cette 
option est sélectionnée, les notes se déclenchent 
en fonction du canal émis par votre contrôleur 
MIDI, quel que soit l’instrument sélectionné. 

Si vous utilisez les cartes SampleCell II en plus de 
Soft SampleCell, les notes MIDI sont envoyées 
aux instruments réglés sur le canal 
correspondant sur tous les dispositifs 
SampleCell.

Si vous souhaitez que le passage des données en 
« MIDI Thru » intervienne à l’arrière-plan, 
sélectionnez aussi l’option Pass MIDI Thru 
When in Background.

Pass MIDI thru when in background. Permet aux 
dispositifs MIDI externes de déclencher la 
lecture de Soft SampleCell, même si l’éditeur 
Soft SampleCell n’est pas l’application actuelle. 
Sélectionnez également Pass MIDI Thru 
Unchanged dans la boîte de dialogue 
SampleCell Preferences pour assurer un bon 
fonctionnement.

Préférences d’instruments

Default new Instruments to « Key Track » off. 

Spécifie que la hauteur de tous les nouveaux 
instruments n’est pas affectée par les notes 
MIDI. Cette fonction est utile lors de la création 
d’une banque d’instruments sans hauteur, effets 
sonores par exemple. 
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Automatically Remap Instruments. Cette 
commande répartit tous les instruments 
existants dans la banque actuelle dès qu’un 
nouvel instrument est ajouté. Les instruments 
sont répartis sur une étendue de 5 octaves, et 
c’est la note centrale de chaque groupe de notes 
qui est choisir comme note de base MIDI pour 
l’instrument correspondant. Si, par exemple, 5 
instruments sont ouverts, l’instrument situé à 
l’extrême gauche couvre l’étendue allant de Do1 
à Si2, avec sa note de base définie sur Fa#1. 
L’instrument suivant situé à droite est affecté de 
Do2 à Si3 avec une note de base de Fa#2, etc. Il 
est ainsi plus facile de former des banques 
d’effets sonores ou de batteries à la volée.

Make One Instrument. Lorsque cette option est 
sélectionnée, tous les fichiers d’échantillons 
sont chargés dans un nouvel instrument, si vous 
les faites glisser sur l’éditeur Soft SampleCell. S’il 
s’agit de fichiers AIFF, leur affectation aux 
groupe de notes est extraite des paramètres du 
fichier AIFF.

Lorsque cette option n’est pas sélectionnée, un 
instrument est créé pour chaque fichier 
d’échantillon, et l’affectation de notes hautes et 
basses de l’instrument respecte les paramètres 
AIFF (s’ils existent). S’il ne s’agit pas de fichiers 
AIFF, ils sont triés et chargés par ordre 
alphabétique, par nom d’échantillon.

Try to Assign Unused MIDI Channel. Cette 
option remplace les valeurs par défaut des 
instruments et attribue automatiquement à 
chaque nouvel instrument le premier canal 
MIDI non utilisé disponible.

Si aucun canal MIDI n’est utilisé ou disponible, 
l’instrument est réglé sur son canal MIDI par 
défaut, ce qui peut entraîner des doubles 
attributions aux canaux MIDI.
Guide Soft SampleCell
Cette préférence recherche uniquement les 
canaux non utilisés dans la banque actuelle. Si 
plus d’une banque est ouverte, il est possible que 
cette préférence attribue un canal MIDI qui est 
déjà utilisé par une autre banque ouverte.

Préférences d’ouverture/de 
fermeture

Preview using Sound Manager. Cette option 
permet de passer par le Sound Manager du 
Macintosh pour écouter les échantillons dans 
les boîtes de dialogue pour Open, New Key 
Group et Add Multiple Key Groups. Si cette 
option est désélectionnée, la pré-écoute audio 
s’effectue via la configuration audio 
Soft SampleCell. Le « Stop » d’aperçu n’est pas 
disponible lors de l’écoute via Soft SampleCell. 

Si vous utilisez les cartes SampleCell II en plus de 
Soft SampleCell, la pré-écoute est effectuée par 
le dernier dispositif SampleCell sélectionné.

Verify sample file locations. Spécifie si 
Soft SampleCell vérifie l’emplacement des 
fichiers avant ou pendant le chargement. En 
effectuant cette vérification avant le 
chargement, vous découvrirez plus tôt que 
l’éditeur Soft SampleCell recherche un fichier 
sur un CD que vous n’avez plus. En effectuant 
cette vérification pendant le chargement, vous 
réduisez les changements de disques si la 
banque utilise les échantillons de plusieurs CD-
ROM.

Automatically open all Instruments in a Bank.  
Cette option permet de passer outre la boîte de 
dialogue Select Instrument qui s’affiche lors de 
l’ouverture des banques. La boîte de dialogue 
Select Instrument permet de choisir 
individuellement les instruments d’une banque 
que vous souhaitez charger.



Automatically load samples. Charge chaque 
échantillon associé à l’ouverture d’un 
instrument ou d’une banque. Lorsque cette 
option est désactivée, les banques et les 
instruments sont ouverts sans que les fichiers 
d’échantillons associés soient chargés dans la 
mémoire vive.

Préférences d’affichage

Display line segment envelopes. Affiche les 
contrôles de paramètres d’enveloppe dans la 
fenêtre Envelope sous forme de segments qu’on 
fait glisser pour les éditer. Lorsque cette option 
est désélectionnée, elle affiche les contrôles de 
paramètres d’enveloppe sous forme de curseurs.

Default to Small Bank View. Définit la vue de 
banque par défaut. Lorsque cette option est 
sélectionnée, les banques ouvertes ou créées 
sont en affichage réduit.  Lorsqu’elle est 
désélectionnée, les banques sont en affichage 
total (pleine hauteur).

Display controls in real units. Affiche les 
paramètres d’instruments en valeurs réelles 
d’unités (ms, Hz, etc.) ou en valeurs 
Soft SampleCell  (0-127 et autres plages de 
commandes).

Préférences de montage de 
boucles

Permet de définir les couleurs de canal et 
d’arrière-plan pour la fenêtre Loop. Reportez-
vous à « Sélection des couleurs de la fenêtre 
Loop » à la page 68 pour obtenir de plus amples 
détails. 
Préférences de recherche de 
fichiers

Permet de spécifier les emplacements dans 
lesquels il faut rechercher les instruments et les 
échantillons Soft SampleCell.

Menu Windows

Sample Map

Ouvre la fenêtre Sample Map.

Misc Parameters

Ouvre la fenêtre Misc Parameters.

Envelopes

Ouvre la fenêtre Envelopes.

Matrix

Ouvre la fenêtre Matrix Modulation.

Modulators

Ouvre la fenêtre Modulators.

Trackers

Ouvre la fenêtre Trackers.

Menu Windows
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Switch Bank Size

Fait passer Bank Size View pour la banque 
actuelle de l’affichage normal à l’affichage 
réduit, et inversement.

Current Bank

Toutes les banques ouvertes actuellement sont 
répertoriées à la fin du menu Windows. Si vous 
sélectionnez une banque, sa fenêtre est activée.
Guide Soft SampleCell



annexe a

Utilisation de Soft SampleCell avec Pro 
Tools
En intégrant Soft SampleCell dans une session 
Pro Tools à l'aide de DirectConnect, vous 
pouvez bénéficier des capacités 
d'enregistrement et de montage MIDI, de 
mixage numérique et de traitement DSP de 
Pro Tools.

DirectConnect est un Plug-In spécifique à 
Macintosh permettant d'assigner, d'enregistrer, 
de traiter et de mixer indépendamment jusqu'à 
32 sorties de canaux audio différentes, 
provenant de Soft SampleCell, dans 
l'environnement Pro Tools.

Une fois les sorties Soft SampleCell assignées à 
Pro Tools, vous pouvez :

• Les assigner à des entrées auxiliaires pour un 
traitement de Plug-In

• Automatiser les paramètres de volume, de 
panoramique et de Plug-In

• Effectuer un prémixage sur disque

• Bénéficier des sorties audio des interfaces 
audio de Digidesign
DirectConnect et nombre de 
pistes sur les systèmes 
Pro Tools TDM

Chaque canal audio transmis via DirectConnect 
utilise la même largeur de bande passante sur le 
bus PCI qu'une piste audio unique sur les 
systèmes Pro Tools TDM. Si vous effectuez une 
lecture de 48 pistes disque, par exemple, sur un 
système Pro Tools MIX, il restera 16 canaux 
audio (16 mono ou 8 stéréo) qui pourront être 
utilisés avec DirectConnect. 

Si vous essayez d'utiliser avec DirectConnect 
plus de canaux que disponibles, vous risquez de 
provoquer une erreur DAE -6042 (bus PCI 
surchargé).

DirectConnect et nombre de 
pistes sur les systèmes 
Pro Tools LE

Les performances des systèmes Pro Tools LE 
dépendent de différents facteurs, dont la 
fréquence  processeur de l'UC hôte, la mémoire 
disponible et les paramètres de mémoire 
tampon. Digidesign ne peut pas garantir 32 
sorties de canaux audio simultanées avec 
DirectConnect sur toutes les configurations 
d'ordinateur.
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Pour obtenir plus d'informations sur les UC et 
les configurations de système recommandées, 
veuillez consulter le site Web de Digidesign.

DirectConnect et ressources DSP
(systèmes TDM uniquement)

Semblable à certains Plug-Ins, DirectConnect 
requiert un type de puce DSP (SRAM) spécifique 
pour fonctionner. Une carte MIX Core en 
contient trois.

DirectConnect utilise une de ces puces DSP. Elle 
ne pourra donc être utilisée par d'autres Plug-
Ins.

Configuration de Pro Tools 
pour travailler en MIDI
Avant d'utiliser Soft SampleCell avec Pro Tools, 
vous devez configurer l’aspect MIDI de 
Pro Tools.

Activation des périphériques 
d'entrée

Pour lire des pistes Soft SampleCell ou 
enregistrer des pistes MIDI à partir d'un clavier 
de contrôle MIDI, vous devez activer le 
contrôleur dans la boîte de dialogue Input 
Devices.

La fenêtre Show System Usage (Windows > 
Show System Usage) permet de vérifier la 
disponibilité des DSP sur le système, ainsi 
que la façon dont elles sont utilisées. Pour 
plus de renseignements, consultez le Guide 
de référence Pro Tools.
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Pour activer les périphériques d'entrée :

1  Allumez les périphériques MIDI et lancez 
Pro Tools.

2  Choisissez MIDI >  Input Devices.

3  Dans la boîte de dialogue Input Devices, 
sélectionnez les périphériques MIDI à utiliser 
pour la lecture des pistes Soft SampleCell et 
l'enregistrement des pistes MIDI.

4  Cliquez sur OK.

Activation des périphériques d'entrée MIDI

Pour améliorer les performances MIDI, 
désélectionnez tout périphérique MIDI non 
utilisé.



MIDI Thru

Pour pouvoir écouter Soft SampleCell et les 
autres périphériques MIDI pendant 
l'enregistrement, activez l'option MIDI Thru. 
Lorsque cette option est activée, Pro Tools 
renvoie les données MIDI (provenant du 
contrôleur) vers le périphérique et le canal 
affectés à la piste MIDI actuellement préparée en 
enregistrement.

Pour activer MIDI Thru :

■ Sélectionnez MIDI > MIDI Thru.

Lorsque vous utilisez l'option MIDI Thru, 
désactivez le contrôle local (Local On) sur votre 
clavier de contrôle MIDI. S'il reste activé, le 
générateur de sons de votre clavier risque de 
recevoir les notes MIDI en double (depuis le 
clavier et en retour de la fonction Thru),  ce qui 
peut provoquer divers problèmes. Si vous ne 
savez pas comment désactiver le contrôle local 
de votre instrument, consultez la 
documentation du fabricant.

MIDI Thru activé

Lorsque l'option MIDI Thru est activée, les 
données System Exclusive sont renvoyées 
vers le périphérique MIDI affecté à la piste 
préparée en enregistrement, mais seulement 
si la taille des événements Sysex reste 
inférieure à 256 octets.
Filtre d'entrée MIDI

Le filtre d'entrée MIDI sert à filtrer certains types 
de messages MIDI. Le filtre d'entrée peut être 
réglé pour laisser passer (et donc enregistrer) 
tous les messages (All), seulement les messages 
spécifiés (Only), ou tous les messages sauf (All 
except) ceux spécifiés.

Lorsque vous utilisez l'option Only, seuls les 
messages MIDI sélectionnés sont enregistrés. 
Inversement, lorsque vous utilisez l'option All 
Except, les messages sélectionnés ne sont pas 
enregistrés.

Par exemple, pour filtrer les changements de 
programme :

1  Choisissez MIDI >  Input Filter.

2  Sélectionnez l'option All Except.

3  Sélectionnez l'option Program Changes. Ne 
cochez pas les autres cases d'option.

4  Cliquez sur OK.

Filtre d'entrée MIDI
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Utilisation de DirectConnect
Pour lire des pistes Soft SampleCell dans 
Pro Tools, vous devez utiliser DirectConnect.

Pour configurer DirectConnect :

1  Lancez l'éditeur Soft SampleCell.

2  Sélectionnez SampleCell > Soft SampleCell 
Setup et choisissez DirectConnect parmi les 
options Sound Output. Cliquez sur OK.

3  Ouvrez toutes les banques Soft SampleCell 
que vous souhaitez utiliser dans la session 
Pro Tools. 

4  Dans les banques, assignez des instruments 
aux canaux MIDI appropriés.

5  Assignez les sorties d'instruments aux sorties 
souhaitées.

6  Lancez Pro Tools et créez une session.

7  Choisissez File > New Track et spécifiez une 
piste Auxiliary Input (stéréo), puis cliquez sur 
Create.

8  Choisissez File > New Track et spécifiez une 
piste MIDI, puis cliquez sur Create.

9  Dans la fenêtre Mix, cliquez sur l'option 
Output Device/Channel Selector de la nouvelle 
piste MIDI et sélectionnez Soft SampleCell, ainsi 
que le canal MIDI de votre choix.

Les instruments Soft SampleCell réglés sur le 
même canal MIDI dans l'éditeur Soft SampleCell 
seront déclenchés par la piste MIDI.
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10  Dans la fenêtre Mix, assignez le Plug-In 
Soft SampleCell DirectConnect à la piste 
Auxiliary Input.

11  Dans la fenêtre DirectConnect plug-in, réglez 
l'entrée Direct Connect sur la sortie 
Soft SampleCell de votre choix.

Sélection de Soft SampleCell comme périphérique MIDI

Assignation de Soft SampleCell à une entrée auxiliaire

L'assignation du canal d'entrée 
DirectConnect doit correspondre à 
l'assignation du canal de sortie de 
l'instrument concerné dans l'éditeur 
Soft SampleCell.

Sélection de Soft SampleCell dans DirectConnect



12  Sélectionnez MIDI > MIDI Thru et préparez la 
piste MIDI en enregistrement. Jouez quelques 
notes sur le contrôleur MIDI, afin de déclencher 
les sons dans Soft SampleCell.

Vous pouvez désormais enregistrer et lire des 
données de jeu MIDI pour l'instrument 
Soft SampleCell, comme vous le feriez avec 
n'importe quel périphérique MIDI dans 
Pro Tools. 

Pour ajouter des instruments Soft SampleCell :

1  Créez une piste MIDI pour chaque instrument 
Soft SampleCell à ajouter.

2  Cliquez sur l'option Output Device/Channel 
Selector de la piste MIDI, puis sélectionnez 
Soft SampleCell, ainsi que le canal MIDI de 
votre choix.

3  Sélectionnez File > New Track et créez une 
nouvelle entrée auxiliaire (stéréo) pour chaque 
instrument Soft SampleCell à ajouter.

4  Dans la fenêtre Mix, assignez le Plug-In 
Soft SampleCell DirectConnect à chaque 
nouvelle piste Auxiliary Input.

5  Dans la fenêtre DirectConnect plug-in, réglez 
l'entrée Direct Connect de chaque nouvelle 
entrée auxiliaire sur la sortie Soft SampleCell de 
votre choix.

Vous devez préparer une piste MIDI en 
enregistrement, pour pouvoir écouter 
l'instrument assigné.

Pour plus d'informations sur 
l'enregistrement, le montage et la lecture 
MIDI, référez-vous au Guide de référence 
Pro Tools.
Rappel total de session

Lorsque vous enregistrez et ouvrez à nouveau 
une session qui utilise Soft SampleCell avec 
DirectConnect, Pro Tools rappelle 
automatiquement tous les paramètres, lance 
l'éditeur Soft SampleCell et ouvre les banques et 
les instruments appropriés, à votre place. Ceci 
permet un rappel total et pratique des 
configurations Pro Tools et Soft SampleCell.

Pour utiliser le rappel de session, enregistrez 
votre session comme suit :

Pour utiliser le rappel total de session :

1  Créez la session Pro Tools/Soft SampleCell en 
suivant les instructions de la section “Utilisation 
de DirectConnect » à la page 96.

2  Dans l'éditeur Soft SampleCell, sélectionnez 
File > Save All Changed, afin d'enregistrer les 
banques et les instruments. Pour copier des 
instruments et des échantillons à de nouveaux 
emplacements, cochez les cases appropriées 
dans la boîte de dialogue Save.

3  Dans Pro Tools, sélectionnez File > Save 
Session, afin d'enregistrer la session. 

4  Refermez la session Pro Tools. 

A la prochaine ouverture de la session, Pro Tools 
lancera l'éditeur Soft SampleCell et ouvrira les 
banques et instruments associés.

Ne refermez pas les banques 
Soft SampleCell avant d'avoir enregistré la 
session Pro Tools, sinon Pro Tools ne les 
rappellera pas. Toutes les banques 
Soft SampleCell doivent également avoir été 
enregistrées (Pro Tools ne rappelle aucune 
banque non enregistrée et sans nom).
Annexe A : Utilisation de Soft SampleCell avec Pro Tools 97



98
Utilisateurs de Digi001

Si vous utilisez les fonctions MIDI de Digi001, 
vous devez lancer Pro Tools avant de lancer 
l'éditeur Soft SampleCell (ou toute autre 
application OMS), sinon Pro Tools ne s'ouvrira 
pas. 

Vous devez également quitter les autres 
applications avant de refermer Pro Tools, sinon 
les fonctions MIDI ne seront pas disponibles sur 
Digi001 tant que des applications OMS seront 
ouvertes.

Si vous n'utilisez pas les capacités MIDI de 
Digi001, retirez le pilote OMS de Digi001 du 
dossier OMS, afin d'éviter les problèmes décrits 
ci-dessus.
Guide Soft SampleCell
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Enregistrement d'échantillons
Même s'il n'est pas possible d'échantillonner des 
données audio directement à partir de 
Soft SampleCell, l'échantillonnage peut 
s'effectuer de multiples façons, grâce à 
l'application Pro Tools de Digidesign ou aux 
autres applications d'enregistrement 
audionumérique.

Echantillonnage avec 
Pro Tools
Le système Pro Tools de Digidesign peut servir à 
enregistrer des échantillons audio qui pourront 
ensuite être utilisés avec Soft SampleCell. 

Pour créer des échantillons à l'aide de Pro Tools :

1  Utilisez Pro Tools pour enregistrer les sons 
souhaités sur le disque dur. (Voir le guide de 
référence de Pro Tools.) Soft SampleCell peut lire 
des échantillons enregistrés avec une fidélité de 
16 ou 24 bits et à une fréquence de 44.1 ou 
48 kHz.

Lorsque vous utilisez Soft SampleCell avec 
DirectConnect, les échantillons sont lus à la 
fréquence d'échantillonnage de la session 
Pro Tools. Lorsque vous utilisez l'option 
Direct I/O, ils sont lus à la fréquence 
d'échantillonnage sélectionnée dans 
l'interface audio.
2  Modifiez les échantillons à l'aide des outils de 
montage Pro Tools, selon vos besoins, puis 
enregistrez le fichier audio au format SDI, SDII, 
AIFF ou .WAV. 

3  Lancez Soft SampleCell et chargez les 
échantillons dans un instrument. Voir 
« Ajout/importation d'échantillons » à la 
page 31.

Utilisation des bibliothèques 
de sons
Les partenaires de développement de Digidesign 
ont mis de nombreuses bibliothèques 
d'échantillons à la disposition des utilisateurs de 
Soft SampleCell. Le CD-ROM Demo Sounds, 
fourni avec Soft SampleCell, présente 
brièvement les divers sons disponibles. 

Contactez Digidesign ou votre revendeur local 
pour des informations supplémentaires sur les 
autres bibliothèques de sons disponibles pour 
Soft SampleCell. 
Annexe B : Enregistrement d'échantillons 99
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Utilisation des bibliothèques de 
sons destinées aux autres 
échantillonneurs

La plupart des bibliothèques de sons destinées 
aux autres types d'échantillonneurs étant dans 
des formats de fichier audio pris en charge par 
Soft SampleCell, vous pouvez importer leurs 
échantillons, afin de créer vos propres 
instruments Soft SampleCell.

Vous pouvez également utiliser toutes les 
applications de traduction de fichier disponibles 
pour le transfert de bibliothèques de sons d'un 
format à un autre. 

Contactez Digidesign ou votre revendeur local 
pour de plus amples informations sur ces 
applications, ainsi que sur les autres 
applications des partenaires de développement 
de Digidesign. 
Guide Soft SampleCell
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Numéros de contrôleur MIDI
Soft SampleCell permet de choisir deux 
numéros de contrôleur MIDI (dans une liste de 
120) comme sources de modulation. Vous 
pouvez ainsi, par exemple, utiliser un contrôleur 
de souffle (contrôleur MIDI n˚2) pour moduler 
le volume, ou une pédale (contrôleur MIDI n˚4) 
pour moduler l'amplitude du LFO. 

Tableau 1. Numéros de contrôleur MIDI

Numéro de 
contrôleur

Type de contrôleur

0 Bank Select

1 Molette de modulation

2 Contrôleur de souffle 

3 Non défini 6

4 Pédale de contrôle

5 Durée de portamento

6 Entrée de données 

7 Volume de canal 

8 Balance 

9 Non défini

10 Panoramique 

11 Contrôleur d'expression 
12 Contrôleur d'effet 1 

13 Contrôleur d'effet 1 

14 - 15 Non défini

16 Contrôleur général #1 

17 Contrôleur général #2 

18 Contrôleur général #3 

19 Contrôleur général #4 

20 - 31 Non défini

32 Bank Select

33 Molette de modulation

34 Contrôleur de souffle 

35 Non défini 

36 Pédale de contrôle

37 Durée de portamento

38 Entrée de données 

39 Volume de canal 

Tableau 1. Numéros de contrôleur MIDI

Numéro de 
contrôleur

Type de contrôleur
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40 Balance 

41 Non défini

42 Panoramique 

43 Contrôleur d'expression 

44 Contrôleur d'effet 1 

45 Contrôleur d'effet 2 

46 - 47 Non défini 

48 Contrôleur général #1 

49 Contrôleur général #2 

50 Contrôleur général #3 

51 Contrôleur général #4 

52 - 63 Non défini

64 Pédale sustain on/off

65 Portamento on/off 

66 Sustenuto on/off 

67 Pédale de sourdine on/off 

68 Pédale de legato

69 Hold 2 

70 Cont. son 1 (variation sonore)

71 Cont. son 2 (timbre/intensité 
harmonique) 

72 Cont. son 3 (temps de retombée)

73 Cont. son 4 (temps d'attaque) 

Tableau 1. Numéros de contrôleur MIDI

Numéro de 
contrôleur

Type de contrôleur
Guide Soft SampleCell
74 Cont. son 5 (brillance)

75 Cont. son 6 (durée de retombée) 

76 Cont. son 7 
(fréquence de vibrato)

77 Cont. son 8 (intensité de vibrato)

78 Cont. son 9 (retard de vibrato)

79 Cont. son 10 

80 Contrôleur général #5 

81 Contrôleur général #6 

82 Contrôleur général #7 

83 Contrôleur général #8 

84 Contrôleur portamento 

85 - 90 Non défini 

91 Niveau de départ réverbération 

92 Profondeur effets 2 
(profondeur de trémolo)

93 Niveau de départ Chorus

94 Profondeur effets 4 (profondeur 
céleste/désaccord)

95 Profondeur effets 5 
(intensité de phasing)

96 Entrée de données +1 

97 Entrée de données -1 

98 Numéro de paramètre non inscrit

99 Numéro de paramètre non inscrit

Tableau 1. Numéros de contrôleur MIDI

Numéro de 
contrôleur

Type de contrôleur



100 Numéro de paramètre inscrit

101 Numéro de paramètre inscrit

102 - 119 Non défini 

Tableau 1. Numéros de contrôleur MIDI

Numéro de 
contrôleur

Type de contrôleur
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A
Accord

boucles d'échantillons 41
instruments 23

Accord de boucle 41
Activation des périphériques d'entrée MIDI 94
Affectation d’un contrôleur MIDI 18
Affichage de la boucle 61
Ajout d'échantillons aux instruments 31
Ajout de zones de vélocité 32
Amplitude des échantillons 40
Annulation de l'autorisation de Soft SampleCell 4
Assignation de sorties audio 20
Auto Locate Loop, boutons 62
Autorisation de Soft SampleCell 3

B
Banques 12

chargement 13
chargement d’instruments 15
commentaires 23
création 15
enregistrement 25
fermeture 25
multiples 16
ouverture 13
réglage de la vue par défaut 15
suppression des instruments 17
vues 14

Banques multiples 16
Bouclage 57
Boucles

accord 41
activation 41
activation ou désactivation 41
écoute 65
flèches de zoom 60
suppression 67
zone de données 63
Index

Boucles d'échantillons
activation ou désactivation 41

Boucles de crossfade 62

C
Canaux de sortie, réglage 20
Channel Select, bouton 62, 63
Chargement d’instruments dans les banques 15
Chorusing 79
Commandes d'accord de boucle 41
Commentaires, ajout et affichage 23
Configuration

canaux MIDI 19
Configuration des zones MIDI 19
Configuration requise 1, 2
Contrôle local 95
Contrôleur MIDI

affectation à un contrôle 18
contrôle local 95
modulateurs 53
numéro de contrôleur MIDI

assignation d'un modulateur 53
utilisation pour l’entrée de données 17

Contrôleur MIDI, activation 5
Contrôleurs MIDI A et B 53
Création automatique d'instruments 29
Création d'instruments 28
Création de banques 15
Crossfade de vélocité 43
Crossfade Loop, bouton 62

D
Début de zone 40
Définition de la note MIDI de base 36
Delete Loop Marker, bouton 61
Désaccord d’un instrument 24
Désactivation du suivi de touche 42
index
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Detune, contrôle 24
Digi001 et Soft SampleCell 98
DirectConnect

nombre de pistes 93
rappel total de configuration 97
ressources DSP 94
utilisation avec Soft SampleCell 93

Display Controls in Real Units, option 49
Disquette d'autorisation

obtention d'une disquette de secours 3
utilisation comme clé 3

Duplication d’instruments 17

E
Echantillons

ajout aux instruments 31
chargement d'échantillons déchargés 36
déplacement 33
déplacement vers une nouvelle zone de 
vélocité 35
remplacement 33
remplacement et suppression 35
remplacer 35
sélection à l'aide d’un contrôleur MIDI 33
sélection à l'aide du clavier 33
sélection dans la fenêtre Sample Map 33
sélection manuelle 33
suppression 33
taille 33

Edit, commandes du menu
Clear Instrument 83
Copy Instrument 82
Cut Instrument 82
Paste Instrument 82
Show Clipboard 83
Undo 82

Edit, menu 82
Emprunt de voix 44
Enregistrement d’instruments 26
Enregistrement de banques 25
Enregistrement de Soft SampleCell 3
Ensembles d’instruments 77
Entrée de données

utilisation d’un clavier d’ordinateur 18
utilisation d’un contrôleur MIDI 17
utilisation des numéros de notes MIDI 17

Envelope Amount, commande 47
Envelope, fenêtre 28, 48
Soft SampleCell Guide
Enveloppe
création d'un vibrato 74

Equal Detune, option 24
désaccord égal activé 24
désaccord égal désactivé 24

Erreur DAE -6042 93

F
Fenêtre Sample Map

paramètres 36
Fermeture des banques 25
File, commandes du menu

Close 81
Close All 81
Get Bank Info 82
New 81
Open 81
Quit 82
Revert Bank 82
Revert Instrument 82
Save All Changed 81
Save Bank 81
Save Bank As 82
Save Instrument 82
Save Instrument As 82

File, menu 81
Filtre 45

1 pôle 45
4 pôles 45
commande Filter Frequency 45
commande Filter Resonance 45
contrôle à l'aide d'une enveloppe 45
contrôle de la brillance 76
techniques avancées 76

Filtre à 1 pôle 45
Filtre à 4 pôles 45
Find File, boîte de dialogue 13
Flèches de défilement 61
Flèches de sélection d'échantillon 39
Flèches de zoom 60
Flèches de zoom de boucle 62

G
Gate Time, commande 47
Générateur d'enveloppe 47

contrôle du filtre 45
étapes d'enveloppe 47



options d'affichage 48, 49
suivi de touche 49

Générateur de rampe 53
création d'un vibrato 74

Générateur de suivi 54, 71, 72
et assignations de matrice 71
points d’inflexion 55
techniques avancées 71

Groupes de touches
déplacement vers un nouvel emplacement 34
modification 33
panoramique de groupes de touches 21
panoramique du groupes de touches 39
redimensionnement 34
répartition 34
suppression 35
tri des emplacements 34

H
Hauteur aléatoire 72
Haut-parleur, bouton 59, 63
Hi/Lo Note, menu contextuel 19

I
Input Devices, commande 94
Input Filter, commande 95

boîte de dialogue MIDI Input Filter 95
Installation de Soft SampleCell 3
Instrument, commandes du menu

Add Multiple Key Groups 83
Change Sample 83
Convert Instrument to Stereo/Mono 85
Edit Loops 85
Get Instrument Info 85
Launch Sample Editor 85
Load Sample 83
Map All Instruments 86
New Key Group 83
New Velocity Zone 83
Reload Sample 83
Reorder Key Groups By Root Note 86
Sample Parameters 84
Select Sample Editor 85
Set Instrument Defaults 86
Set Root Notes 86
Spread Key Groups 86
Unload Sample 83

Instrument, fichiers 11
Instrument, menu 83
Instruments

accord 23
ajout d'échantillons 31
chargement dans les banques 15
chorusing 79
commentaires 23
concepts de base 27
création 28
création automatique 29
création et modification 27
crossfade de vélocité 43
désaccord 24
duplication 17
échantillon unique 28
échantillons multiples 28
enregistrement 26
ensemble 77
modèles 71
modification 27
modification de la réponse de vélocité MIDI 43
modulation du panoramique stéréo 51
mono et stéréo 28
Mute et lecture en solo 22
panoramique 21
paramètres par défaut 70
priorité de voix 44
réglage d’un canal MIDI 19
suppression des banques 17
transposition 24
utilisation de copies 17
volume 22

Instruments à échantillons multiples 28

L
Large Bank, vue 14
Loop Select 62
Loop Select, bouton 62
Loop, bouton 38
Loop, fenêtre 38, 58
Loop, menu 58

M
Mapping des touches 30
Marqueurs de début et de fin de boucle 61
Matrice de modulation

augmentation de la résolution 71
destinations de modulation 50
Index 107
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paramètres 50
sources de modulation 50

Matrix Modulation, bouton 28
Matrix Modulation, fenêtre 49
Mémoire vive

allocation 7
insuffisante 13

MIDI
activation des périphériques d'entrée 94
amélioration des performances 94
configuration d’un canal MIDI 19
configuration de Pro Tools 94
configuration des zones MIDI 19
configuration requise 2
filtre d'entrée 95
filtre d'entrée avec Pro Tools 95
modification de la réponse de vélocité 43
sélection d'échantillons 33
spécification d’un numéro de note depuis un 
appareil MIDI 18

MIDI Thru, option 95
MIDI, menu

Commande Input Devices 94
commande Input Filter 95
option MIDI Thru 95

Misc Parameters, bouton 27, 42
Misc Parameters, fenêtre 42
Modèles d'instruments

création 70
Modèles, instruments 69
Modification d’échantillons 57
Modification du groupes de touches 33
Modulateurs

contrôleurs MIDI A et B 53
générateur de rampe 53
LFO 1 et 2 52

Modulators, bouton 28
Modulators, fenêtre 52
Molette de modulation

création d'un vibrato 74
Multi-Sample Instrument, commande 81
Mute et lecture en solo des instruments 22

N
Note de base MIDI 40
Note MIDI de base

définition 36
Soft SampleCell Guide
Numéros de notes MIDI 18
entrée de données 18

O
OMS Input Devices 5
Outil Trim 60
Ouverture de banques 13

P
Panoramique de groupes de touches 21
Panoramique des instruments 21
Panoramique du groupes de touches 39
Paramètres d'instruments par défaut 70
Paramètres de modulation 50
Point de départ d'échantillons 39
Point de départ d'un échantillon 39
Points d’inflexion 55
Polyphonie 44
Polyphonie de voix 44
Polyphonie monophonique 44
Preferences

préférences d’affichage 91
préférences d’instruments 89
préférences d’ouverture/de fermeture 90
préférences de montage de boucles 91
préférences de recherche de fichiers 91
préférences générales 89

Preferences, fenêtre 89
Priorité d'allocation des voix 44
Priorité de voix 44
Priorité du chargement d’échantillons 14
Pro Tools

configuration MIDI 94
utilisation avec Soft SampleCell 93

Programme d'installation, CD-ROM 3

R
Rappel total de configuration 97
Recherche de fichiers 13
Recouvrement de voix 44
Redimensionnement des zones de vélocité 35
Réglage de Hi/Lo MIDI Note 19
Réglage des canaux de sortie 20
Réglage du volume des instruments 22
Resampling Quality, menu 46
Revert Audio File, commande 59
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S
Sample Map, fenêtre 27, 30

activation 29
Sample Parameters, bouton 38
Sample Parameters, fenêtre 38
Sample Select 78
SampleCell, commandes du menu

All Notes Off 88
Delete Unused Samples 86
Load All Samples 86
Monitor SampleCell 87
OMS MIDI Input Devices 88
OMS MIDI Setup 88
Open OMS Studio Setup 88
Preferences 89
Soft SampleCell CPU Usage 87
Soft SampleCell Setup 87
Test SampleCell 87

SampleCell, menu 86
Save All Changed, commande 26
Save As Audio File Copy, commande 59
Save Audio Selection As, commande 59
Select Instrument, boîte de dialogue 13
Selector, outil 61
Send to Instrument, bouton 60
Sens de lecture des échantillons 40
Set Instrument Default, commande 21
Set Root Note, bouton 37
Single-Sample Instrument, commande 81
Small Bank, vue 14
Soft SampleCell

annulation de l'autorisation 4
autorisation 3
Digi001 98
fonctions 1
installation 3
types de fichiers 11

banques 12
échantillons 11
instruments 11

utilisation avec DirectConnect 93
utilisation avec Pro Tools 93

Sortie audio, options 7
Sorties audio

assignation 20
Spread Key Groups, bouton 34
Stereo Multi-Sample Instrument, commande 81
Suivi de touche 42, 49
Index

Suivi de touche de l'enveloppe 49
Suppression

groupes de touches et zones de vélocité 35
Suppression des instruments des banques 17
Sustain Decay, commande 47
Swap Loops, bouton 60
Switch Bank Size 14
System Exclusive, données 95

T
Techniques avancées 69
Trackers, bouton 28
Transposition d’instruments 24
Trigger, mode 52
Trim, outil 60
Trimming de l’audio 68
Types de fichiers 11

V
Valeur d'amplitude 51
Vélocité MIDI

négative 43
réglage 43

Vibrato
dynamique 73
retard 74

Vibrato dynamique 73

W
Windows, commandes du menu

Current Bank 92
Envelopes 91
Matrix 91
Misc Parameters 91
Modulators 91
Sample Map 91
Switch Bank Size 92
Trackers 91

Windows, menu 91

Z
Zones de vélocité 30

ajout 32
redimensionnement 35
suppression 35
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